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Provisions Relating to Approved Use and Warranty  

 

nac Image Technology warranties operation of the software within the rage given below 

for normal use as described in the User’s Guide.  

nac Image Technology offers no warranty for this product other than that found in these 

provisions.   

 

1. Warranty  

If this software does not function normally at delivery due to a defect in the recording 

medium or some other reason, we will replace it free of charge.   

 

2. Customer Support   

nac Image Technology will provide necessary information relating to this software, such 

as serious errors (bugs) and upgrades in the method of use. This service shall be valid 

for one year from the date of delivery of this software 

 

3. Limits of Warranty  

nac Image Technology shall only be liable for this software as described in 1 and 2 above. 

nac Image Technology shall not be liable for any damage that occurs for any reason 

arising from the use of this software. While we attempted to create a flawless User’s 

Guide, nac Image Technology shall not be liable for any damage arising from anything 

written in this document.   

 

4. Copyrights and Rights of Use  

The copyright for this software belongs to nac Image Technology. nac Image Technology 

authorizes use of this software to the customer under the following conditions.  

 

5. Scope of Use  

This software shall not be used simultaneously on multiple computers.  

 

6. Limitations on Copying  

Other than for the express purpose of backup for the customer, reproduction of all or part 

of this software is prohibited. 

 

7. Third Party Use  

This software and any copies shall not be lent or transferred to a third party for use. 

 

8. Warranty after Modification or Upgrades  

nac Image Technology shall not warranty normal operation if any modifications or 

upgrades unrelated to the administration of nac Image Technology are made to this 

software. Additionally, nac Image Technology shall not be liable for any damages arising 

for the use of such modifications or upgrades to this software.  
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Minpack Copyright Notice (1999) University of Chicago.  All rights reserved 
 
Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the 
following conditions are met:  
 
1. Redistributions of source code must retain the above 
copyright notice, this list of conditions and the following 
disclaimer. 
 
2. Redistributions in binary form must reproduce the above 
copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials 
provided with the distribution. 
 
3. The end-user documentation included with the 
redistribution, if any, must include the following 
acknowledgment:  
 
   "This product includes software developed by the 
   University of Chicago, as Operator of Argonne National 
   Laboratory. 
 
Alternately, this acknowledgment may appear in the software 
itself, if and wherever such third-party acknowledgments 
normally appear. 
 
4. WARRANTY DISCLAIMER. THE SOFTWARE IS SUPPLIED "AS IS" 
WITHOUT WARRANTY OF ANY KIND. THE COPYRIGHT HOLDER, THE 
UNITED STATES, THE UNITED STATES DEPARTMENT OF ENERGY, AND 
THEIR EMPLOYEES:  (1) DISCLAIM ANY WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE 
OR NON-INFRINGEMENT, (2) DO NOT ASSUME ANY LEGAL LIABILITY 
OR RESPONSIBILITY FOR THE ACCURACY, COMPLETENESS, OR 
USEFULNESS OF THE SOFTWARE, (3) DO NOT REPRESENT THAT USE OF 
THE SOFTWARE WOULD NOT INFRINGE PRIVATELY OWNED RIGHTS, (4) 
DO NOT WARRANT THAT THE SOFTWARE WILL FUNCTION 
UNINTERRUPTED, THAT IT IS ERROR-FREE OR THAT ANY ERRORS WILL 
BE CORRECTED. 
 
5. LIMITATION OF LIABILITY. IN NO EVENT WILL THE COPYRIGHT 
HOLDER, THE UNITED STATES, THE UNITED STATES DEPARTMENT OF 
ENERGY, OR THEIR EMPLOYEES:  BE LIABLE FOR ANY INDIRECT, 
INCIDENTAL, CONSEQUENTIAL, SPECIAL OR PUNITIVE DAMAGES OF 
ANY KIND OR NATURE, INCLUDING BUT NOT LIMITED TO LOSS OF 
PROFITS OR LOSS OF DATA, FOR ANY REASON WHATSOEVER, WHETHER 
SUCH LIABILITY IS ASSERTED ON THE BASIS OF CONTRACT, TORT 
(INCLUDING NEGLIGENCE OR STRICT LIABILITY), OR OTHERWISE, 
EVEN IF ANY OF SAID PARTIES HAS BEEN WARNED OF THE 
POSSIBILITY OF SUCH LOSS OR DAMAGES. 
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IMPORTANT:  READ BEFORE DOWNLOADING, COPYING, INSTALLING OR 

USING.  

 

 By downloading, copying, installing, or using the software you agree to this license. 

 If you do not agree to this license, do not download, install, 

 copy or use the software. 

 

 

                          License Agreement 

               For Open-Source Computer Vision Library 

 

Copyright (C) 2000-2008, Intel Corporation, all rights reserved. 

Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved. 

Third party copyrights are property of their respective owners. 

 

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:  

 

  * Redistributions of source code must retain the above copyright notice, 

    this list of conditions and the following disclaimer. 

 

  * Redistributions in binary form must reproduce the above copyright notice, 

    this list of conditions and the following disclaimer in the documentation 

    and/or other materials provided with the distribution. 

 

  * The name of the copyright holders may not be used to endorse or promote products 

    derived from this software without specific prior written permission. 

 

This software is provided by the copyright holders and contributors "as is" and 

any express or implied warranties, including, but not limited to, the implied 

warranties of merchantability and fitness for a particular purpose are disclaimed. 

In no event shall the Intel Corporation or contributors be liable for any direct, 

indirect, incidental, special, exemplary, or consequential damages 

(Including, but not limited to, procurement of substitute goods or services; 

loss of use, data, or profits; or business interruption) however caused 

and on any theory of liability, whether in contract, strict liability, 

or tort (including negligence or otherwise) arising in any way out of 

the use of this software, even if advised of the possibility of such damage. 
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List of New Functions by Version of MOVIAS Neo   

 

Ver3.22 

 Windows 11 compatibility 

 

Ver3.15 

 6DOF Output Coordinate System Selection(p. エラー! ブックマークが定義されてい

ません。) 

 

Ver3.14 

 Corrected a bug in the 6DOF value output where the results files was blank. 

 

Ver.3.13 

 

⚫ Added a dynamic 2D-6DOF function(p. 10－33) 

⚫ Added a 2D-6DOF starting point offset function 

⚫ 2D-6DOF analysis results graph creation function(p. 10－39) 

⚫ Switch between the Y axis and the Z axis on the３D tracking figure 

 

Ver.3.10 

 

⚫ Add the2D-6DOF function 

 

Ver.3.07 

 

⚫ Windows 10 compatibility 

 

Ver.3.00 

 

⚫ 64bit compatibility 

Overview 

Conversion from MOVIAS Neo Ver.3.00a to native 64bit. 

Detailed Functions 

Added 64bit software (p. 1－4) 

 

⚫ Optical Distortion Correction Image Conversion 

Overview 

When setting the optical distortion correction, enable export of measurement 

images as distortion corrected images. 

Detailed Functions 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 

Export as AVI (p. 8－3) 

 

⚫ Specify Graph Playback Range  

Overview 

If designating the playback range for the graph window, it is reflected in the 

graph display range.  

Detailed Functions 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 
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⚫ Save the Playback Range 

Overview 

The playback range can be separately set for the measurement image, graph, 

trajectory, stick and then saved. Also, you can select the “And range (range 

overlapping the playback range)”, “Or range (range including all the playback 

range)” for the playback range separately set for these during synchronized 

playback.   

Detailed Functions 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 

Automatic Update of Group Tracking Rotation Angle 

Overview 

The group tracking rotation angle can now be automatically updated after a 

group is created or when measurement data is constructed.  

Detailed Function 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 

 

Ver.2.50 

 

⚫ Extended Optical Distortion Correction Function 

 Overview 

Improves the method of calculating distortion correction to perform [Polynomial 

Correction by Area] when the number of lines in the grid is 13x11 or higher.  

If there is no optical distortion correction chart, a function was added to perform 

distortion correction using GUI while viewing the measurement image.  

Compatible with the chessboard format distortion correction chart.  

Detailed Function 

エラー! 参照元が見つかりません。  (p. エラー! ブックマークが定義され

ていません。) 

 

⚫ Screen Axis Alignment Function(Image Alignment・Additional Charge) 

 Overview 

Function to horizontally and vertically align line segments connecting aligned 

reference points to the screen during 2 point image alignment.   

Detailed Functions 

エラー! 参照元が見つかりません。  (p. エラー! ブックマークが定義され

ていません。) 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 

 

⚫ Function to Enlarge the Image Area(Image Alignment・Additional Charge) 

 Overview 

Ability to enlarge the image size by adding a black frame outside the image 

when creating a project that is a solution to the problem of part of the image 

being cut off during image alignment. 

 Detailed Function 

エラー! 参照元が見つかりません。a   (p. エラー! ブックマークが定義され

ていません。) 
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Ver.2.40  

 

⚫ User Defined Points Function 

 Overview 

Measurement points calculating the coordinate values from existing 

measurement points. Just as with other measurement points, you can use 

[Superimpose], [View Graph], [Calibration] and [Reference Points for Image 

Alignment].  

 Detailed Functions 

エラー! 参照元が見つかりません。  (p. 4－8) 

Example of the Operation of User Defined Points  (p. 4－16) 

 Using User Defined Points 

Example of the Operation with User Defined Points 1 Marker is Hidden 

 (p. 4－21) 

Example of the Operation with User Defined Points 2 Measure Using Time 

Values Generated by an Event   

(p. 4－23) 

 

⚫ Changing Perspective for Image Alignment (Additional Charge) 

Overview 

Function to create [Image Seen from the Front] from the changing perspective 

settings and to perform alignment. 

Detailed Functions 

エラー! 参照元が見つかりません。  (p. エラー! ブックマークが定義され

ていません。) 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 

 

⚫ Analysis・CSV Export of Quadrants・Group Tracking Angle 

 Overview 

Enable the quadrants and group tracking angles to be displayed on graphs・lists 

and also be exported to a CSV file.  

 Detailed Functions 

エラー! 参照元が見つかりません。  (p. エラー! ブックマークが定義され

ていません。) 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) 
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1. Introduction 
The MOVIAS Neo software (hereafter, MOVIAS Neo) is a general purpose motion 

analysis software. The two versions include the 3D and the 2D analysis versions. The 3D 

analysis version can also be used for 2D analysis. 

3D analysis photographs the target images from multiple directions and 2D data is 

derived from these images and then merged to produce 3D data that is then analyzed. 

2D analysis uses images taken from a single direction. 

Tracking of the target markers in the image that are the basis of analysis is 

automatically performed. Manual tracking and manual correction of the auto-tracking 

results is also available. Auto-tracking is performed on image files (MCFF, AVI formats, 

etc.) displayed on a PC monitor. 

Tracking results are shown as videos, numerical lists, graphs and stick models. Some 

of the results (such as trajectory figures and stick models) can be superimposed on the 

images. Additionally, data can be exported to other software programs using a CSV 

format text file.  

Also, waveform data can be imported as graphs to simultaneously display it with other 

graphs and images. 

 

To properly and effectively perform analysis, read this guide carefully before using. 

1.1  Basic Features 

 

⚫ Image / Data Input 

AVI  

- Corrects the aspect ratio of the image in the AVI file converted from DV-

HDV/AVCHD for analysis using EDIUS Neo 2 manufactured by Grass Valley 

Co, Ltd.) 

MCFF (Bayer) 

WMV (Windows Media Video) 

- To perform WMV analysis, Windows Media Player 11 or later must be 

installed. Only searchable WMV files can be input. 

Sequential image files (TIFF, JPEG, BMP)  

Waveform files (Wave-In binary files from Library, Inc.)  

nac, Inc. nwf binary files 

Import function for CSV format files (MOVIAS Pro format, simple CSV format)  

⚫ Analysis Type 

2D analysis, 3D analysis (select either DLT or MDLT method)  

⚫ Project Management 

Multiple project management (sessions), project templates 

⚫ Tracking 

Automatic tracking of markers (quadrants  , white dot  , black dot  , and 

feature point )  

Tracking Modes: Automatic, semi-automatic, manual (can be set for each tracking 

point)  

Measurement point group tracking 

Hidden point processing (interpolation of hidden points upon reappearance and 

continuous tracking)  
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Tracking data support for hidden areas 

 (Interpolation with linear, 2D least squares, cubic, spline)  

Frame skip tracking  

Tracking area designation function, tracking direction designation function 

Common/custom virtual point calculations, user defined point calculation  

 

⚫ Calibration 

Automatic recognition of the standard calibration chart produced by nac (3D)  

Real scale conversion 

Depth plane correction, scale plane correction 

Change perspective (incline correction)  

Optical distortion correction 

⚫ Definition of Coordinates 

Dynamic coordinate system for each frame, definition of still coordinate system for 

fixed frames 

⚫ Analysis Functions 

Distance, speed, acceleration, coordinate position, displacement, mass analysis 

(force, momentum, power, and energy) from the specified reference point  

2-point distance, speed, and acceleration between analysis points   

Angle, angular velocity, and angular acceleration between 2-4 points 

Quadrant, group tracking angle   

Projected area of part surrounded by multiple points  

Simple 6DOF analysis 

⚫ Creating and Displaying Graphs  

Graph display (time-series graphs, correlation graphs, and graphs with multiple 

vertical axis)  

List display (tracking coordinates and angles of measurement points (quadrants), 

measurement data and analysis data)  

Graphing of external waveform data, synchronized playback of videos, analysis 

graphs, trajectory figures and stick diagrams  

Adjustment of auto-scaling of graphs, extended range function  

Comparison view of analysis results for multiple projects  

Low pass filtering for waveform data/analysis results, smoothing filter use  

Stick display (time-shift display, superimposed display of reference points)  

Trajectory figures  

Annotation functions (show diagrams and analysis results on images, show outlines 

linked to tracking points) 

⚫ Export Results 

Export analysis results as a CSV file or Excel spreadsheet  

Export as an AVI file of the analysis results screen 

Export as AVI or still image merged with images, graphs, or sticks 

Function to paste the analysis screen into other programs 

Print function 

⚫ Other 

Point zoom function (enlarged display of a tracking point area, enlarge a specific 

area)  

Synchronized playback of multiple images with different frame rates 

Image correction function (gamma, contrast, chroma, brightness, rotation, reversal, 

aspect ratio conversion and interlace deletion)  
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⚫ Options (Additional Charge)  

Image alignment, Overlay display, Afterimage display 

Image alignment (function to display images based on a reference point)  

Overlay display (function to display two images superimposed) 

Afterimage display (function to display images from the previous and subsequent 

frames superimposed)  

Refer to エラー! 参照元が見つかりません。 (p.エラー! ブックマークが定義されていま

せん。) for image alignment, overlay display, afterimage display. 

1.2  Operating Environment 

MOVIAS Neo operates on a PC with the following specifications. 

CPU:  Pentium 4, 2GHz or higher 

Memory:  512MB or more (1GB or more is recommended)  

Hard Drive:  150MB or more free space for software installation 

  (200GB or more for data is recommended)  

Monitor:  Resolution of 1024x768 or greater (1920x1080 or 

greater is recommended)  
If the vertical resolution is less than 864, please use after 

turning OFF the [Refer to the sequence with images] in the 

[Import Analog Waveform Data (detail settings)] window. 

OS:  Windows 11,  

Windows 10 64bit / 32bit,  

Windows 8/8.1 64bit / 32bit,  

Windows 7 64bit / 32bit,  

Windows Vista (SP2 or later) 64bit / 32bit 

Windows XP (SP3 or later) 32bit 

DirectX®:  Microsoft DirectX 9.0C or later 

Other:  CD-ROM drive required for installation 

 -USB port required for the MOVIAS license key 
 

Refer to Operating Environment (p.エラー! ブックマークが定義されていません。) if 

using the Image Alignment and Overlay Function. 

Excel export requires installation of Microsoft Office Excel 2003 or later. We do not 

warranty operation merging all the PC, OS with Excel. 
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1.3  Installation 

1.3.1  Install MOVIAS Neo 

Since the installation requires administrator authorization, please install after an 

authorized user has logged on. 

 

Insert the MOVIAS Neo Installation CD into the CD-ROM drive of your PC. The 

installation selection screen shown below will appear. 

 
MOVIAS Neo Program Installation Selection Screen 

 
If the [Installation Selection Screen] does not automatically appear when the CD is 

inserted into the PC, go to the root folder on the CD and run “Launcher.exe” to access 

the [Installation Selection Screen].  

Click each button on the [Installation Selection Screen] to start installation of each 

program. The install button on the 64bit version is only enabled on 64bit OS on Windows 

Vista or later. 

 

✓ Install the 32bit / 64bit MOVIAS Neo  

Install the MOVIAS Neo software. Install 64bit only with a 64bit OS. 

 

✓ Install the HASP HL drive 

Install the driver for the license key (HASP HL) that protects MOVIAS Neo. 

If this driver is not installed on the computer, MOVIAS Neo will not start. If 

this driver is not installed on the computer, install before starting MOVIAS 

Neo. 
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✓ Install DirectX 9.0c 

MOVIAS Neo uses DirectX to display sticks. Version 9.0c of DirectX or later 

is required to properly run MOVIAS Neo on your computer. 

If version 9.0c or later of DirectX is not on the computer, install before 

launching MOVIAS Neo. 

 

✓ Install the 32bit / 64bit MOVIAS Neo Viewer 

Install the MOVIAS Neo Viewer software that displays the MOVIAS Neo 

analysis results. The 64bit version can only be installed on 64bit OS. 

 

✓ Confirm the Version 

Confirm the version of DirectX installed on the computer. Click to display 

the [Version of DirectX] dialog. 

 

 
[Check the Version of DirectX] Dialog 
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Click [Install the 32bit/64bit MOVIAS Neo] and the [Welcome to MOVIAS Neo Setup] 

dialog will appear. 

The following is a description of the 64bit installation process. If you are installing the 

32bit version, the text that appears on the screen may differ slightly, but the installation 

procedure is the same as that for the 64bit version. 

 

If an old version of MOVIAS Neo is installed, we recommend uninstalling that 

one and then run the setup for the new version. 

 

 
[Welcome to the MOVIAS Neo Setup] dialog 

 
Click [Next] to jump to the [Product License Agreement] dialog. 

 

 
[Product License Agreement] dialog 

 

Carefully read the contents of [Provisions Relating to Approved Use and Warranty] 

shown here and if you agree, select “I accept the terms of the product license agreement” 

and then click [Next] to display the [User Information] dialog. If you do not agree, click 

[Cancel] to stop the installation process. 
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 [User Information] Dialog 

 

In the [User Information] dialog, enter the username and company name. Then click 

[Next] to go to [Setup Type] dialog. 

 

 
 [Setup Type] Dialog 

 

In the [Setup Type] dialog, click [All] and then click [Next] to jump to [Installation 

Ready] dialog. In this case, MOVIAS Neo is installed in [C: ¥Program 

Files¥nac¥MoviasNeo]. If the MOVIAS Neo 32bit version is installed to a 64bit OS, 

install to [C: \Program Files (x86)\nac\MoviasNeo].  

When [Custom] is selected, go to the [Installation Ready] dialog via the [Installation 

Folder] and [Custom Setup] dialogs. 
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 [Installation Ready] Dialog 

 

In the [Installation Ready] dialog, click [Install] to start copying files. The [Installing] 

dialog will appear, and the program will be installed.  

Click [Back] to correct the settings. 

 

 

 
 [Installing] Dialog 

 

Once the installation process is complete, the [Finish MOVIAS Neo Installation] 

message appears. Click [Finish] to exit. 
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 [Finish MOVIAS Neo Installation] Dialog 

After installation, MOVIAS Neo is registered to [All Programs] → [MOVIAS Neo 64bit] 

on Windows, and the 32bit version is registered to [All Programs] → [MOVIAS Neo]. 

The MOVIAS Neo program shortcut will be added to the desktop. 
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1.3.2  Install MOVIAS Neo Viewer 

Click [Install 32bit/64bit MOVIAS Neo Viewer] to open the [Welcome to the MOVIAS 

Neo Viewer Setup] dialog. 

The following is a description of the 64bit installation process. If you are installing the 

32bit version, the text that appears on the screen may differ slightly, but the installation 

procedure is the same as that for the 64bit version. 

 

 

If an old version of MOVIAS Neo Viewer is installed, we recommend 

uninstalling that one and then run the setup for the new version. 

 

 

 
[Welcome to the MOVIAS Neo Viewer Setup] dialog 

 

Click [Next] to jump to the [Choose Destination] dialog. 

 

 

 
[Choose Destination] dialog 
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After selecting the destination, click [Next] and the [Ready for Installation] dialog will 

appear. 

 

 
[Ready for Installation] Dialog 

 

In the [Ready for Installation] dialog, click [Install] to start copying files. The [Installing] 

dialog will appear, and the program will be installed.  

Click [Back] to correct the settings. 

After installing, the [Finish Installation] dialog will appear. 

 

 
[Finish MOVIAS Neo Viewer Installation] dialog 
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1.4  Uninstall 

1.4.1  Uninstall MOVIAS Neo 

To uninstall MOVIAS Neo from your computer, open the [Control Panel] and click [Add 

or Remove Programs] ([Add or Remove Applications] in Windows 2000 or [Programs 

and Features] in Windows 7 / Vista). Select [MOVIAS Neo] and click [Change/Remove]. 

 

 
MOVIAS Neo Program Selection 

 

The [Remove Program] dialog will appear. 

 

 
 [Remove Program] Dialog 

 

Select [Remove] in the [Remove Program] dialog and click [Next]. 
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[Remove Program] Dialog 

 

The [Remove Program] dialog will appear.  

Click [Remove] to completely remove MOVIAS Neo. Otherwise, click [Back]. 

Click [Remove] to uninstall MOVIAS Neo and the [Finish Uninstall] dialog will appear.  

 

 
 [Finish Uninstall] Dialog 

 

Click [Finish] to complete the uninstallation. 
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1.4.2  Uninstall MOVIAS Neo Viewer 

To uninstall the MOVIAS Neo Viewer from your computer, open the [Control Panel] 

and click [Add or Remove Programs] ([Add or Remove Applications] in Windows XP or 

[Programs and Features] in Windows 7 / Vista).  

 

 

 
Select MOVIAS Neo Viewer Program  

 

The [Remove Program] dialog will appear. 

 
[Remove Program] Dialog 

 

Select [Remove] in the [Remove Program] dialog and click [Next]. 
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[Verify Uninstall] Dialog 

The [Remove Program] dialog will appear.  

Click [Remove] to completely remove the MOVIAS Neo Viewer. Otherwise, click [Back]. 

Click [Remove] to uninstall the MOVIAS Neo Viewer and the [Finish Uninstall] dialog 

will appear.  

 

 
[Finish Uninstall] Dialog 

 

Click [Finish] to complete the uninstallation. 
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1.5  MOVIAS License Key 

MOVIAS Neo utilizes a MOVIAS license key for software protection. If the license key is 

not properly inserted into the PC USB port of the computer or if the HASP HL driver is 

not installed, MOVIAS Neo will not work. 

 

 
MOVIAS License Key 

 

There are two types of MOVIAS Neo license keys:  a 2D analysis version and a 3D 

analysis version. You cannot use the features of the 3D analysis version with the license 

key of a 2D analysis version. 

 

The MOVIAS Neo License key is not compatible with a MOVIAS Pro license key. 

 

⚫ Warning Message when Starting MOVIAS Neo  

If the MOVIAS Neo license key is not inserted when starting MOVIAS Neo or if it is 

inserted improperly, the following warning message appears. If this happens, make sure 

that the license key is inserted and restart MOVIAS Neo. 

 

 
[MOVIAS License Key Error] Warning 

 

If the error message appears even when the MOVIAS license key is properly 

inserted, the driver may not be properly installed or the license key itself may 

be damaged. Please contact us if this happens. 
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1.6  Operation with Windows Vista or Later Versions 

If installing the 64bit version of MOVIAS Neo, the environment settings (.ini) will be 

stored in the following folder, regardless of where installed. 

   “C: \Users\<<User Name>>\AppData\Roaming\nac\MoviasNeo\” 

 

 

If installing the 32-bit version of MOVIAS Neo and MOVIAS Neo is installed in the 

default location “C: \Program Files”, the environment settings (.ini) will be saved in 

different locations in Windows 7, Windows Vista and Windows XP. In addition to “C: 

\Program Files”, installation is identical for the OS managed folders such as “C: 

\Program Data” or “C: \Windows”. 

 

⚫ Windows XP 

With Windows XP, the MOVIAS Neo environment settings will be saved in  

“C: \Program Files\NAC\MoviasNeo\MoviasNeo.ini”. 

 

 
 

With Windows XP, the 

environment settings will be 

saved in the ini file in 

“C: \Program Files\NAC 

\MoviasNeo”. 
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⚫ Windows Vista and later 

With Windows Vista and later, the MOVIAS Neo environment settings will be saved in 

“C: \Users\<User Name>\AppData\Local\Virtual 

Store\ ProgramFiles\nac\MoviasNeo\MoviasNeo.ini”. 

 

 
 

Even if the project files (.nmp) and other files (AVI/still image/CSV) are saved in the "C: 

\Program Files”, they are also saved in the Virtual Store folder for each user.  

Open the destination folder set in [Environment Settings] in MOVIAS Neo in Explorer 

and click [Compatible Files] to verify the actual save location.  

 

 

Compatible file button 

 

With Windows 7/Vista, the environment settings 

are saved in the .ini file in the above folder. 

 

An ini file with the same name also exists in “C: 

\ProgramFiles\NAC\MoviasNeo” but the 

environmental settings are saved in this ini file. 
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2. Quick Start Guide 

2.1  Launch MOVIAS Neo 

Click the icon  on the desktop to start MOVIAS Neo. Or click Windows [Start] ⇒

[Programs] ⇒ [MOVIAS Neo]. 

 
MOVIAS Neo Start Screen 

 

The [Environment Settings] dialog will appear the program is first launched. Make the 

settings in the project directory under the [Folders] tab. The location set here is where 

new projects will be saved.  

The default is the [MoviasNeo Projects] folder under [My Documents]. 

 

 
 [Environment Settings] Dialog 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. 8-
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29)for details on environment settings. 

2.2  2D Analysis Tutorial 

2.2.1  Create a 2D Analysis Project 

Click  on the main control bar to create a new 2D project. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on projects. 

 

The [エラー! 参照元が見つかりません。] dialog appears. 

 

 

Perform the following.  

① Click [Browse] and select a measurement 

image file to analyze.  

② Set the frame rate. *1)  

③ Place a checkmark in the box for the 

measurement image to be copied to a project 

folder. *2)  

④ Click [OK]. 

 

 

 

 

 

 

 

 

 

The tutorial uses the sample folder [Cellular.avi] as a measurement image file. (The 

default directory for this file is “C: \Program Files\nac\MoviasNeo\Samples 

\Cellular.avi”). 

 

 

 

 

 

 

 

 

 

 

 

*1) When analyzing AVI files created with our high-speed camera and the camera 

control software, the filming speed can be automatically set. Since the filming 

information is loaded from the ***avi.txt file attached to the ***.avi file converted by 

the camera control software, we recommend putting the ***avi.txt file into the same 

folder as the ***.avi file.   

④ 

① 

② 

③ 
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*2) Refer to 3.2.1 Project Folder Structure (P 3-4) for details. 
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After the 2D analysis project is created, MOVIAS Neo switches to the tracking mode 

and the following screen appears. 

 

 

 

 
 

 

 

Click the buttons on the main control bar to perform the corresponding operations. 

Buttons required for the active window and mode are shown on the main control bar. 

Zoom View 

Playback Bar 

Image Window 

エラー! 参照元が見つかり

ません。 Operation Mode Display 

Measurement Point List 

Tracking Dialog Bar 

Project Dialog Bar 
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2.2.2  2D Tracking 

Select the white dot from the target markers  (Quadrant, White Dot, 

Black Dot, and Feature Point), and click in the vicinity of the measurement point on the 

image window. If recognized properly, it will be shown as Point0 on the image and Point0 

will be added to the measurement point list. 

 
 

 

Repeat this operation to add multiple measurement points.  

 

The measurement point position can be fine-tuned in zoom view. The zoom view shows 

the extended image that was clicked in the image window. The measurement point is 

shown in yellow in the zoom view, and the following two symbols show the status. 

 

+  The measurement point is not set. Fine-tune the position in zoom view.  

X  The measurement point is set. 

 

 

To fine-tune, drag the + mark in zoom view or click  to automatically detect the center 

of the mark. After adjusting, click  to confirm the position of the measurement point. 

 

         
 

 

 

 

After confirming the position of the measurement point, click 

 on the tracking control bar to start auto-tracking in the 

forward direction. 

 

Click near the marker 

Add measurement point to the image window 

Point0 is added to the measurement 

point list  

Fine tune the 

measurement point 

position in zoom view 

Confirm the position 

Confirm the 

position. 

Auto-detect the 

center of the 

mark. 

Drag to fine 

tune 

Tracking control bar 
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If the tracking is interrupted, stop auto tracking and change the values of [Template 

Size] and [Search Area] in  [エラー! 参照元が見つかりません。 (p. 4－11.  

Or switch to semi-auto  tracking or manual  tracking on the measurement point list. 

 

After tracking is complete, click  to exit the tracking mode. The update confirmation 

message appears. Click [Update]. 

 

 
 

After the tracking mode is complete, it switches to the synchronized display mode. 

 

 

Tracking Screen 
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2.2.3  2D Calibration 

Converts the tracking results found in [2.2.2 2D into real scale values.  

 

Access the measurement image in the synchronized display mode and click on the エラ

ー! 参照元が見つかりません。 . It switches to the real scale conversion mode for 

calibration and the following screen appears. 

 

 

 

 

 
 

Real scale conversion dialog 

The buttons required for the real scale conversion 

mode are found on the main control bar. 
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 On the measurement image, click two points of a known distance. These clicked points 

are called control points. Here, select quadrants  to set control points as the エラー! 

参照元が見つかりません。. 

On the measurement image, click near the marker. The first point is displayed as C-

Mark1. The second point is C-Mark2. 

 
Fine-tune the positions of the points in zoom view. The adjustment process is the same 

as with the tracking process. 

 

 

 

After specifying the control points, perform 

the following steps in the [2D Calibration] 

dialog.  

① Input the distance between the two 

points designated in [Length of Reference 

Line] in the [Reference Plane].  

② Input the distance between two points 

to calculate the [Conversion Coefficient].  

③ Click [Finish] to automatically apply 

the calibration results and access the 

synchronized display mode. 

 

 

 

 

The calibration method currently in use can be verified under [Calibration Mode Node] 

in the [Project Tree].  

  

If necessary, set in the tabs for [Origin and Axis], [Plane Correction], [Depth Plane] and 

[Scale Plane]. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) , エラー! 参照元が見つかりません。エラー! 参照元

Click 2 points of a known distance 

Calibration Settings Screen 

③ 

① 
② 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 2－9 

が見つかりません。s (p. エラー! ブックマークが定義されていません。) for details on 2D 

calibration. 
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2.2.4  Create Analysis Graphs 

Access the measurement image window in the synchronized display mode and click on 

the エラー! 参照元が見つかりません。  to display the [Create a New Graph] dialog. 

 

Perform the following.  

① Select the measurement 

points from [Measurement 

Points] to create a graph.  

② Select the [Physical 

Quantities], [Unit] and 

[Component] for the vertical and 

horizontal axes of the graph.  

③ Input the [Graph Title], 

[Component] and [Color].  

④ Select the [Filter] 

⑤ Click  to add to the list of 

graphs displayed.  

⑥ Click [Draw Graph]. 

 

 

 

If preparing multiple graphs, repeat these steps and add each graph to the list of graphs 

displayed. Check [Draw in the Same Graph] to draw all of the graphs added to the graph 

list on the same graph. 

 

 
Graph Display 

 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on creating graphs. 

The graph created is 

added to the project tree. 

Double click to display the 

graph. 

⑥ 

① 

②  

⑤  

③  

④  
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2.2.5  Export as a CSV File 

Export the tracking results, measurement results and analysis graph data to a CSV file. 

Go to the graph list and click [Save as File Format] → [CSV Format] on the right click 

menu to export the data. 

 

 
 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on exporting as CSV files. 

 

2.2.6  Save Measurement Results 

Click the エラー! 参照元が見つかりません。  to assign a name and save the project. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) , 3.2.6 Save Project As (p. 3－13) for details 

on saving projects. 
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2.3  3D Analysis Tutorial 

2.3.1  Create a 3D Analysis Project 

Click  on the Main Control Bar to create a 3D analysis project. 

The [エラー! 参照元が見つかりません。 dialog appears. 

 

For 3D analysis, designate measurement images photographed with at least two 

cameras as well as the calibration chart image. 

Perform the following. 

 

① Set the number of cameras used in 

[Number of Synchronized Cameras]. 

② Select the measurement image file 

for analysis with [Browse] in the 

measurement image file  

③ Set the frame rate. *3)  

④ Designate the calibration image 

file.  

⑤ Check to copy the measurement 

image and calibration image to the 

project folder. Refer to 3.2.1 Project 

Folder Structure (P 3-4) for details. 

⑥ Repeat ② ～ ⑤ for the [Number of 

Synchronized Cameras] and then click 

[OK]. 

 

 

 

 

 

 

This tutorial uses image files found in the sample folder. (The default directory of these 

files is in C: \Program Files\nac\MoviasNeo\Samples\3D. 

 

 

 

 

 

 

 

 

 

 

*3) When analyzing AVI files created with our high-speed camera and the camera 

control software, the filming speed can be automatically set. Since the filming 

information is loaded from the ***avi.txt file attached to the ***.avi file converted by 

the camera control software, we recommend putting the ***avi.txt file into the same 

folder as the ***.avi file.   

② 

① 

③ 

④ 

⑤ 
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Make the settings for the measurement image files and calibration image files as follows. 

Camera #1 Measurement image file  

Calibration image file 

L1-1.avi 

L-1-1-1.avi 

Camera #2 Measurement image file  

Calibration image file 

R1-1.avi 

R1-1-1-1.avi 

The same file can be set as the measurement image and the calibration image. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for details on creating 3D projects. 

 

 

If the 3D analysis project is done, MOVIAS Neo switches to the tracking mode and the 

following screen appears. 

 

 

 
 

 

 

 

Click any button on the エラー! 参照元が見つかりません。  to perform the various 

operations. Buttons required for the active window and the mode can be found on the エ

ラー! 参照元が見つかりません。. 

 

List of measurement points 

Tracking dialog bar 

Zoom 

view 

Operating Mode 

Image window 

エラー! 参照

元が見つかり

エラー! 参照元が見つかりません。Main Control Bar 

Project Dialog Bar 
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2.3.2  3D Tracking 

Tracking is performed on the measurement points for the measurement images from 

each camera.  

①  Performs tracking for the first camera (identical to that for 2D tracking)  

②  Displays the measurement image from the second camera and switches to the 

tracking mode.  

 

Double click on the second camera measurement image node on the project tree to 

show the measurement images for the second camera. 

 

 

 
 

After adding the measurement points for the 1st camera, the status of the 

measurement points for the 2nd camera is [Awaiting Camera Mapping].  

 

③ Click on the エラー! 参照元が見つかりません。    for mapping between cameras. 

The status of the 

measurement points for the 

2nd camera is [Awaiting 

Camera Mapping] 

Measurement 

image node for the 

2nd camera 
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④ Select points for mapping from the measurement point list. 

 
 

 
 

⑤ Click near the corresponding point on the image window to auto-detect the 

corresponding points. 

    
 

 

If auto detection fails, correct the position with the zoom view. After correcting, click 

the set zoom view button  to set the position. 

⑥ Repeat ④, ⑤ to set the required corresponding points. 

⑦ After finishing the required corresponding points, perform auto-tracking using the 

same process as that for 2D analysis. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エ

ラー! ブックマークが定義されていません。) for details on 3D tracking. 

Click the corresponding point 

After clicking on the corresponding 

points on the image window to set 

the position 

After selecting the 

corresponding points from 

the measurement point list 

Once a measurement point is selected 

from the measurement point list, the 

corresponding points are shown without 

verifying the position 
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2.3.3  3D Calibration 

Converts the tracking results from [2.3.2 3D] into real space coordinates. With 3D 

calibration, input the real space coordinates from the calibration chart and specify the 

control point position on the calibration image for each camera. 

 

① The calibration image is displayed from the project tree. 

 
 

② Click  on the Main Control Bar to switch to the calibration mode. 

The [Calibration 3D] dialog will appear. 

 
 

[Calibration 3D] Dialog 

Double click the calibration 

chart on the project tree to 

display the image. 
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③ Input the real space coordinate values for the control points in the [Real Space 

Coordinate] tab of the [Calibration 3D] dialog. This tutorial loads the real space 

coordinates on the calibration chart from the CSV file created previously. 

 

The real space coordinate file used is 5poles_chart_3d_no1.csv in the Sample 

folder. (If installed using the defaults, it is C: \Program 

Files\nac\MoviasNeo\Samples\Cal\5poles_chart_3d_no1.csv. Click [Import] to 

select the file.) 

 

The real space coordinates can also be input directly to the list. 

 
 

 
 

 

The coordinate system in this tutorial is the right-handed system, as shown in the 

following figure. 

 

Real Space Coordinates 

X 

Y 

Z 
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④ Set the corresponding control points under the [Image Coordinate Settings] tab. This 

tutorial uses the standard 5 pole chart. Select [Add Sequential Label Number] and 

input [1]. Select the white dot  from the エラー! 参照元が見つかりません。 on the 

エラー! 参照元が見つかりません。 and click to set the control points corresponding 

to the selected calibration image. 

 

 
 

 

 

Fine tuning of the control point positions is performed in zoom view. Once the control 

points are properly recognized, C-Point1 appears on the screen and the control point 

coordinates are set. (Repeat the same process for all of the control points.)  

 
 

Check to make sure the real space coordinate number and the control point number 

match. 

 

Image Coordinate Settings 

The positions of the specified 

control points are displayed on 

the image and on the list. 
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If the order of the control points is incorrect, the numbers can be automatically 

corrected by clicking on [Auto Identify Labels] after designating all the control 

points. Make sure the real space coordinates and control point numbers are correct. 

 

Click [Finish] in the [Calibration 3D] dialog after performing the same process 

for the calibration images for all the cameras and the 3D calibration will be 

complete.  

If the default settings are used, the 3D measurement data calculations are 

performed after tracking or 3D calibration. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エ

ラー! ブックマークが定義されていません。) for details on 3D calibration.  

 

2.3.4  Define Sticks 

After constructing the 3D measurement data, click  on the エラー! 参照元が見つかり

ません。 while in the display or synchronized display mode to access the [エラー! 参照元

が見つかりません。]. 

 

 

① 

② 

③ 

④ 

Perform the following. 

 

 Select a measurement point from 

the [Measurement Point List].  

 

 Click  to add the starting and 

ending measurement points to the 

[List of Stick Components].   

 

 Click [Add].  

 

 Click [Complete]. 
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Define Stick Dialog 
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Click  on the エラー! 参照元が見つかりません。 or select a stick node from the project 

tree and click on [Create New] from the right click menu to perform the 3D stick display 

 

 
 

 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for details on sticks. 

2.3.5  Print 

You can print images, lists, graphs, and sticks from the right click menu on the window 

displayed. 

 

2.3.6  Save Measurement Results 

Click  on the エラー! 参照元が見つかりません。 to assign a name and save the project. 

 

Refer to 3.2.6 Save Project As (p. 3－13) for details on saving. 

 

 

 

 

 

 

 

 

 

 

3D Stick Display 

The stick node is located under 

analysis data in the project tree. 
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3. MOVIAS Neo Operations 

3.1  MOVIAS Neo Overview 

 

Double click  on the desktop to launch the application. The figure below shows the 

screen when a project is opened in the sync display mode.  

Active window operations are performed with the main control bar and playback bar. 

Only the required items for the active window and mode are shown on the エラー! 参照

元が見つかりません。.  

Project operations and window displays (images, graphs, lists, sticks) are performed from 

the project dialog bar. 

 

 

 
Application Overview 

 

 

 

 

 

 

 
 

 

 

 

 

 

 
エラー! 参照元が見つかりません。 

Project Toolbar 

Import Toolbar 

Analysis Toolbar 

Mode Toolbar Settings Toolbar 

Zoom Control Bar Window Toolbar 

Mode Display Bar 

Playback Control Bar Playback Slider Bar Playback Settings Control Bar 

エラー! 参照元が見つかりません。(Display Mode) 

Playback Bar 

Zoom View 

Window Display 

Drawings Toolbar 

エラー! 参照元が見つか

りません。 

Excel Export Toolbar 

Project Dialog Bar 
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3.1.1  2D Analysis Process 

In general, the process for 2D analysis follows a flow of [Create a Project] → [Pre-

processing] → [Tracking and Calibration] → [Construct Measurement Data and Create 

Analysis Data]. 

 

 
Overview of the 2D Analysis Process 

 

An overview of [Tracking – Calibration] is shown below. 

The operation mode is shown [Mode Display Bar] of the [Main Control Bar]. 

 

 

 
Operation Mode Figure for 2D [Tracking – Calibration]  

 

[Preprocessing] and [Construct Measurement Data – Create Analysis Data] are 

performed in the Display / Synchronized Display modes. 

  

Tracking 

★Real scale conversion 

★Change perspective 

Correct optical distortion 

Reconstruct 

measurement 

data 

Create analysis graph 

Trajectory figure 

Display sticks 

Track 

measurement 

points  

Track virtual points 

Assign a function 

Create virtual points 

Tracking, calibration 

 
Reconstruct measurement data 

Create analysis data 

 

Pre-

processing 

Image 

preprocessing 

T0 correction 

Create・load a 

project 

 

Create project 
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3.1.2  3D Analysis Process 

The process for 3D analysis is identical to that for 2D analysis, with a flow of [Create 

Project] → [Preprocessing] → [Tracking and Calibration] → [Reconstruct Measurement 

Data and Create Analysis Data] 

 

However, since multiple cameras are involved in 3D analysis, tracking and calibration 

(including lens distortion correction) is performed multiple times. 

 
Overview of the 3D Analysis Process 

 

An overview of [Tracking and Calibration] is shown below.  

The operation mode is shown in the [Mode Display Bar] in the エラー! 参照元が見つかり

ません。]. 

 

 
Operation Mode Figure for 3D [Tracking • Calibration]  

 

[Preprocessing] and [Reconstruct Measurement Data and Create Analysis Data] are 

performed in the display and synchronized display modes. 
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3.2  Projects 

MOVIAS Neo handles tracking and analysis data in project units, and all information is 

saved in project files (.nmp).  

In MOVIAS Neo, a maximum of 8 project files can be opened at the same time, and 

multiple open projects can be saved and loaded as a session file (.nms) 

 

Attn:  Users of MOVIAS Neo Ver.1 

The operating functions of the project files has changed somewhat from Ver. 2. 

Please refer to 3.2.10  For For Users of MOVIAS Neo Ver.1 (p. 3－19) for details. 

 

3.2.1  Project Folder Structure 

In the [Folders] tab under [Environment Settings], MOVIAS Neo creates [project folders] 

with the same name as the project in specific folders called [Projects]. The necessary files 

are created for projects and saved in the [Projects Folders]. Make sure to create a project 

file (with an extension of “.nmp”). 

 

The structure of the project folder is as follows. For example, [Projects] are in [MoviasNeo 

Projects] in [My Documents], with the names of projects called [Project 1] and [Project 

2]. Processing is conducted using the measurement image and calibration image (as well 

as the optical distortion image and the external image for processing) specified during 

the creation of the project. 

 

The images from [Project 1] are copied into the [Project 1] folder to create the project. 

[Project 2] references the images in the image folder to create the project. 

 

 
Project Folder Structure 
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Settings can be made in this manner to either copy images to the project folder or to 

reference images. Select copy/do not copy the image file in the same way as when 

importing an image (p. 8-18) or adding an optical distortion correction chart (p. 5-25). 

Settings are made during creation of the project. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for details on creating projects. 

 

 
 

⚫ Copy Image Files 

Check [Copy Image Files] to copy images to a project folder.  

Projects can be moved or copied to each project folder for managing.  

This setting is used when you must move project folders such as when conducting 

analysis on multiple computers. 

 

⚫ Do Not Copy Image Files 

Uncheck [Copy Image Files] when not copying images to a project folder and when 

referencing specific locations to create projects.  

This setting is used for batch handling measurement images that are not moved and 

when analyzing projects with images that have large file sizes 

When measurement images are open, MOVIAS Neo searches locations by referencing 

images from project creation. Project folders can be referenced if an image cannot be 

found with this. 

 

If opening projects by moving referenced image files to another location, copy the image 

from the referenced location to the project folder. 
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3.2.2  Create a Project 

⚫ Create a 2D Analysis Project 

Create a project for 2D analysis. Perform either of the following operations to create a 

2D analysis project. 

 

✓ Click   on the project toolbar on the エラー! 参照元が見つかりません。.  

✓ Click [File] ⇒ [New 2D Project] on the menu. 

 

The [Create a 2D Analysis Project] dialog appears.  

Specify the measurement image, image information and camera name. Click [OK] to 

create a 2D analysis project.  

The measurement image appears after creating a project and then it switches to the 

tracking mode. 

 

 
 

 

Measurement Image File 

Designates the measurement image for the target camera. The measurement image 

file formats that can be set include AVI, MCFF, BMP, JPG, PNG and TIF 

 

Copy the Image File 

   Sets the image file in the project folder to copy/do not copy. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details. 

 

Frame Rate 

Sets the frame rate (fps). 

 

Setting for the measurement image file 

Check / set video information 

Camera name 

Preview image 

Set the image file in the 

project folder to copy/do not 

copy  
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Image Size 

   Shows the size of the loaded image. 

 

“T0”Frame (Time Starting Poitn)  

Sets the “T0” frame (time starting point). 

 

Number of Frames 

Displays the total number of frames for the image. 

 

Start Frame 

Displays the starting frame of the loaded image. 

 

End Frame 

Displays the ending frame of the loaded image. 

 

Camera Name 

  Sets the camera name shown on the project tree. The default is the name of the 

measurement image file. * Do not use the characters \/: ! in the camera name. 

  Check [Auto Create from the Image File Name] to automatically set the camera name 

from the image file name. 

 

Preview Image 

  Shows a preview of the measurement image currently selected. Not shown if there is 

an invalid name or if a file that MOVIAS Neo cannot process is selected. 
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⚫ Create a 3D Project 

Create a project for 3D analysis. Perform either of the following operations to create a 

3D analysis project. 

 

✓ Click   on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見

つかりません。. 

✓ Click [File] ⇒ [New 3D Project] on the menu. 

 
Two or more measurement image files and calibration image settings are required to create a 3D 

project.  

First, set the number of cameras used for analysis. Next, set the following for each camera 

 

✓ Camera name  

✓ Measurement image file  

✓ Video information settings  

✓ Calibration image  

✓ Copy/do not copy the image to the project folder  

Click [OK] to create a 3D analysis project.  

After creating a 3D project, the measurement image for the first camera appears and it switches to the 

tracking mode. 

 

 

 
 

Number of Synchronized Cameras 

Designates the number of cameras used for measurement. Required for the 

measurement images. 

 

Camera Selection Tab 

Select the camera. 

Camera selection tab 

Setting for number of 

sync cameras 
Camera name 

(each camera) 

Measurement image file 

setting (each camera) 

Calibration image file 

setting(each camera) 

Check/set video information 

(each camera) 

Preview image Left: 

measurement image  

Right: calibration image 

Copy/do not copy setting for image file 

in the project folder (measurement 

image・calibration image) 



MOVIAS Neo V3 User’s Guide  nac Image Technology Inc. 

(00355)L 3－10 

 

Camera Name 

Sets the camera name shown on the project tree. The default is the name of the 

measurement image file. Set for each camera. Do not use the characters \/: ! in the 

camera name. 

  Check [Auto Create from the Image File Name] to automatically set the camera name 

from the image file name. 

 

Measurement Image File 

Designates the measurement image for the target camera. Set for each camera. 

 

Copy the Image File (Measurement) (Calibration) 

Sets the designated measurement image file and the calibration image file in the 

project folder to copy/do not copy. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p.エラ

ー! ブックマークが定義されていません。) for details. 

 

Frame Rate 

Sets the frame rate (fps). 

 

Image Size 

   Shows the size of the loaded image. 

 

“T0”Frame (Time Starting Point)  

Sets the “T0” frame (time starting point). 

 

Number of Frames 

Displays the total number of frames for the image. 

 

Start Frame 

Displays the starting frame of the loaded image. 

 

End Frame 

Displays the ending frame of the loaded image. 

 

Calibration Image File 
Designates the calibration image for the target camera. Set for each camera. 

 
If there is a 3D calibration parameter file (*.3dc) in the calibration image folder, that 

file is automatically loaded, and a project created with those calibration parameters is 

set. For example, if the calibration image file is "Calib.avi", the file "Calib.3dc" in the 

same folder is automatically loaded. If there is no 3D calibration parameter file, only 

the image is loaded. 
 

Preview Image 
Preview of the measurement image and calibration image currently designated. The 

measurement image is on the left and the calibration image is on the right. 
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3.2.3  Open a Project 

Open a saved project file (.nmp). A maximum of 8 projects can be opened at the same 

time. When a project is opened, you can continue from the point when it was last saved. 

Perform any of the following to open a project. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [File] ⇒ [Open Project] on the menu. 

✓ Drag the project file (.nmp) to the main window. 

 

 
To open a project file, MOVIAS Neo must be able to 

load it and write to it. If there was an error opening 

the projects, as shown in the dialog box on the right, 

check and make sure the load attributes for that file 

are correct. 

 

 

3.2.4  Close a Project 

Close a project selected from the current project tree. Perform either of the following 

operations. 

 

✓ Click [File] ⇒ [Close a Project] on the menu. 

✓ Select the project node on the Project Tree and click [Close Project] from the 

right click menu.  

 

 

Open a project to add it 

to the project tree. 
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3.2.5  Save a Project 

Save tracking data, calibration data or analysis data. Perform any of the following 

operations. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [File] ⇒ [Save Project] on the menu. 

✓ Press Ctrl + S. 

✓ Select the project node on the エラー! 参照元が見つかりません。 and click [Save 

Project] on the right click menu. 
✓ Click OK on the [Save?] dialog to close a project.  

 

A message displays the results when the tracking, 

calibration and optical distortion correction mode 

is complete. 

 
Select [Update] to save the current results to a file.  

Select [Discard] to delete the current results and return to 

the previous mode. 

 

Set to confirm refresh operations when mode ended. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) [Restore Settings] tab for details. 

 

Attn:  Users of MOVIAS Neo Ver.1 

The operating functions of the project files has changed from Ver. 2. Please 

refer to 3.2.10 For Users of MOVIAS Neo Ver.1 (p. 3－19) for details. 

 

 

Attn:  Users of MOVIAS Neo Ver.2.10 and later 

Confirmation when ending modes has been changed. 

In Ver2.20, when selecting [Discard] in the dialog above, the preceeding 

contents are discarded and the project file is reloaded. 

With versions before Ver2.10, if you select [No] to [Save?], the preceeding 

contents are not saved to the file but are retained as data. 
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3.2.6  Save Project As 

Assigns a name to save the project selected on the current project tree. 

For a project with a setting of [Copy Image File] when a new project was created, the 

image file is also copied when saving under an assigned name. 

 

Click [File] → [Save Project As] on the menu to display the save dialog. Assign a new 

project name and save. Do not use the characters ?*<>\”/|: ! in the project name. 

 

 
[New Analysis Project] dialog 

Type of Project 

Shows the type of project saved. 

Project Name 

Sets the project name. 

Test Number 

Shows the test number set in [Project Information] (p. エラー! ブックマークが定義さ

れていません。). 

Folder 

Creates a folder to save projects. The default is the folder set in “Projects” in 

“Environment Settings” (p. 8-28). 

Comments 

Shows comments for the project set in [Project Information] (p. エラー! ブックマーク

が定義されていません。). 

3.2.7  Change a Project Name 

Changes the name of the project selected in the current 

project tree. Perform any of the following. 

 

✓ Edit route nodes on the project tree.  

✓ Select route nodes on the project tree and click [Rename 

Project] on the right click menu.  

✓ Click [File] → [Change the Project Name] on the menu.  

 

Do not use the characters ?*<>\”/|: ! in the project name. 
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3.2.8  Sessions 

You can save and load multiple open projects as a [Session]. Sessions are handled as files 

(.nms) and the full path is saved for each project. *6) 

 
Overview of a Session File Content 

Perform the following from [File] → [Session] in the menu. 

 
 

Open a Session 
Open a full path project saved in a session file (.nms).  

  At this point, all of the currently open projects are closed. 

 

If a project file saved in the session file cannot be found 

when a session is opened, a warning appears and only 

the projects found are opened. 
 

Save a Session 

Saves the full path of multiple projects currently open as a session file (.nms). 

 

Close a Session 

Closes all of the projects currently open. 

 

 

*6) The session file saves only the full path to each project file currently open. You 

must separately save each project file. 

 

 

 

 

 

 

Session menu 
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3.2.9  Project Template 

Project templates save existing projects as project template files (nmt) and function to 

create projects from template files. 

Projects are created from the template files using all of the parameters other than 

tracking results (tracking settings, calibration data and such). 

 

Project template files (.nmt) are used in conjunction with the auto update function for 

control points, center of gravity points, analysis graphs, sticks, tracking figures, and the 

analysis procedure can be automated. This function is used to perform the same analysis 

on duplicates of different measurement images. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for automatic updates of visual points and 

center of gravity points and refer to エラー! 参照元が見つかりません。エラー! 参照元

が見つかりません。 (p. エラー! ブックマークが定義されていません。) for automatic 

updates of graphs. 

 

Next is an example that uses the project template function, creates a project template 

file from a [Previous Project] and creates multiple projects from the same project 

template. 

① A [Previous Project] creates tracking, real scale conversion, control points and 

analysis graphs from the new project created. 

② A project template file is created from this [Previous Project]. 

③ Next, [Project 1] is newly created from the project template created in ②. Switch 

to the tracking mode to arrange the tracking points, adjust the position and 

conduct tracking. Once tracking is done, create the measurement data that 

recalculates the control points and analysis graph with the tracking data and 

performs auto updates. 

④ In the same manner as in ③, [Project 2] and [Project 3] are created from the 

project template using different images, in order to create multiple projects. 
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Example Using the Project Template 
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⚫ Create a Template from a Current Project 

Click [File] → [Project Template] → [Create a Template from a Current Project] on the menu 

to create a project template file (.nmt) from a currently selected project. 

 

 
 

Since the file save dialog is shown, input the file name and save. At this point, a 

description of the template file is given. 

 

 
 

⚫ Create a Project from a Template 

Click [File] → [Project Template] → [Create a Project from a Template] on the menu to create 

a project from a project template file (.nmt) 

Open the project template file (.nmt) from the open file dialog. While the file is saving, if 

the file description is included, a description of the template file appears under the dialog. 

 
 

 

Project template  

menu 

The template file 

description appears 

Notes describing the 

template file 
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Open the project template file to show the create project dialog. Select the measurement 

image and create a project. Specifying an image with the same size as the project 

template file is required. For 3D analysis projects, the size of the measurement images 

and the size of the calibration images for all the cameras must match with the template 

files.  

 
 

projects are created by applying all of the saved project parameters (tracking settings 

and calibration parameters) to the template. 

 

If creating a 2D measurement project from 2D measurement project template files, the 

project template calibration settings are applied to the 2D calibration parameters. 

 

If creating a 3D measurement project from a 3D measurement project template file, the 

project template calibration settings are applied to the 3D calibration parameters. If 

creating 3D measurements, there is no need for calibration image settings. 

Calibration image settings are required to verify or correct calibration settings for project 

templates. 

 

For 3D projects created from project templates, the calibration image can be set from 

[Change Image File] on the right click menu of the project tree after creating the project. 
 

 
 

 

Calibration image settings 

Select from the project tree 
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3.2.10  For Users of MOVIAS Neo Ver.1 

MOVIAS Neo Ver2 is different from Ver1. 

 

⚫ Project Files 

The project file format is different from Ver. 2.00. When saving projects created with 

MOVIAS Neo Ver.1, they are saved as Ver. 1. Projects created in Ver. 2 cannot be opened 

with MOVIAS Neo Ver.1. 

 

 
When Opening a Ver. 2 Project with MOVIAS Neo Ver.1  

 

When changing project files created with Ver.1, save confirmation message appears.    

If you select [Yes], it is saved as a MOVIAS Neo Ver.2 project file. If you select [No], the 

save will be cancelled. 

 

If you must keep Ver.1 project files, make sure to use [Save As]. 

 

⚫ External Project Link Function 

MOVIAS Neo Ver.2 does not support the new linking function for external projects. 

Instead, use the open multiple projects function to compare analysis results.  

Ver.2 cannot perform links to external projects created in Ver.1. 

 

Click [File] → [External Project Analysis Results] → [Delete] on the menu to delete the 

link with an external project. 
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3.3  Operating Modes 

With MOVIAS Neo, playback, synchronized playback, tracking, calibration and 

measurement data creation is conducted in each of those modes. 

 

The mode display bar for the operation main control bar is displayed for the current 

operation mode.  

 

 

3.3.1  Display Mode 

The display mode is the mode to perform playback operations on the active window. 

Perform either of the following. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the main control bar. 

✓ Click [Playback] → [Display Mode] on the menu. 

 

Perform any of the following to open a new window. 

 

✓ Click [Show Video] on the right click menu on the 

project tree mode.  

✓ Double click on the project tree mode. 

 

You must switch to the display mode to access エラー! 参照元が

見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。), Export as AVI (p. エラー! ブックマークが定義されていませ

ん。), [T0 Frame (Time Starting Point)] (p. 8－27), エラー! 参照

元が見つかりません。 (p. エラー! ブックマークが定義されていま

せん。).  
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3.3.2  Synchronized Display Mode 

Synchronized display mode of the window currently displayed. 

If frame jumping a window, all the windows displayed jump to the same frame. 

Perform either of the following to access the sync display mode. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the main control bar. 

✓ Click [Playback] → [Synchronized Display Mode] on the menu 

 

The sync display mode is activated immediately after a new window is open. 

 

If playing back in this mode, all the windows perform synchronized playback. The order 

of operations is identical to that for the display mode. You can adjust the loop playback 

and the playback range. The playback frame range is the maximum range for all the 

windows. The update time interval during synchronized display is the frame rate on the 

selected window. 

 

The sync display mode will remain even when switching to an active window that cannot 

be a window to active from a window processing any mode. For example, if the graph 

window is made the active window during tracking, the graph window switches to the 

sync display mode 
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3.4  Playback Operations 

3.4.1  Playback 

Plays back in an active window. 

Playback using the エラー! 参照元が見つかりません。 

 

  Jump to starting or ending frame 

  Frame by frame forward, frame by frame rewind 

 ( ) Play (Loop play) 

 ( ) Reverse playback (reverse loop play) 

 Stop 

 

During playback, each window functions as follows.  

 

Image Window Plays images 

Graph Cursor moves along with the current frame. 

List Selection moves along with the current frame. 

Stick Displays the current frame stick data. 

3.4.2  Loop Playback 

Performs loop playback within the playback range. Click [Play] once during playback for 

loop playback. The playback range is repeatedly played during loop playback. 

Click [Stop] or switch to another mode to end the loop playback. 

 

Loop Play 

 

Access playback to enable only playback 

in the current direction and stop. Press 

[play] again for loop playback. When 

there is a short range for a loop, it is 

easiest to temporarily set a longer range 

for loop playback and then set it to a 

shorter range for playback. 

 (Forward loop playback cannot be made 

at the final frame. Likewise reverse loop 

playback cannot be made at the first 

frame.)  

 

 
 (while playing)  

 

 
 (during loop playback)  
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3.4.3  Index Frame Setting 

Registers the designated frame as the index frame. 

Click   on the エラー! 参照元が見つかりません。 of the エラー! 参照元が見つかりま

せん。 to set. 

 

 Register and Cancel Index Frame 

Registers the current frame as the index frame. If cancelling the index frame, 

move to the target index frame and click  again. 

Index frames for all the images displayed in the synchronized display mode 

are registered or cancelled. 

 

 Jump Index 

Jump to the next index frame. 

 

3.4.4  Playback, Tracking Range Settings  

Conducts playback and tracking processing for the playback range. 

After creating a project, the playback range is set for the entire range of video data. 

 

Drag the playback range with the playback slider on the playback bar or input a number 

into the playback setting control bar on the playback bar to set the playback range. 

 

Or, set the current frame as the [Start Frame] with , or set the current frame as the 

playback end frame with . 

 

 
 

 

 

 
 

 

With synchronized playback, you can set the synchronized playback range from the 

playback range for all windows shown. 

 [And] button Sets the overlapping range for the playback range on all 

the display windows as the synchronized playback range. 

 [Or] button Sets the range including all the playback range for all of 

the display windows as the synchronized playback range. 

Playback range 

Playback range 

And / Or button 
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3.4.5  Frame Rate 

The frame rate is set from the playback control bar on the playback bar.  

The following values can be set for the frame rate. The frame rate can be input directly. 

 

 

3.5  Correct the Image Displayed 
Adjusts the image quality in the active window.  

Switch to the display mode and click [Playback] → [Image Quality] in the menu to show the image 

quality adjustment setting dialog. 

 

This adjustment only applies to the image shown. It is not reflected in the tracking mode. 

If conducting image quality adjustment for tracking, refer to エラー! 参照元が見つかりま

せん。 (p. エラー! ブックマークが定義されていません。). 

 

Gamma Correction 

Select from OFF, LOW, NORMAL 

 

Contrast Adjustment 

Set in a range of 0～300. 

 (Default value:  100)  

 

Brightness Adjustment 

Set in a range of -200～200. 

 (Default value:  0)  

 

Chroma Adjustment 

Set in a range of 0～200. 

 (Default value:  100)  

 

Default Button 

Restores all the settings to the default values. 
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3.6  Zoom In or Zoom Out the Image Displayed 

Zoom the displayed image with the zoom control bar on the main control bar. 

 

 
Zoom Control Bar 

 

 Switch to enable and disable zoom. Use when zooming into a specific area. 

 

 Extended display.  

Zoom rates are as follows. Minimum 25% ⇔ 33% ⇔ 50% ⇔ 100% ⇔ and 

then in increments of 100% to a maximum of 1600% 

 

 Shrunk display. 

 

 Display the image at the original size. 

 

 Display the image fit to the size of the window. 

 

3.6.1  Zoom In to a Specific Area 

The cursor changes into a magnifying glass on the image when the zoom tool is enabled. 

At this point, left click the image to zoom in, centered around the location clicked. 

Also, drag on the image and a rectangle with a red border will appear. Stop dragging to 

zoom in at the center of the rectangle. 

   

 

 

 

 

 

 

 

Zoom in a 

specific area 
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3.6.2  Zoom In or Zoom Out Using the Mouse Wheel 

Zoom in on an image by turning the wheel towards the back and zoom out by turning to 

the front. Zooms without changing the position of the cursor. 

3.6.3  Scroll Across the Image  

Press and drag the wheel on the image to scroll across the image。 

 

  
 

Drag with 

the wheel 
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4. Tracking 
 

4.1  Tracking Mode 

The tracking mode is the mode to perform interpolation or tracking of the display 

settings, tracking settings and functions for the measurement points. 

 

To switch to the tracking mode, access the measurement image window and perform any 

of the following. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [Playback] ⇒ [Tracking Mode] on the menu. 

✓ Click [Change to Tracking Mode] on the right click menu in the measurement 

image window. 

 

Switch to the tracking mode to display the measurement point list and the tracking 

dialog bar. 

 

  
Overview of the Tracking Mode 

 

 

 

 

 
エラー! 参照元が見つかりません。 (Tracking Mode)  

Zoom control bar Mode display bar 

Window toolbar 

Measurement point selection 

toolbar 

Operating mode toolbar 

Tracking control bar 

Main control bar 

Measurement point list Tracking dialog bar 

Zoomview 
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4.1.1  Tracking Dialog Bar 

Shows the tracking results and tracking status. Shown only in the tracking mode. 

The tracking dialog bar displays the following. 

 

✓ X‐T graphs, Y‐T graphs, X‐Y graphs 

✓ Tracked, untracked frames 

✓ Tracking status (regardless of interpolation). 

 

⚫ X‐T, Y‐T, X‐Y 

Shows the tracked coordinate values. Displays the X coordinates and time or frame 

graph, Y coordinates and time or frame graph, X and Y coordinate graph. 

 

 

 

 

 

 

 

 

⚫ Tracked or Not Tracked 

This is a graph with Point ID on the vertical axis and time or frame on the 

horizontal axis. Determines whether tracking is based on the presence of plots. If 

the location confirmation is successful, a tracked graph is shown. 

If location verification is not performed (such as when tracking fails, or 

measurement points are deleted) an untracked graph is shown. 

Point ID can be verified in エラー! 参照元が見つかりません。 (p. エラー! ブックマー

クが定義されていません。). 

 

 
Example of the tracking shown for Point 0 (ID #: 1). Tracked frames are plotted.  

 

 
Example of the untracked section shown for Point 0 (ID #: 1). Untracked frames are 

plotted. 
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⚫ Tracking Status 

Graph with Point ID on the vertical axis and time/frame on the horizontal axis. 

Shows the status of interpolation conducted during tracking. 

“・” is shown if tracking was successful and “X“ is shown when tracking is 

restarted (hidden point tracking). “ ■ “is shown during group tracking and   

“ ◆ ” is shown with function fitting. 

 

 

 

 
Example of Tracking Status shown for Point 0 (ID #: 1) 

 

 

 

⚫ Mouse Right Click Menu on the Tracking Dialog Bar 

Select Measurement Point 

Measurement point selection mode. Select a graph point to jump to that frame. 

 

Zoom 

Zoom mode. Zooms the designated range by dragging. 

 

Cancel Zoom 

Cancels the zoom and shows the data for the entire range. 

 

Interpolation 

Shows the interpolation dialog. (p. エラー! ブックマークが定義されていません。)  

 

Fix Display Range 

Setting to change the display range or fix the image size for the X‐T or Y‐T or X‐
Y graphs. 

 

Tracking Status Display 

Displays the interpolated frames. Select the status shown under the [Tracking 

Status] tab. 

Function fitting Restart tracking Group tracking 
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4.1.2  Measurement Point List and Tracking Control Toolbar 

The tracking status for measurement points currently zoomed is shown on the 

measurement point list. It is also shown in the message display area during auto 

tracking. 

 

  
Standard     Tracking 

 

⚫ Points 

Shows the names of the measurement points. Points checked in the boxes to the 

right of the point name are subject to tracking or interpolation with the fitting 

function. 

 

⚫ Type 

Displays the type of target marker. Select from quadrant , white dot , black dot 

, and feature point . 

 

⚫ Tracking Method 

Select from auto  or semi-automatic  or manual . Frame by frame is 

automatic in any method. 

 

Auto Automatic tracking of measurement points and verification of location. 

Processing is suspended if detection of measurement points fails. After 

manually verifying the positions, restart auto tracking. 

Semi-automatic Automatic tracking of measurement points and manual 

verification of location. 

Manual Manual tracking of measurement points and verification of location. 

 

Click  or press the space bar in the zoom view to check the measurement point 

location. 

 

⚫ Graphs 

Check points to display on the tracking dialog bar. 

 

Measurement 

point list 

Message display area (only 

during tracking) 
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⚫ Status 

Displays the status of the measurement points in the current frame. The statuses 

are as follows. 

✓ Ready 

Coordinate values for measurement points have been made. This is also the 

status when auto tracking is successful. 

✓ Correlation Value Dropped 

During tracking, the correlation coefficient dropped below the threshold value 

so tracking failed. 

✓ Failed to Detect Center 

Failure to detect the center of the marker. 

✓ Not Set  

Tracking not performed. 

✓ Disappeared 

Tracking failure. 

✓ Awaiting Verification of Point Position 

Auto detection  performed. Awaiting the verification button  to be 

clicked. 

✓ Awaiting Point Position Specification 

Manually correcting the location. Awaiting the verification button   to be 

clicked. 

✓ Awaiting Camera Response (Only for 3D Analysis)  

The measurement point positions are set for other cameras but not for this 

camera. 

Link the cameras  and add the measurement points to this camera.  

 

⚫ Overwrite Tracking of Measurement Points  

Track while overwriting the previous 

tracking results. 

Check the box for auto tracking to correct 

auto tracking in all the tracking ranges. 

Make sure to perform auto tracking on 

tracking points subject to overwrite 

tracking each time that auto tracking is 

performed. Once tracking is finished, 

remove the check for [Overwrite 

Tracking]. 

To fine tune the range for retracking, use [Delete Tracking Results in the Specified 

Range] (p. エラー! ブックマークが定義されていません。) to delete the results of the 

specified range and then conduct auto tracking. 

 

To enable overwriting tracking after adding new measurement points, set [Enable 

Overwrite Tracking when Adding New Measurement Points] (p. エラー! ブックマー

クが定義されていません。) in the エラー! 参照元が見つかりません。 [Tracking] tab.  

 

Overwrite settings 
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4.1.3  Zoom View 

Fine tune and set the measurement point location with the zoom view. 

 

  Zoom in and zoom out. 

Magnifications of “100%”, “200%”, 

“400%”, “800%”, “1600%”. 

 Automatic detection of 

measurement points. 

 Verification of measurement point 

location. 

 (use the space bar)  

 Back. 

 Display the [Measurement Point 

Properties] dialog (Refer to p. エラー! ブックマークが定義されていま

せん。)  

 

 

⚫ Set the Zoom Method 

Select [Set the Zoom Method] on the right click menu, and then select “Nearest 

Neighbor”, “Bilinear” or “Bicubic” to set the zoom method in the zoom view. 

 

 
Set the Zoom Method 
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4.1.4  Tracking Control Bar 

Shows at the top of the zoom view when in the tracking mode. 

Tracks and implements the stop and tracking settings. 

 

 
 

 Tracks the current frame and then switches to 

the next frame. 

 Tracks the current frame and then moves to the 

previous frame. 

 Starts auto tracking in the forward direction. 

 Starts auto tracking in the reverse direction. 

 Stops auto tracking. 

 Performs interpolation for the fit function. 

(Refer to p. エラー! ブックマークが定義されていません。)  

 Shows the tracking properties. (Refer to p. エラー! ブックマークが定義されて

いません。) 

 

Tracking Control Bar 

(only while tracking) 
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4.2  Measurement Points 

4.2.1  Target Markers 

The four types of target markers that MOVIAS Neo uses for auto tracking include 

quadrant markers, white dot markers, black dot markers and feature point markers.   

Fixed points can also be set. 

 

⚫ Quadrant Markers 

Quadrant markers are circular or square target markers that 

are divided into four sections, as shown in the examples to the 

right. 

MOVIAS Neo first searches for markers or their locations in 

correlating images. Next, it uses the feature where the marker 

is divided into four sections to detect the center of the marker 

in sub-pixel units. 

 

When conducting quadrant tracking, the quadrant angles are 

calculated while tracking. Refer to エラー! 参照元が見つかりま

せん。エラー! 参照元が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。) for the method to verify the 

angles calculated. 

Also, use the calculated angles with the drawing function to 

apply to any analysis that includes rotation. For details, refer 

to エラー! 参照元が見つかりません。エラー! 参照元が見つかり

ません。 (p. エラー! ブックマークが定義されていません。). 

 

⚫ White Dot Markers, Black Dot Markers 

 White dot markers have a white dot in the middle of a black 

background while black dot markers have a black dot in the 

middle of a gray background, as shown to the right. MOVIAS 

Neo first searches for markers or their locations in correlating 

images. Next, the center of gravity for the object containing 

the point with the greatest correlation is determined in sub-

pixel units. Select either the area center of gravity method or 

the weighted brightness area center of gravity method to 

detect the center of gravity. 

 

⚫ Feature Point Markers 

Unlike the quadrant markers or the white dot or black dot markers, these markers have 

no defined shape. MOVIAS Neo searches for correlating images and tracks the area with 

the greatest correlation (the area that best resembles the image). 

 

⚫ Fixed Points 

Unlike the above-mentioned measurement points, these points are not tracked. They are 

measurement points with the same coordinates for all the frames. 

 

⚫ User Defined Points 
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Measurement points where the coordinates are calculated from the previous 

measurement point. Measurement points already tracked are required to add user 

defined points. 
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4.2.2  Measurement Point Properties Settings 

Sets the properties for the selected measurement points. Performs settings for name 

changes and display and the tracking method. 

Use any of the following operations to set the measurement point properties. 

✓ Click  in the zoom view. 

✓ Click [Measurement Point Properties] on the right click menu in the zoom 

view. 

✓ Click [Tracking] ⇒ [Measurement Point Properties] on the menu. 

 

Depending on the type of measurement point, the following measurement point 

properties dialog will appear. 

 

 
Quadrant, White Dot, Black 

Dot, Feature Point 

 
Fixed Points 

 
User Defined Points 

 

⚫ Name 

Name and ID Number 

Shows the name and ID number of the measurement points. 

 

⚫ Display Settings 

Show Trajectory 

Check to show the trajectory on the image. 

 

Number of Previous Frames and Number of Subsequent Frames 

Sets the length of the trajectory shown on the image.  

 

Show the Name of the Tracking Points 

Check to show the name of the tracking points on the image. 

 

Show the Location of the Tracking Points 

Check to show the location of the tracking points on the image. 
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⚫ Tracking Settings 

Perform Tracking 

Check to perform tracking.  

 

Tracking Mode 

Specifies the tracking method. Select from auto  or semi-automatic  or 

manual . (Refer to p. 4－4) 

 

Type of Tracking Point 

Specifies the type of target marker for the measurement point. 

 

Tracking Point Color 

Selects the color shown for the measurement point tracked. 

 

Show Graph of the Tracking Results 

Check to display the graph of the tracking results on the tracking dialog bar.   

 

Overwrite Tracking Results 

Check to enable エラー! 参照元が見つかりません。 (refer to p. エラー! ブックマー

クが定義されていません。).  

 

Detailed Settings for the Tracking Parameters 

Shows the [Adjust the Tracking Point Parameters] dialog (refer to p. 4－11).  

 

X Coordinates, Y Coordinates (only with Fixed Points)  

Sets the coordinates. 

 

⚫ Apply and Save As Defaults 

Used to save the tracking settings as the initial values for subsequent measurement 

points. The tracking settings are saved in the application, so they are used as the initial 

values even when MOVIAS Neo is restarted. Use [Load Factory Parameters] in 

Environmental Settings to disable the saved values. 

 

Refer to the エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていま

せん。) in エラー! 参照元が見つかりません。 for details. 
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4.2.3   Detailed Settings for Tracking Parameters 

Several parameters must be properly set for auto tracking target markers with MOVIAS 

Neo. 

These parameters are called [tracking parameters]. 

 

Tracking parameter settings are set in the [Adjust the Tracking Point Parameters] dialog. 

Click  in the [Measurement Point Properties] dialog (p. エラー! ブッ

クマークが定義されていません。) to open [Adjust the Tracking Point Parameters].  

 

 

 
Dialog to adjust the tracking point parameters 

 

 

 

 

Image display area 

Coordinates  

Blue border : Search area 

Pink border : Template size 

Blue × : Location currently set 

White ＋ : Location detected with current setting 

Red circle : Center point detected (quadrant only) 

(Not shown when white + not detected) 

Area to adjust the target 

marker parameters 

Area to adjust the 

correlation parameters 
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⚫ Correlation Parameters 

The four correlation parameters include “Template Size”, “Update Template”, “Search 

Area” and “Correlation Coefficient Lower Limit”. 

Template Size 

Templates refer to the original image used as the 

correlation standard. The size of the template is set in 

pixels.  

MOVIAS Neo searches images for the image with the 

highest correlation to this template. The size of the 

template impacts the tracking rate. 

 

Update Template 

Sets the template to refresh at each frame. 

There is no need to change from the default settings 

(update at each frame) for the quadrant marker, white 

dot marker or black dot marker. With feature point 

markers, the center point detection accuracy decreases 

as the template is updated so in principle, try not to 

refresh. However, if the target rotates or is odd 

shaped, the template must be updated so update as 

infrequently as possible. 

 

Search Area 

The search area is the area searched for sections with 

high correlation. In the search area, the template 

image is moved bit by bit to detect sections with high 

correlation. 

The size of the search area is set in %, using the 

template as the standard. 

If the target has a high motion velocity, expand the 

search area. 

If there are other targets of the same time in the 

vicinity of the target, make the search area smaller to 

avoid errors in identification. 

The size of the search area impacts the tracking rate. 

 

Correlation Coefficient Lower Limit 

The correlation coefficient is the level of correlation, 

expressed as an integer from 0 to 100. 

If the correlation coefficient is 100, the two images 

match completely, and the level of correlation 

decreases and the number decreases. 

During auto tracking, if the correlation coefficient 

drops below the lower limit, tracking stops. 
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⚫ Quadrant Marker Parameters 

 

 

Diameter of the Center Point Detection Circle 

This is a parameter stipulating the diameter of the 

circle to detect the center point of the quadrant 

marker. Set as a % of the template size. The center 

point detection circle is shown as a red circle on the 

image. The detection circle must be within the 

marker. 

⚫ White Dot／Black Dot Marker Parameters 

 

 

Binary Threshold 

Set the brightness range for identification as white 

dot/black dot. The binary threshold value settings 

cannot be changed from MOVIAS Neo Ver2.20.   

To track in the same manner as with Ver2.10, use 

“255” or “100%” as the upper limit for white dots and 

adjust the lower limit. For black dots, use “0” as the 

lower limit and adjust the upper limit. 

Update Every Frame (Correlation from the max/min 

brightness)  

Set the threshold value [0-100%] for the brightness 

within the current template. 

Upper threshold ←  (Max brightness within the 

template) 

／(Min brightness within the 

template) 

× Upper limit input [0-100％] 

Lower threshold ←  (Max brightness within the 

template) 

／(Min brightness within the 

template) 

× Lower limit input [0-100％] 

to identify the white dot/black dot from the range. The 

threshold value changes every frame. The image is 

enabled so the brightness gradually changes.  

All Frames Fixed 

Sets the threshold values as a brightness value [0-

255]. 

Upper threshold ← Upper limit input 

Lower threshold ← Lower limit input 

to identify the white dot/black dot from the range. 

COG (Center of Gravity) Calculation Method 

Specify the method of determining the center of 

gravity in the area extracted, using the threshold 

value as the standard. 

The center of gravity is calculated for the detection 

point when using area center of gravity. 

The center of gravity is calculated according to the 

brightness of each point when using the brightness 

center of gravity. 

 

Upper limit input 
Lower limit input 
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⚫ Feature Point Marker Parameters 

Specify Position for Coordinate Detection 

Designates the location of the template for the 

feature points (points clicked). 

For example, enable when tracking sections with 

sharp angles. 

 

 

 

 

 

 

Here is an example of a tracking target in the square 

black area of the figure to the left. 

 

Click on the upper left corner of the tracking target to 

add the feature point. After adding the feature point, 

the template becomes a square centered around the 

feature point and the detection coordinate location 

becomes H:  0, V:  0. 

 

 

 

 

 

To improve the tracking accuracy, move the template 

to the area where the feature is the tracking target. 

 

 

 

 

 

 

 

 

 

 

 

 

Line Edge Tracking 

Designate the tracking direction as well as the 

square search area. 

To specify the direction, check [Use Tracking 

Angles] and specify the angle (0～360°). If the 

angle is specified, a line appears on the image at 

the set angle (preview). After setting, tracking 

occurs in the direction specified. 

 

 

 

Background 

Tracking 

target 

Template area 

Search 

area 

Feature 

point 

Tracking 

target 

Featur

e point 

Line preview 
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4.2.4  Operation of User Defined Points 

User defined points are measurement points that are detected from the coordinates of 

existing measurement points. Add on the image window and perform the detailed 

settings in the [User-defined Points] dialog.   

User defined points can be used in [Superimpose], [Show Graph], [Show List], [2D 

Calibration], [Origin Point, Axis, Reference Points] and [Reference Points for Image 

Alignment] in the same manner as other measurement points. 

⚫ Example of the Operation of User Defined Points  

The basic operation of user defined points is as follows.  

1. Select user defined points  from the measurement point toolbar 

.  

 

2. The user defined point dialog will appear. 

 
 

3. Select the type of user defined points and set the parameters. 

In the following diagram, select [Relative Position] and select [Point 0] and [Point 

1] in [Reference Points].  

 

User defined point dialog 
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4. Click the measurement location to add user defined points.  

After adding, the coordinates of the user defined points are automatically 

calculated, and the trajectory is shown on the tracking graph.  

  
Add user defined points     Tracking graph after adding user defined points 

 

5. After adding, detailed settings can be made in zoom view or in the dialog. 

Refer to [エラー! 参照元が見つかりません。] (p. エラー! ブックマークが定義されてい

ません。) for detailed settings for user defined points. 

 

 

If you close the user defined points or select another type of measurement point, the user 

defined point operation ends, and the settings are locked. To correct the completed user 

defined point settings again, click on the defined point corresponding to the 

measurement point list and the user defined point dialog will reappear. Delete the check 

on [Keep the Current Settings] to perform the operation.     

 

計算された 

座標値 

Adjust the coordinates in zoom view. 
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⚫ Types of User Defined Points 

Three types of user defined points can be used. Use according to the location 

relationship of the target measurement. 

Fixed 

User defined points that have the same coordinates for all frames. Measurement points 

that are identical to fixed points. 

 

Relative Location 

User defined points with coordinates that retain their shape from two designated 

measurement points. The geometrically relative location is calculated for the point 

clicked on the image to the two reference points to make the user defined points. This 

can be used, for example, when measurement points are hidden during tracking or 

when performing measurements in locations where the markers are difficult to find.  

 

2 Point (Ratio)  

User defined points with coordinates of a specific ratio on lines connecting two 

designated points. Use this for measurement targets that you know exist on a line.   

For example, if you wish to set measurement points at the center of a disk and you 

cannot set the measurement points due to the axis, set markers at two symmetrical 

locations surrounding this axis and if you set the ratio [50%] for this user defined point, 

the center of the two markers, specifically, the center of the axis, can be calculated.    

 

⚫ Detailed Settings for User Defined Points 

 
User Defined Point Dialog 

User Defined Points 

  Select・set the type of user defined points.  

 

Fixed 

The same as for fixed points. 

Relative Location 

Calculates the relative location from 

two measurement points. 

2 Points (Ratio)  

Calculates the ratio of the distance 

between two measurement points. In 

the figure to the left, if the ratio is 0, it 

is Point0 and if the ratio is 100, it is 

Point1.  

 

Calculates the Coordinate Location for Each 

Frame 

Calculates the coordinates for user 

defined points for each frame.  

Applying the Coordinate Location for the 

Current Frame 

  The coordinates for the user defined points 

for the time shown are applied to all 

times. 

Keep the Current Settings 

  Locks the set parameters so they cannot be 

changed. Automatically locks when the 

dialog is closed. 
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4.2.5  Hints for Tracking Parameter Settings 

⚫ Quadrant Markers 

The size of the red circle shown with quadrant markers (called 

the “center point detection circle”) depends on the image quality 

so set the quadrant markers at about the level of that in the 

figure at right. 

The larger the circle, the better the accuracy but if the marker 

disappears, auto tracking is not possible. Also, the accuracy 

may suffer if the shape changes. 

The smaller the circle, the worse the accuracy but if the marker 

disappears or changes shape, auto tracking can still be done. 

 

 

 

⚫ White Dot or Black Dot Markers 

Set the size of the template relative to the white dot/black dot 

at about the level of that in the figure at right. 

The template must be large enough, so the white dot or black 

dot does not meet the outside edge of the template. 

Adjust the binary threshold value and extract the white dot or 

black dot from the background. 

 

When tracking white dots, the white dots may be included in 

bright areas due to reflections from shiny surfaces and may 

result in white dot tracking failure. 

In this case, adjust the upper limit of the threshold value for white dots so the white dots 

are not impacted by the bright areas and the desired white dots can be tracked. 

 

The center of gravity calculation methods for white dot or black dot includes the “area 

center of gravity” and the “brightness center of gravity”. 

Generally, if the shades of the tracking target are clearly defined, use “area center of 

gravity”. 

If the brightness values along the edges of the tracking target do not clearly change, you 

may be able to enable “brightness center of gravity”. 

A trick when using “brightness center of gravity” is to make the range for the threshold 

value broader than with “area center of gravity”. If the range of the threshold value is 

broader, it is easier to calculate areas where the brightness changes. 
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⚫ Feature Point Markers 

Adjust the template size containing the feature points in the template. 

With targets that rotate significantly or change shape, the template must be updated. 

However, since the tracking accuracy drops when the template is updated, adjust the 

parameters to update as infrequently as possible. With a slight rotation or change in 

shape, the correlation coefficient drops but not having to update the template has a 

positive effect. 

If tracking small objects moving on a background, set so most of the background is not 

in the template 

Use the detection coordinate designations to track sections with sharp angles. 

Also, if tracking as shown in the figure below, the positions of the measurement points 

shift during normal tracking. If this occurs, use line edge tracking (p. エラー! ブックマ

ークが定義されていません。) to track in a particular direction. 

  
 

⚫ User Defined Points 

Use user defined points to calculate points that are difficult to track automatically or 

points with markers that cannot be inserted.  

Examples of situations where auto detection is difficult or where markers are obscure 

include when the markers are hidden while tracking or when measuring a point in the 

center of a disk to track locations that are floating in space.    

The user defined calculations use geometric shapes so make sure to have reference points 

for the user defined points in locations with crisply defined shapes. User defined points 

cannot be used with soft objects such as cloth.   

Location shift 
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(a) Example of the Operation with User Defined Points 1 Marker is Hidden  

Here is an example of user defined points where a marker is hidden. 

The head of a dummy is measured in the image below. However, in one frame, since the 

head is hidden, measurements using markers are not possible. Thus, user defined points 

are used to calculate the coordinates. 

  
 

First, add tracking points as reference points for the user defined points and then track. 

 
 

After tracking is complete, add the user defined points. Select [Relative Location] in the 

user defined points dialog and set the points tracked before the reference points as 

[Point0] and [Point1].  

 

Measure the head of the dummy 
The head of the dummy is hidden 

Add tracking points as 

reference points for the user 

defined points 
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Once the user defined points are added, the relative locations for all frames are 

calculated from the added location. 

 
 

Even in frames where measurements cannot be made because the tracking target is 

hidden, the coordinates of the relative location can be calculated, as shown below.  

 
 

The relative location is 

calculated and displayed 

on the tracking graph. 
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(b) Example of the Operation with User Defined Points 2 Measure Using 
Time Values Generated by an Event   

This is an example of the operation performing measurements and analysis using time 

values generated by an event. 

 

User defined points have a function called [Apply the coordinates for the current frame 

to the entire range]. Use this to compare the coordinates from an event generated with 

other time coordinates. 

 

Consider using the time coordinates generated by an event when you want to make 

calculations for each type of physical quantities.   

 (The following figure is a continuation of the first operating example for user defined 

points when a marker is hidden.)  

 
 

The image for the time generated for an event is shown. Here, the event is when the 

dummy is thrown forward during impact.   
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With the time image for the generated event still displayed, select [Apply the Coordinate 

Location for the Current Frame] from the user defined point dialog.   

 
 

Check [Keep the Current Settings]. If you move the frame before checking [Keep the 

Current Settings], be careful of the set frame shifting. 
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You can verify if the coordinates for the frame generated by the event are applied to all 

the frames. 
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4.3  Tracking 

4.3.1  Add Measurement Points 

Add measurement points to the measurement image to conduct tracking. 

The procedure for adding measurement points is as follows. 

 ① Access the measurement image window and switch to the tracking mode. 

 ② Select the target markers used for the measurement points with the 

[Measurement Point Toolbar]. 

 ③ Click on the measurement points on the image.  

 At this point, auto detection is performed for quadrant and white dots/black 

dots. 

 ④ After adding, fine tune the coordinates with zoom view. 

 ⑤ After completing the fine tuning, click [Confirm] to finish the preparations 

for the measurement points. 

 

Repeat ①～⑤ for the number of measurement points. 

For 3D tracking, in addition to the procedures given above, you must also link the 

cameras. For details, refer to エラー! 参照元が見つかりません。エラー! 参照元が見つか

りません。 (p. エラー! ブックマークが定義されていません。). 
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4.3.2  Delete Measurement Points 

Deletes the measurement points selected from the measurement point list. If 

measurement points are deleted, the measurement results are also deleted. 

Perform any of the following to delete measurement points. 

 

✓ Click [Tracking] ⇒ [Delete Measurement Points] on the menu. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [Delete Measurement Points] on the right click menu in the エラー! 参照

元が見つかりません。 

 

Point0, Point1, Point3 are deleted in the following figures. 

 

 

4.3.3  Automatic Tracking 

After adding measurement points, conduct tracking. 

Use      on the エラー! 参照元が見つかりません。 

 

 :  Track only the frame currently displayed, then move to the next frame. 

 :  Starts auto tracking. 

:  Stops auto tracking. 

 

Tracking methods include auto・semi-automatic・manual, and any of them can be set 

for each measurement point. 

The tracking range is processed in the same range as the playback range. 

 

Corrections can be made manually when auto tracking fails. (Refer to p. エラー! ブック

マークが定義されていません。). 

Also, operations during tracking failure include Group Tracking (Refer to p. 4－33) and 

エラー! 参照元が見つかりません。 (Refer to p. エラー! ブックマークが定義されていませ

ん。). 

Targets for removal 
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4.3.4  Tracking Properties 

Sets the tracking failure settings, skip frames and tracking methods. Perform any of the 

following to display the tracking properties dialog. 

 

✓ Click [Tracking] ⇒ [Tracking Properties] on the menu.  

✓ Click  on the エラー! 参照元が見つかりません。. 

 

⚫ Tab for [Setting the Number of Frames] 

Reference Frames 

Set the number of frames expected for 

tracking. The default is 5. 

 

 

Skip Frames 

Set the number of frames to jump during 

tracking. For example, with a playback 

range of [0: 20], a start of 2, and 4 skip 

frames, tracking is performed on frames 

2, 7, 12, 17.  

  The default for the number of skip frames 

is 0, with tracking on all frames. 

 

⚫ 『トラッキング』タブ 

Tracking in the Reverse Direction 

Setting to automatically start tracking 

in the opposite direction after tracking 

in the direction specified. 

 

Process when Tracking Fails 

Setting for processing when tracking 

fails. 

  If [Continue Tracking] isn’t checked, a 

warning appears in the message display 

area of the measurement point list when 

tracking fails and tracking stops. If 

checked, select from [Do Nothing], 

[Group Tracking] or [Track Hidden 

Points] to continue processing when 

tracking fails. 

With “Do Nothing”, tracking is not 

performed after the frame where the 

tracking failure occurred. Tracking 

continues for all other tracking points. 

 

Refer to [Group Tracking] (p. 4－33) and エラー! 参照元が見つかりません。] (p. エラー! 

ブックマークが定義されていません。) for more details. 

Refer to エラー! 参照元が見つかりません。] (p. エラー! ブックマークが定義されていませ

ん。) for operations that stopped due to tracking failures. 
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⚫ [Default Parameter Settings] Tab 

 

Default Settings for Template Parameters 

Setting for auto detection of template parameters when adding tracking points. If 

enabled, the template parameters are automatically adjusted after adding tracking 

points. If disabled, the standard template parameters will be used. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.5  Correcting Tracking Failures 

Uncheck [Continue Tracking] when tracking fails under the 

tracking properties since manual correction will be required when 

tracking fails. The cause is shown in the message display area of 

the measurement point list, so make any corrections based on that. 

If tracking points overlap, it is considered a tracking failure of 

[Duplicate Tracking Points]. In the example to the right, Point 4 is 

a duplicate. 

 

The actions to perform corrections are shown below. 

 

Action Details 

Fine tune and set the measurement points 

in the zoom view 

Tracking restarts after the 

measurement point locations are set. 

Correct the properties for the measurement 

points 

After setting the tracking parameters, 

auto detection and setting is 

performed. If the detection is 

successful, tracking restarts. 

Uncheck the point name from the 

measurement point list 

 

 
 

After that, tracking is not preformed 

on points that are not checked. 

Tracking is automatically restarted on 

the points that are checked. 

End tracking mode Ends tracking and switches to another 

mode. 

Click Stop   Ends the auto tracking state. 
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4.3.6  Correcting and Interpolating Tracking Results 

⚫ Reposition Measurement Points 

Perform any of the following to reposition measurement points. 

✓ Click [Tracking]⇒ [Reposition Measurement Points] on the menu. 

✓ Click  on the the エラー! 参照元が見つかりません。 on the エラー! 参照元が

見つかりません。. 

 

Move to the point selected from the measurement point list. 

When repositioning, the location of the measurement points in untracked frames is 

established. For tracked frames, you can adjust the position in the measurement image 

window or in zoom view. 

 

⚫ Interpolating for Fitting 

Interpolation can be conducted on a batch for fitting with untracked frames or frames 

where tracking fails. Functions to use are as follows. 

 

 “Linear” ・ “Least Squares” ・ Cubic” ・ Spline”  

 

A series of targets are measurement points that are checked on the エラー! 参照元が見

つかりません。. 

 

Perform any of the following to show the interpolation dialog and conduct interpolation. 

 

✓ Click [Tracking] ⇒ [Interpolate Hidden Points] on the menu. 

✓ エラー! 参照元が見つかりません。Click  on the エラー! 参照元が見つかりま

せん。. 

✓ Click [Interpolate] on the right click menu on the tracking dialog bar.  

 

Interpolation Method 

Select the function to be used for interpolation. 

Select from linear・least squares・cubic・spline. 

 

Number of Previous Control Points・Number of 

Future Control Points 

Set the number of control points used for the 

interpolation method. 

 

OK 

Conducts interpolation with the current settings and 

closes the dialog. 

 

Reset 

Restores the interpolation status from when the 

dialog was launched. 

 

Apply 

Conducts interpolation with the current settings. 
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⚫ Delete Tracking Results 

Delete the tracking results for specified measurement points in a designated range. 

The tracking results for the points selected on the measurement point list are subject to 

removal. 

 

Perform any of the following to delete tracking results. 

✓ Click [Tracking] ⇒ [Delete the Tracking Results from the Specified Range] on 

the menu. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [Delete the Tracking Results from the Specified Range] on the right click 

menu on the measurement point list. 

The dialog is displayed for selecting the range to be deleted. 

 

 

 

Delete from the Selected Range 

Deletes the measurement results from the 

playback range. 

 

Delete All Frames 

  Deletes the measurement results from all 

frames. 

Measurement points remain even when all 

frames are deleted. 

 

Delete only the Current Frame 

Deletes only the current frame. 

 

Delete from Start Frame to the Current 

Frame 

Deletes the measurement results from the 

start of the playback range to the current 

frame shown. 

 

Delete from the Current Frame to the End 

Frame 

Deletes the measurement results from the 

current frame to the end of the playback 

range. 

 

Delete Range of Frames Specified 

Deletes the measurement results for the 

input range. 
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4.3.7  Tracking for 3D Analysis 

Tracking is identical to tracking for 2D analysis. However, since cameras must be linked 

for 3D analysis, processing for 2D analysis and 3D analysis differs in the following ways. 

 

✓ Tracking is required for each camera 

✓ Group tracking and tracking of specified areas is not available 

✓ Link  cameras by setting the linked measurement points between cameras 

 

For 3D analysis of measurement points, the same measurement points must be filmed 

by two or more cameras at the same time. 

 

The process for tracking during 3D analysis is in ①～⑤ below. 

 

 
 Add measurement points for the first camera. 

Tracking can be performed immediately or after 

tracking from other cameras.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Display the measurement image for the 

second camera and switch to the tracking 

mode.  

Click  to start linking cameras. 

 

If adding measurement points for the second 

camera, they are added as new measurement 

points. 

 

 

 

 

 

カメラ間 Link cameras 
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 Select the corresponding measurement points 

from the measurement point list. The selected 

points are shown in the center of the image.  

They are only displayed and their positions are 

not set. 

 

 

 

 

 

 

 

 

 

 Click the corresponding location on the 

measurement image window for auto detection 

of the corresponding point.  

If auto detection fails, correct the location with 

the zoom view. After correcting, click  in the 

zoom view to set the location.  

 

The types of markers are the same as the types 

set for other cameras. A different type can be set 

for each camera. 

 

 

 

 

 

 If linking is necessary, track using the same 

procedure for 2D analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Measurement points tracked with two or more cameras use the tracking results for all 

of the cameras to construct 3D data. Measurement points tracked with a single camera 

cannot be used to build 3D data. 

選択した計測点 

が表示される 計測点の選択 

対応点クリック 

確定 
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4.3.8  Group Tracking 

This is a method of tracking that performs interpolation using the geometric relationship 

with other points when tracking fails. The geometric relationship between the previous 

tracking results and the tracked point in the current frame is used to interpolate the 

frames where tracking failed. To enable group tracking, the tracking points must be set 

to [Auto] tracking. Refer to [Tracking Methods](p. 4-4)for the setting method Groups can 

be created with 3, 4 or 5 points for group tracking. 

Group of 3 points Interpolation taking into consideration the relationship 

with parallel transport, rotation and scaling 

Group of 4 or 5 points Interpolation taking into consideration the relationship 

with parallel transport, rotation, scaling and shearing 

deformation 

 

When conducting group tracking, the angle of the group shape is calculated at the same 

time as tracking. The angle calculated can be checked in the graph・list. By using this 

calculated angle together with the drawing function, it can be applied to analysis that 

includes rotation.  

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for the method of checking the angle and refer to 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。) for 

applications to analysis that includes rotation. 

 

The group angle is automatically calculated immediately after the group is created・

when the measurement data is built. 

 

To use group tracking, enable [Continue Tracking] in the [Tracking] tab of the tracking 

properties and select [Group Tracking]. Click on the group tracking settings and set the 

group when the [Measurement Point Group Setting] dialog appears. 

 
 

 
Tracking Measurement Point Group Settings dialog 

 

 

Measurement point list 

Group list 

Member list 

Start the measurement 

point group settings dialog 

for tracking 

Enable group 

tracking 
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Measurement Point List:  List of measurement points that can be registered 

Member List:  List of groups being created 

Group List:  List of groups already created. The names are automatically 

assigned. 

Select “New Group” when adding a group, add the measurement 

points to the member list and click [Register]. 

 

  :  Add or remove from the member list.  

 :  Delete from the group list. 

 :  Register to the group list. 

 

Groups registered to the group list can be used for group tracking. While the same point 

can be assigned to multiple groups, the exact same group combination cannot be created. 

 

⚫ Create a Group 

Creates a new group. The same combination cannot be created. One group is created 

from 3~5 points.  

Create groups using either of the following procedures. 

 

 

Procedure 1 

1) Select 3~5 measurement points from the measurement point list to create a 

group. 

2) Click  to add. 

3) Temporarily register to the member list. 

4) Click   to register. 

 

Procedure 2 

  The member list must be empty. 

1) Select 3~5 measurement points from the measurement point list to create a group. 

2) Click  to register. 

 

⚫ Delete a Group 

Deletes a group. The group cannot be used for subsequent tracking. Perform the 

following to delete a group. 

1) Select a group from the group list. 

2) Click   to delete. 
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4.3.9  Tracking Hidden Points 

This is a tracking method that attempts tracking with only a certain number of frames 

after a tracking failure. If tracking in the designated frames is successful, normal 

tracking can be restarted. Frames where tracking has failed are interpolated with 

quadratic least square regression. 

 

To perform hidden point tracking, enable [Continue Tracking] in the [Tracking] tab of 

the tracking properties and select [Tracking Hidden Points] to designate the number of 

frames 

The number of frames that can be designated is 1~99. 

 

For example, if tracking a range of [0: 20] using hidden point tracking, set the number 

of frames to 5. If tracking is successful up to frame 8 but tracking fails at frame 9, 

tracking will attempt to restart at frames:  10, 11, 12, 13, 14. 

If measurement points are in the frames where tracking was attempted, tracking is 

performed on the next measurement points. If measurement points are not located 

within the designated frames, tracking of measurement points in subsequent frames is 

not performed. 

 

 
 

4.4  Checking Tracking Data 

You can check the image coordinates for the tracked target markers, or the data 

generated for the angles when tracking quadrant markers/groups. 

Check the measurement data to verify the calibrated data. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for measurement data. 

 

To check tracking data, click on any of the following items from the right click menu on 

the measurement image node. 

 

Show Graph of Coordinate Data Show the graph (XY coordinates/time) for the 

tracked coordinate 

Show Locus Chart for the Coordinate Data  Show the locus chart (X-Y graph) 

for the tracked coordinates. 

Show List of Coordinate Data Show the list of the tracked coordinates and angles.  

 

Specify the number 

of frames 

(1~99) 

Enable hidden 

point tracking 
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Tracking Graph  Tracking Locus Chart    Tracking List 

 

To switch each coordinate and angle between show and hide, click [Properties] in the 

right click menu of the graph.  

 
 

Choose the [Select Display Data] tab for the coordinates or choose the [Select Angle Data] 

tab for the angles. Check the items you wish to display and then click OK.     

Switch between show, 

hide on the graph, list 
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4.5  Other Tracking Settings 

4.5.1  Image Pre-Processing 

Adjusts the image used for tracking. Can be set only in the display mode. 

Set the image resize, rotation, reverse, deinterlace, image quality adjustment and color 

components used for tracking (brightness value, red, green, blue). 

 

These settings are reflected on the image displayed during the tracking mode and image 

resize, rotation, reverse, deinterlace are even reflected on the image displayed during 

the display or synchronized display modes. 

 

Processing for tracking results such as image resizing should be performed 

before tracking. 

After pressing [OK] in the image pre-processing dialog, the tracking results are 

deleted. They are not deleted if [Cancel] is pressed. After making the tracking 

settings, track using the image set. 

 

 

Click [Playback] -> [Image Pre-Processing] on the menu. 

 

The following warning appears before the [Image Pre-Processing] dialog is displayed. 

 
 

Click [Yes] and the image pre-processing dialog will appear. 
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Image Pre-Processing Dialog 

 

Deinterlace 

Performs settings for deinterlacing when selecting “Resize to 1920x1080” or 

“640x480” with image resize 

Select from “Odd”, “Even”, “Duplicate”, “60fps”, “60fps (reverse field)”. 

 

Resize Image 

Resizes the image according to the selected format. 

Make sure to set when measuring using real scale conversion used in DV format 

images or image files filmed with HDV cameras or AVCHD cameras. Otherwise, the 

aspect ratio for the image will be incorrect. 

 

✓ 1: 1 display 

No image resize performed. 

✓ Resize to 1920x1080 

Resizes a 1440x1080 image to 1920x1080. Images filmed with HDV and 

AVCHD cameras must be converted to the AVI format using special 

conversion software. 

✓ Resize to 640x480 

Resize to 720x480 image for DV format. 

 

 

 

 

 

 

 

 

An image size of 1440x1080 can 

be resized to 1920x1080.  

An image size of 720x480 can be 

resized to 640x480.  

Other sized images cannot be 

resized. 
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Reverse Image 

Reverses the image. Select from [No], [Horizontal] and [Vertical].   

 

Image Rotation Angle (Clockwise)  

Rotates the image clockwise. Select from [0], [90], [180] and [270]. 

 

Gamma Correction 

Select from OFF, LOW, NORMAL. 

Default:  OFF For normal image files 

NORMAL For MCFF 

 

Contrast Adjustment 

Set in a range of 0～300. (Default:  100)  

 

Brightness Adjustment 

Set in a range of －200～200. (Default:  0)  

 

Color Plane Used 

Select a color from gray, red, green, or blue to be used for tracking. The default is 

gray. 

 

Histogram 

Show a histogram for the images selected. 

 

Default 

Reset the settings. 
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4.5.2  Specify Tracking Area 

Sets the tracking area. You can only set for 2D analysis projects. 

If the tracking area is set, measurement points detected outside the area during auto 

tracking are treated as tracking failures. 

Set in the designate tracking area mode. Perform either of the following to access the 

specify tracking area mode. 

✓ Click area settings  on the エラー! 参照元が見つかりません。 on the エラー! 

参照元が見つかりません。 

✓ Click [Tracking] -> [Specify Tracking Area] on the menu. 

 

In the specify tracking area mode, drag on the image to add the tracking area. 

Multiple areas can be added. After creating an area, you can move or resize it. 

 

  
 

You can delete the currently selected tracking area or delete the entire area using the 

right click menu. 

 
 

In modes other than the specify tracking area mode, the tracking area can be switched 

from show to hide with [Show Tracking Range] on the right click menu of the image 

window. 

Tracking area 



MOVIAS Neo V3 User’s Guide  nac Image Technology Inc. 

(00355)L 4－44 
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4.5.3  Batch Settings for Measurement Point Properties 

The properties for all the measurement points in a project can be set together or 

individually. 

Click [Properties] on the right click menu of the measurement image node to set the 

measurement point properties as a batch. 

 

  
 

The [Measurement Point Display Settings] dialog appears. 

 

[Measurement Point Display Settings] dialog 

 

 

The following measurement point parameters can be set individually or as a batch using 

this dialog. 

Set each item by double clicking each of the cells on the list. 

To set as a batch, check the box to the left of the measurement points and set the 

parameters together. Click on the checkmarks for the batch settings to switch the 

checkmarks to the left of all the measurement points. 

 

Name Set the name of the measurement point. 

Show Location Switch the measurement point location to show/hide. 

Show Name Switch the measurement point name to show/hide. 

Color Set the measurement point color (select color or set custom color). 

Trajectory Switch the trajectory on the measurement image to show/hide. 

Future Trajectory Set the number of frames ahead to display the trajectory. 

Past Trajectory Set the number of frames behind to display the trajectory. 

Zoom Ratio Set the zoom view rate (100%,200%,400%,800%,1600%). 

Batch settings 

Total number of measurement points 

Sort button 
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Graph (X)  Switch the X coordinates on the coordinates graph for the tracking 

results to show/hide. 

Graph (Y) Switch the Y coordinates on the coordinates graph for the tracking 

results to show/hide. 

List (X) Switch the X coordinates on the coordinates list for the tracking 

results to show/hide. 

List (Y) Switch the Y coordinates on the coordinates list for the tracking results 

to show/hide. 

The coordinates graph and coordinates list for tracking results can be 

displayed from the right click menu of the [Measurement Image] node. 

You can also move with multiple states selected. The same operations 

can be made from [Top] or [Bottom] on the right click menu on the list. 

4.5.4  Sort Measurement Point List 

The measurement point list can be sorted by keyword or by clicking on the header of the 

list.  Or sort the measurement point list from the [Measurement Point Display Settings] 

dialog (p. エラー! ブックマークが定義されていません。). 

⚫ Sort by Keyword 

To sort by keyword, click [Sort by Name] on the right click menu in the measurement 

point list. 

The [Sorting Measurement Points] dialog appears. 

 
 [Sorting Measurement Points] dialog 

Input the keyword containing the measurement points to sort and select to go to the top 

or bottom. Press [Apply] to move to the location designated for the measurement points 

containing the keyword. 

 
 

[Sort by Name] can be performed with a right click in the same manner as when sorted 

from the [Measurement Point Display Settings] dialog. Click [Sort] on the right side to 

move the selected measurement points [Up] (Down) to the top (bottom).  

 

Input the keyword 

Select to jump to either 

the top or the bottom of 

measurement points 

containing the input 

keyword 

Sort 

Sort results from the “top” of 

measurement points containing 

the keyword “point”. 
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⚫ Sort by Clicking the Header 

Click the header to sort according to the following rules. 

 

 
 

 

 

 

 

 

 

 

 

Click the header of the [Measurement Point Display] dialog and sort according to the 

following rules. 

Header Sorting Method Header Sorting Method 

Name Alphabetical Zoom Rate 100%⇔200%⇔400%⇔800%⇔

1600% 

Display 

Location 

Show ⇔ Hide Graph (X) Show ⇔ Hide 

Display 

Name 

Show ⇔ Hide Graph (Y) Show ⇔ Hide 

Color RGB value List (X) Show ⇔ Hide 

Trajectory Show ⇔ Hide List (Y) Show ⇔ Hide 

Forward／

Reverse 

Trajectory 

Numerical order   

 

 

Header Sorting Method 

Point Alphabetical 

Type Quadrant ⇔ White dot ⇔ Black dot ⇔ Feature point ⇔ 

Fixed point ⇔ User defined point 

Tracking 

Method 

Auto ⇔ Semi-automatic ⇔ Manual 

Graph Show ⇔ Hide  

Status Status number 

Overwrite 

Tracking 

Overwrite tracking ⇔ Do not overwrite  

Sort 

Right click menu 

Header 
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5. Calibration 
Calibration must be performed to convert from the image coordinate system to the real 

space coordinate system. MOVIAS Neo performs calibration for 2D analysis (real scale 

conversion・changing perspectives) as well as calibration and lens distortion correction 

for 3D analysis. For 2D analysis, measurement data can be created even without 

calibration. In this case, data is created with 1 mm /pixel and a Z coordinate value of “0”. 

 

5.1  Using Calibration 

Sections エラー! 参照元が見つかりません。～ エラー! 参照元が見つかりません。describe 

how to use calibration. Basic standards for use are provided. 

 

Motion of measurement target? 

1．Plane (or linear)  

Film the plane from the front 

 ⇒ エラー! 参照元が見つかりません。 

 Corrects optical distortion if the image has confirmed optical 

distortion. 

From the diagonal 

 ⇒ エラー! 参照元が見つかりません。 (Consider 3D analysis if the 

angle is greater than 45°)  

 Corrects optical distortion if the image has confirmed optical 

distortion. 

Moving plane 

 ⇒ Use 3D calibration 

2．3D Movement 

⇒ Use 3D calibration 

 

Use 3D calibration 

To confirm slight optical distortion  

 ⇒ MDLT 

Unable to confirm distortion 

 ⇒ 3D‐DLT 

Visible optical distortion 

 ⇒ エラー! 参照元が見つかりません。＋MDLT 

 

Is there optical distortion? 

Visible optical distortion (barrel, pincushion) 

 ⇒ Perform エラー! 参照元が見つかりません。 
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5.2  Real Scale Conversion 

Performs depth correction on the tracking results for a 2D analysis project. With real 

scale conversion, an object moves on the same vertical plane as the camera and the 

analysis is conducted on that plane. 

DV-AVI and AVCHD video files may not have a pixel aspect ratio of 1: 1. In 

this case, use the image resize function from エラー! 参照元が見つかりません。

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていま

せん。) to convert to a square pixel image and then perform measurements・

analysis. 

 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) in エラー! 参照元が見つかりません。 for an explanation of the calculations for real 

scale conversion. 

 

Open the measurement image window and perform either of the following for real scale 

conversion. 

✓ Click [2D Construction] ⇒ [Calibration Settings] ⇒ [Real Scale Conversion] on 

the menu.  

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

The [Real Scale Conversion Dialog] appears and then it switches to the real scale 

conversion mode. Real scale conversion settings can be made in this mode. If you own a 

license for the エラー! 参照元が見つかりません。, you can make the settings for the same 

functions on the real scale conversion dialog. Apply real scale conversion and [Real Scale 

Conversion] will show up on the [Calibration Mode Node].  

 
Overview of Real Scale Conversion Mode 

 

 

エラー! 参照元が見つかりません。 (Real Scale Conversion Mode)  

 

Real scale conversion dialog 

Apply real scale conversion and [Real Scale Conversion] will appear 

Mode Display Bar Zoom Control Bar Specify Measurement Point Toolbar 
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Operation is made with both the measurement image window and the real scale 

conversion dialog. 

 

The procedure for real scale conversion is as follows. 

① Create a reference plane. 

② Set the origin and axis if necessary. 

③ Create the correction plane (depth plane・scale plane). 

④ Record each of the measurement points to the plane. 

⑤ Click Finish. 

After closing the dialog, the depth correction parameters are automatically applied. 

 
When other windows (graphs and such) are in the active window, or when the close 

button on the upper right is clicked, the calibration parameters are eliminated and the 

real scale conversion mode is ended. 

Click  to save the current settings to the settings file (*.2cs). 

Click  to load the previously saved settings file (*.2cs). 

 

Quadrant , white dot , black dot , and fixed point  can be used for the control 

point settings. Also, use select measurement points  to select the tracked 

measurement points and coordinates can be set for the control points that are the same 

as those for the measurement points.   

 

Line input【 】can also be used. It is a method to input fixed points with a single 

operation. Click the starting point on the image. Drag the mouse to the location of the 

ending point. In the real scale conversion mode, use the reference line input under the 

エラー! 参照元が見つかりません。, the X axis input under the エラー! 参照元が見つかり

ません。 or the line length input under the エラー! 参照元が見つかりません。. In the 

change perspective mode, use the X axis input under the エラー! 参照元が見つかりませ

ん。. 

 

In the real scale conversion mode, [Reference Line], [Origin] 

and [Grid] are displayed on the image window. The grid is 

shown without taking optical distortion into consideration. If 

making settings for optical distortion correction, the grid 

displayed will be out of place from the real space grid. Instead 

of using for exact positioning, use as a target for the axis 

direction. 

Switch the display ON/OFF using the right click menu. 

Set the values to finish calibration. Calibration 

calculations done automatically. 

Data settings are loaded from the file (*.2cs). 

Current settings are saved to the file (*.2cs). 

Restore settings. 
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5.2.1  [Reference Plane] Tab 

The reference length is set using the [Reference Plane] tab. Input the image coordinates 

and the actual line length for auto calculation, or you can manually input the real scale 

conversion coefficients. 

If using the real scale conversion coefficients calculated with a different analysis project, 

or if using the real scale conversion coefficients obtained from different analysis software, 

manually input the real scale conversion coefficients. In all other cases, use the image 

coordinates and the actual line length for auto calculation. 

Use together with the measurement image window. 

Set the reference length with either of the following processes. 

✓ Specify the image coordinates and actual line length to auto calculate.  

① Remove the check on [Manually Input Conversion Coefficients] to automatically 

calculate them. 

② Select either [Fix] or [Specify Measurement Points] as the reference line input 

method.  

(ア) With [Fix], input the starting point and the ending point of a line with a 

specific length in the measurement image window. 

(イ) With [Specify Measurement Points], specify two measurement points and 

select either [Calculate Conversion Coefficients for Each Frame] or 

[Calculate Conversion Coefficients for Specific Frames] as the method of 

calculating coefficients.  

③ Use the dialog to input the length of the real space in [Actual Length of 

Reference Line].  

④ Select the units for conversion. 

✓ Manually input the real scale conversion coefficients 

① Check [Manually Input Conversion Coefficients] so they can be input. 

② Manually input the reach scale conversion coefficients in [Conversion 

Coefficients].  

③ Select the units for conversion. 

Fix 

Displays the coordinates for the starting point 

and the ending point clicked in the 

measurement image window. 

Specify Measurement Points 

Calculate Conversion Coefficients for Each 

Frame 

Calculates the conversion coefficients for each 

frame from the designated measurement 

points. 

Calculate Conversion Coefficients for Specific 

Frames 

Converts all of the frames with conversion 

coefficients for designated measurement 

points and times. Press [Current Frame] to 

set the time of the frame currently displayed. 

Actual Length of Reference Line 

Input the length of the real scale for the line set 

in the image. 

Conversion Coefficients 

Shows the conversion coefficients. 
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Manually Input Conversion Coefficients 

Select either automatic calculation or manual 

input of real scale conversion coefficients. 

Remove the check to automatically calculate 

from the [Reference Line] coordinates and 

[Actual Length of the Reference Line] 

coordinates. 

Check to manually input the real scale 

conversion coefficients into [Conversion 

Coefficients]. In this case, you can ignore the 

settings in [Reference Line] and the values for 

[Actual Length of the Reference Line].  

Unit 

Sets the units after conversion. 

Grid Interval 

Sets the grid interval displayed. 

Reset 

Resets the settings to when the dialog was open.  

5.2.2   [Origin and Axis] Tab 

Set the origin and X axis and Y axis directions used in conversion under the [Origin and 

Axis] tab. 

Origin for the Coordinate System 

✓ Lower Left Corner of the Screen 

The lower left of the image is used as the 

origin. 

✓ Fix 

Manually input coordinates to set the origin. 

The units are pixels and the upper left of the 

image is (0, 0).  

✓ Each Frame 

Calculates a specific point as the origin. 

✓ Offset 

Sets offset as the coordinate system origin. 

Applies the offset input to the coordinates 

after real scale conversion. Uncheck to cancel 

the offset application.  

Axis 

Select Axis 

Select the axis to set. Select either the X axis 

or the Y axis. 

✓ Horizontal Right Facing 

Sets the axis to face right. 

✓ Fix 

Manually input the coordinates for the 

starting and ending pints and set the axis 

direction. The units are pixels and the upper 

left of the image is (0,0). Line input is 

possible.  

✓ Each Frame 
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The line connecting specified points is set as 

the axis.   

✓ Offset 

Sets offset to the axis direction. Applies the offset 

input to the coordinates for the settings. Values 

are set as ‘degrees’. Counterclockwise is ‘+’. 

Uncheck to cancel the offset application.  

✓ Another Axis 

  Coordinates where the Y axis is in a position 

90° counterclockwise from the X axis. 

 Coordinates where the Y axis is in a position 

90° clockwise from the X axis. 

Reset 

Resets the settings to when the dialog was open. 

 

There are various axis settings possible when combining the set axis (X axis, Y axis) with 

another axis (counterclockwise, clockwise) and offset coordinate origin and offset axis 

direction. 

The chart below shows examples of coordinate converted measurement point coordinates 

when [Select Axis] and [Additional Axis] are combined. 

 

 Axis Selected: X Axis Axis Selected: Y Axis 

Other Axis:  

Counterclockwise 

 

  

Other Axis:  

Clockwise 

 

  
○: Axis starting and ending points  ×: Coordinate converted measurement point 

 

 

Make the following settings for [Origin and Axis] to that before Ver2.22.  

○ Delete the coordinate origin offset and axis direction offset. 

○ Select [X Axis] from the axis selection combination box. 

When using any other settings (settings after Ver2.22), set under the [Origin and Axis] 

tab. 
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5.2.3  [Depth Plane] Tab 

Calibration of moving objects along a plane is performed under the [Depth Plane] tab if 

there is a plane where the relative depth is known from the reference plane. 

 

Specify the relative depth to the reference plane and the name of the depth plane to 

create a depth plane. 

The registered depth plane is used for the [Plane Correction] tab. 

After registering the plane, the name of the plane and the relative depth can be edited 

in the list. 

 

Reference Plane Depth 

Set the depth of the reference plane. 

Name of the Plane 

Set the name of the depth plane.  

Relative Depth 

Input the depth from the reference plane. Input 

the depth towards the front as a negative. 

Register 

Register to the depth plane list. 

Delete 

Delete the depth plane selected from the list. 

 

5.2.4  [Scale Plane] Tab 

Calibration of moving objects along a plane is performed under the [Scale Plane] tab if 

there is a plane where the length is different from the reference length. 

 

Click on the starting and ending points of a line on the measurement image window with 

a known length and input the actual length in the dialog. 

After registering the plane, the name of the plane and the actual length can be edited in 

the list. 

Plane Name 

Set the name of the scale plane created.  

Designate a Line in the Image Window 

Shows the coordinates for the starting and 

ending points of the line with a known length on 

an image. 

The coordinates clicked on the measurement 

image window are automatically input. 

Actual Length 

The real length for the scale plane. This value is 

used to calculate the conversion coefficient for 

the scale plane.  

Register 

Register the current scale plane to the list. 

Delete 

Delete the scale plane selected on the list. 
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5.2.5   [Plane Correction] Tab 

Use the [Plane Correction] tab to link the planes and measurement points created under 

the [Depth Plane] tab and the [Scale Plane] tab. 

The measurement points not registered here are calibrated using the conversion 

coefficients for the reference plane. 

Check [Set Z Coordinate during Depth Correction] to set the Z value for the 

measurement point. 

 

Select Plane 

Select the plane created in the [Depth Plane] 

tab or the [Scale Plane] tab. 

Measurement Point List 

Select the measurement points linked to the 

plane. 

List of Correction Plane Assignments for the 

Measurement Points 

Display the results of the links between 

measurement points and planes. 

Add  

Link the measurement points selected in 

[Measurement Point List] with the selected 

plane. 

Delete  

Delete the measurement point selected from 

[List of Correction Plane Assignments for the 

Measurement Points]. 

Set Z Coordinate during Depth Correction 

Check to assign measurement points to correction planes and set the relative depth 

of the correction plane as the depth of the measurement point (Z coordinate). This set 

value is used with analysis calculations. 

Uncheck to perform analysis calculations with the Z coordinate of 0 regardless of the 

assigned correction planes. Before MOVIAS Neo Ver2.21, this was calculated by 

checking [Set Z Coordinate during Depth Correction]. Uncheck to calculate in the 

same manner as MOVIAS Pro. 

 

The correction planes cannot be assigned to 

measurement points specified on the reference line. 

If assigning a correction plane to points selected for 

[Every Frame] in the axis direction settings under the 

[Origin and Axis] tab, the starting and ending points 

must also be set on the same correction plane. 

If setting a point as an assigned point for [Every 

Frame] in the axis direction settings under the 

[Origin and Axis] tab, another point is added. 

If assigning improperly corrected planes, a warning 

message will appear when switching tabs or clicking 

[Finish], so make sure to assign properly corrected 

planes. 
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5.3  Changing Perspectives 

Corrects the tracking results of a 2D analysis project by changing perspective. Unlike 

real scale conversion, changing perspective does not require the camera and plane to be 

vertical. Measurements can be made on diagonal scenes. Takes depth elements into 

consideration when correcting movements that have depth. 

 

Refer to エラー! 参照元が見つかりません。  エラー! 参照元が見つかりません。s (p. エラ

ー! ブックマークが定義されていません。) for an explanation of the calculations used for 

changing perspectives. 

 

Perform either of the following to display the measurement image window and make the 

settings for changing perspectives. 

✓ Click [2D Construction] ⇒  [Calibration Status Settings] ⇒  [Changing 

Perspectives] on the menu. 

✓ Click   on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見

つかりません。. 

 

The [Changing Perspectives] dialog appears and then it switches to the change 

perspectives mode. Change perspectives settings can be made in this mode. When 

changing perspectives, [Changing Perspectives] appears in the [Calibration Mode 

Node].  

 

 
Overview of the Change Perspectives Mode 

 

 

 

 

Specify Measurement Point Toolbar Mode Display Bar Zoom Control Bar 

Changing perspectives 

dialog 
If change perspectives is applied, [Changing Perspectives] appears. 
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エラー! 参照元が見つかりません。 (Change Perspectives Mode)  
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Operation is performed both with the measurement image window and the changing 

perspective dialog. 

The procedure for changing perspectives is as follows. 

① Click on 4 points in the measurement image window. 

② Input the length for the real space between the 4 points (6 lengths) or the 

coordinates between the real space (4 points) using the dialog.  

③ Set the origin and axis if necessary. 

④ Click Finish. 

After closing the message, the change perspective parameters are automatically applied. 

 

 
 

When other windows (graphs and such) are in the active window, or when the close 

button at the upper right is clicked, the calibration parameters are cancelled and the 

changing perspectives mode is ended. 

 

Click  to save the current settings to the settings file (*.2cd). 

Click  to load from the previously saved settings file (*.2cd). 

 

Quadrant ・White Dot ・Black Dot ・Fixed Point  can be used for the control 

point settings. Also, you can use Select Measurement Points  to select the tracked 

measurement points and set the control points with the same coordinates as the 

measurement points.   

 

When in the changing perspectives mode, [Reference 

Line], [Origin] and [Grid] may appear in the image 

window, depending on the current change perspectives 

settings. The grid appears without taking optical 

distortion into consideration. If making settings for 

optical distortion correction, the grid displayed will be 

out of place from the real space grid. Instead of using for 

the exact location, use as a target for the axis. 

Switch the display from Show・Hide from the right click menu. 

 

 

 

Sets the value to complete the calibration. 

Calibration calculations are done 

automatically. 

Current settings saved to the file (*.2cd). 

Data settings loaded from the file (*.2cd). 

Restores the values. 
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5.3.1  [Reference Plane] Tab 

Sets the parameters for changing perspectives using the [Reference Plane] tab. 

Designate 4 points with the coordinates for reference points and input the actual length 

between the four points using 6 lengths. The coordinates for the 4 reference points are 

input by clicking a point on the measurement image window. Input the actual lengths・

real space coordinates using the dialog.  

 

 
⚫ Input Reference Points 

Click four points (upper left corner, upper right corner, lower right corner, lower left 

corner) in the measurement image window to set the coordinates. The operation for 

making the settings for the 4 points is different from when making the initial settings.  

 

Initial Settings  

Input the four points according to the following sequence. [Upper Left Corner] ⇒ 

[Upper Right Corner] ⇒ [Lower Right Corner] ⇒ [Lower Left Corner] 

Reset after Setting 4 Points 

Select the reference points using the dialog and adjust the location of the reference 

points selected on the image window. 

 

Input reference 

points 

(Use the image 

window) 

Input actual lengths 

Select the units 

Input reference points 

(upper left corner, upper right corner) 

Input reference points (lower left corner, lower right corner) 

Check to input real space 

coordinates 
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⚫ Input Actual Length 

If [Input Coordinates] is not checked, input the 6 actual lengths between the four points 

of the reference points.  

 

L1: Actual length between the upper left corner (UL) ⇔

upper right corner (UR) 

L2: Actual length between the upper right corner (UR) ⇔

lower right corner (LR) 

L3: Actual length between the lower right corner (LR) ⇔

lower left corner (LL) 

L4: Actual length between the lower left corner (LL) ⇔

upper left corner (UL) 

L5: Actual length between the upper left corner (UL) ⇔

lower right corner (LR) 

L6: Actual length between the upper right corner (UR) ⇔

lower left corner (LL)  

 

 

⚫ Input Coordinate Values 

If [Input Coordinates] is checked, input the real space coordinates for the four points of 

the reference points. 

 

Here, the coordinates input have been subject to depth element correction. To define the 

coordinate system, make the settings in the [Origin and Axis] tab along with the 

coordinates input here. 

 

 

UL: Real space coordinates for the upper left corner 

UR: Real space coordinates for the upper right corner 

LR: Real space coordinates for the lower right corner 

LL: Real space coordinates for the lower left corner 

 

 

  

 

 

 

When input for the reference points and actual lengths is complete, the grid appears on 

the measurement image window. 
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5.3.2   [Origin and Axis] Tab 

Set the origin and axis under the [Origin and Axis] tab. If setting [Fixed] in Origin and 

Axis, the input value is the same as the image coordinates shown at the right side of the 

status bar under the playback bar and does not correspond with the real space 

coordinates. The operation is the same as that in [エラー! 参照元が見つかりません。] of 

the [Origin and Axis] tab (p. エラー! ブックマークが定義されていません。).  

 
 

When changing perspectives, make sure to use the appropriate settings since the origin 

and axis selected greatly impact the measurement results. 
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5.4  3D Calibration 

To construct 3D data, multiple measurement images and the geometric relationship of 

the filming camera must be obtained. 

Since the same relationship is required for each camera, 3D calibration must be 

conducted multiple times. 

Perform [Control Point Real Space Coordinate Input] and [Image Coordinate Input on 

the Calibration Chart for Each Camera] for 3D calibration. 

Designate the fixed measurement points on the calibration chart for the control points. 

 

Perform any of the following to display the calibration image and start constructing 3D 

data. 

 

✓ Click [Construct 3D Data] ⇒ [Calibration] on the menu. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [Switch to Calibration Mode] on the right click menu on the calibration 

window.  

 

The [3D Calibration Dialog] appears, and it switches to the calibration mode. 3D 

calibration settings are made in this mode. 

 

 

Overview of the Calibration Mode 

 

 

 

 

 
エラー! 参照元が見つかりません。 (Calibration Mode)  

Calibration window 

Window toolbar Specify measurement point toolbar Mode display bar Zoom control bar 

3D calibration dialog 
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Operation is performed both with the calibration image window and the 3D calibration 

dialog. 

The 3D calibration procedure is as follows. 

  Input the real space coordinates for the control points. 

  Click the control points on the calibration image.  

  Perform the operation in  multiple times for the cameras for the 

measurement targets. 

  Perform the 3D data construction calculations.  

When creating a project, the setting is automatically loaded when there is a setting file 

with the same name (extension of *.3cd) in the same folder as the calibration image. 

 
 During calibration, click on other calibration windows to confirm the values set on the 

current window, and it switches to the active window operation and continues calibration. 

Click on something other than the calibration image to process in the same manner as 

that when clicking to finish.   

In エラー! 参照元が見つかりません。, if [Automatically Construct Measurement Data 

during 3D Analysis] is enabled, 3D data construction is performed automatically when 

the dialog is completed. Refer to the エラー! 参照元が見つかりません。(p. エラー! ブック

マークが定義されていません。) in Environmental Settings for details. 

5.4.1  3D Calibration Parameter Calculation Method 

The two methods of calculating 3D calibration in MOVIAS Neo include [3D DLT] and 

[MDLT]. 

To set the calculation method, click [File] → [Project Information] in the menu and select 

the calibration calculation method under the [Image] tab in the [Project Information] 

dialog. 

 
 

 

 

Make the settings to complete the 

calibration. 

Restores values. 

Data settings loaded from the file (*.3cd). Also 

loads the settings for the real space coordinates. 
Current settings saved to the file (*.3cd). Settings 

for the real space coordinates are also saved. 

Select the calibration calculation method. 
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3D DLT The basic method that calculates the parameters for 3D data 

construction. Input of a minimum of 6 points is required. 

MDLT Calculates parameters for 3D data construction taking optical 

distortion into consideration. Input of a minimum of 8 points is 

required. 

If there is optical distortion visible to the eye, consider using Optical 

Distortion Correction (p. エラー! ブックマークが定義されていません。). 

 

Both calculation methods require a minimum number of points but the 

accuracy cannot be guaranteed. We recommend calibrating using more points 

(10~15 points). 

 

5.4.2  [Real Space Coordinates] Tab  

[Control Point Real Space Coordinate Input] is performed under the [Real Space Coordinates] tab. 6 

or more points with precise space coordinates are required for calibration (8 or more points for 

MDLT). Perform the either of the following to input the real space coordinates. 

 

✓ Load from the real space coordinates file. 

✓ Manually input on the real space coordinate list.  

 

These real space coordinates are shared between cameras. Input is not necessary for 

calibration from the second and subsequent cameras. 

 

Real Speace Coordinate List 

Shows the real space coordinates. Can be 

manually input. 

 

Unit 

Units for real space coordinates. Select from 

m, cm, mm, um. These units are applied to 3D 

data construction. 

 

Import・Export 

Loads・saves coordinates. The file format is 

CSV (*.csv). 

 

⚫ Edit the Real Space Coordinate List 

You can edit the number and coordinates on the list. Double click to edit. 

Right click to・delete・insert. 

Double click on the row under the last input to add a new row. 

The point can be switched when inputting previously saved points to change the number. 

 

   
 Right click to add・delete・insert 

Double click to manually edit coordinates 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 5－21 

⚫ Real Space Coordinate File Format 

Real space coordinates can be imported and exported. The file format is the comma 

separated value (CSV) format. An example is shown below. 

 

#Point No X Y Z 

1, 0.4, 360.7, 2.6 

2, 0.5, 360.9, 58.3 

3, 0.4, 361.5, 435.7 

4, 0.0, 0.0, 0.0 

5, -0.1, 0.9, -376.5 

6, 0.2, -0.1, -438.4 

7,  400.1,  3.4, 0.9 

#  (Unit: mm)    

Unit=mm    

 

Set the coordinates, number and units.  

 

The 1st column indicates the number. The 2nd, 3rd and 4th columns show the XYZ 

coordinates. 

They are loaded as:  

Number1, X coordinate, Y coordinate, Z coordinate 

Number2, X coordinate, Y coordinate, Z coordinate 

Number3, X coordinate, Y coordinate, Z coordinate 

 

 If starting with “Unit=”, the following unit is set. If there are multiple, the unit for the 

last row is set. If not set, mm are set. Available units include mm, cm, um, m. In the 

example above, it is written in the last row but it can be written in the first row instead. 

Ignore rows starting with letters, empty rows or duplicate numbers. 

 
In the example below, two points (Point 1, Point 2) are loaded and the units are set to “cm”.  

“Point 1” loads the coordinates for “Point 1” in the second row. 

#Point No X Y Z 

1, 0.4, 360.7, 2.6 

1, 0.5, 360.9, 58.3 

Ignore this row. 

 (new row)  

 (new row)  

2,  400.1,  3.4, 0.9 

#  (Unit: mm)    

Unit=mm    

Unit=m    

Unit=cm    
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5.4.3  [Image Coordinate Settings] Tab 

In the [Image Coordinate Settings] tab, the image coordinates for the control points are 

verified on the calibration image and the real space coordinates assigned 

 

Control Point List 

Shows the currently added control points. 

Standard Chart 

Select from [4 Pole], [5 Pole], [AMASS] and 

[Custom] for the calibration chart to be used for 

[Auto Identify Label]. 

Manually Add Control Points 

Set the method of adding control point numbers. 

Auto Detect White Dot 

Auto detect white dots from calibration images 

based on the settings. 

Auto Identify Labels 

Automatically identify the control point 

numbers for the real space coordinates of the 

standard chart. 

 

Perform the following operations. 

  Select the method for adding numbers in [Manually Add Control Points]. 

  Click the control point on the calibration image to add. Adjust the position in 

zoom view. 

  Use the エラー! 参照元が見つかりません。 (refer to p. エラー! ブックマークが

定義されていません。) and auto identify labels to assign the numbers set in the 

[Real Space Coordinates] tab. 

Use the procedures above to perform calibration on a single camera. Perform this 

operation for each calibration image. 

 

If the control point is a white dot, the [エラー! 参照元が見つかりません。] function can 

be used to add control points 

If using a standard chart (4 Pole, 5 Pole, AMASS), you can use the [エラー! 参照元が見つ

かりません。] function (p. エラー! ブックマークが定義されていません。). 
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⚫ Auto Detect White Dot 

Detects white dot control points from the calibration image as a batch. Consider using 

the [Specify Detection Area] function for scenes with bright backgrounds and scenes with 

unrelated white dots. The procedure is as follows. If necessary, specify the detection area. 

Auto detection is performed on the entire image if there is no detection area specified. 

 

(a) Detection Parameter Settings 

Click  under the [Image Coordinate Settings] tab and the [White Dot Detection 

Parameter Settings] will appear. Use the dialog to set the white dots to be detected.   

 

Conversion Threshold for Binary Image 

Sets the brightness threshold for white dot 

detection. 

 

Roundness Threshold 

Sets the roundness. 

 

White Dot Radius 

Sets the range for the size of the point detected. 

 

(b) Detect 

Click  under the [Image Coordinate Settings] tab to sequentially detect 

the control points. 
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(c) Specify Detection Area 

Specifies the detection area for white dots with [Auto Detect White Dots]. If an area is 

specified, white dot detection is performed only on dots within that area. Detection can 

be performed only on areas required, such as scenes with unrelated white dots. 

Click [Detection Range] on the right click menu and drag on the calibration image 

window to specify the detection area. 

  
Drag over the area to specify    Detection area set where dragged  

 

Multiple detection areas can be added. Areas created can be moved or resized. 

The detection area can be automatically deleted when the 3D calibration mode is finished. 

 

Use the right click menu to add or remove detection areas. 

 

Detection Area 

Check to add or delete detection areas. 

 

Delete Detection Area 

Deletes the selected detection area. 

 

Delete All Detection Areas 

Deletes all of the detection areas in the window.  

 

 

 

After setting the areas, click  

under the [Image Coordinate Settings] to 

sequentially detect the control points within the 

[Detection Area]. 
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⚫ Auto Identify Labels 

Identifies the control points and the real space coordinates on the calibration image. 

Valid with charts designated as the standard chart. Supports the following types of 

charts. 

 

   

4 Pole Chart (12 Points)  5 Pole Chart (15 Points) AMASS Chart (12 Points)  

 

The control points must be grouped, the numbers for the control points deleted and new 

positions established. 

 

If the number of control points are designated under the [Real Space Coordinates] tab 

for something other than the charts given above, [Custom] is automatically selected in 

the chart selection combination box. Do not use the auto identify label function when 

[Custom] is selected 

The procedure for the auto identify label function is found in エラー! 参照元が見つかり

ません。～エラー! 参照元が見つかりません。 below. 

 

(a) Select the Type of Chart for the Real Space Coordinates 

Select the type of chart to be used.  

 

Select chart 
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(b) Add Control Points 

Add control points to the calibration image. The position and number must match. 

The figure below shows an example before auto identification of labels. The positions 

match but the control point numbers don’t match. 

 

 
 

(c) Click on Auto Identify Labels 

Click [Auto Identify Labels]. If the auto identification of labels is successful, the 

identified numbers will appear. 

The figure below shows an example after auto identification of labels. The control point 

numbers are corrected according to the chart sequence. 

 

 
 

If auto identification of labels fails, the following message appears. Check to make sure 

the number of control points matches, the control points haven’t shifted and the type of 

chart is accurate. 

 
 

Only the coordinate settings 

are done. The numbers don’t 

match. 

After  auto identification 
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⚫ Control Points Properties Editor 

The 3D calibration measurement point properties are shown in the [Control Point 

Properties Editor]. Replaces detection points and sets detection parameters. 

 

Replacement of detection points cannot be done when the selection for replacement is “-

---”. If another number is selected, that point is replaced with the current point number. 

 

Detailed detection parameter settings are the same as the detailed tracking parameters. 

s (p. 4－11) for details. 

 

 
 

5.4.4   [Precision Verification] Tab 

Under the [Precisions Verification] tab, calibration data calculated for one camera is used 

to calculate and display the reprojection error. The units for this error are pixels.  

 

 
 

 

Select replacement 

Detection parameter settings 

Setting 
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5.5  Optical Distortion Correction 

If performing analysis with MOVIAS Neo, we recommend filming with a “lens without 

optical distortion”. However, you may want to perform measurements with a “lens with 

optical distortion” such as with wide angle photography using a single camera. With 

“videos with optical distortion” filmed in this manner, analysis is not possible due to the 

fluctuations in the length between two points according to their positions in the image. 

To perform analysis, you need to perform “optical distortion correction”. 

 

MOVIAS Neo has an [Optical Distortion Correction] function and an [Extended Optical 

Distortion Correction] function. 

With the [Optical Distortion Correction] function (p. エラー! ブックマークが定義されて

いません。), basic optical distortion correction is performed using a grid chart image.   

The [Extended Optical Distortion Correction] function (p. エラー! ブックマークが定義さ

れていません。) is a revised version of the [Optical Distortion Correction] function. 

Optical distortion correction is performed using a grid line chart or a chessboard chart. 

Qualitative optical distortion correction can be performed without a specialty chart (p. 5

－35). 

 

If there are multiple cameras, add and correct each optical distortion correction chart. 

 

In the [Optical Distortion Correction Chart] node, the 

currently applied optical distortion correction method is 

shown. After creating a project, [No Distortion Correction] 

appears and the real coordinates are calculated without 

performing optical distortion correction.   

If the [Optical Distortion Correction] function is applied and 

the [Optical Distortion Correction Chart] and the [Extended 

Optical Distortion Correction] functions are applied, 

[Extended Optical Distortion Correction 

(Radial/Polynomial)] appears and each type of optical 

distortion correction is performed. 

 

If you perform AVI export on the measurement image with 

distortion correction activated, you will be able to export the 

image after being corrected for distortion.  

 

 

“No distortion correction” 

shows after creating a 

project 

Check for AVI output of images 

subject to distortion correction. 
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5.5.1  Add Optical Distortion Correction Chart 

First, add an optical distortion correction chart to use the [Optical Distortion Correction] 

function. Select the camera node to be added and click [Add Optical Distortion Correction 

Chart] in the right click menu.  

 

 

 

 

 

 

 

 

 

 

 

 

 
If an optical distortion correction chart is added, the optical distortion correction image 

automatically appears. 

Select [Add Optical Distortion 

Correction Chart] from the right 

click menu on the camera node 

The [Optical Distortion 

Correction Chart] is added 

レンズ歪み補正チャート

を追加すると、 

「レンズ歪み補正 ﾁｬｰﾄ」

と表示されます。 
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5.5.2  Optical Distortion Correction Mode 

Access the optical distortion image window and perform either of the following to switch 

to the optical distortion correction mode. 

✓ Click on [Switch to the Optical Distortion Correction Mode] in the right click 

menu in the optical distortion correction image window. 

✓ Click  from the エラー! 参照元が見つかりません。 on the エラー! 参照元が見

つかりません。. 

 

The [Optical Distortion Correction Dialog] appears and it switches to the optical 

distortion correction mode. The optical distortion correction settings are made in this 

mode. 

 

 
 Overview of the Optical Distortion Correction Mode 

 

 

 
エラー! 参照元が見つかりません。 (Optical Distortion Correction Mode)  

 

Operations can be carried out in the optical distortion correction image window and the 

optical distortion correction dialog. Perform the following for optical distortion correction. 

  Set the size of the grid. 

  Use the dialog to select the four corners and input each on the optical 

distortion correction image. 

  Click [Auto Detect Intersection]. Or manually input all of the points.  

  After setting all of the grid points, click [Show Corrected Image] to confirm 

the corrected image. 

  Click [Finish] to complete the processing and save the parameters. The 

distortion correction parameters are automatically applied when building 

measurement data.  

Mode display bar Window toolbar Zoom control bar 

Optical distortion correction dialog 

Optical distortion correction image window 
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5.5.3  Optical Distortion Correction Dialog 

The optical distortion correction operation is performed in the optical distortion 

correction image window using the optical distortion correction dialog. 

 
⚫  [Optical Distortion Correction Settings] Tab 

Number of Grid Intersections 

Set the vertical and horizontal grid lines in a range from 5~25. 

 

Adjust the Location of the Intersections Detected on the Image Window 

Shows a list of the intersections. The unique names of “Upper Left”, “Upper Right”, 

“Lower Right”, “Lower Left” are assigned to the four corners. 

 

Enable the Function to Auto Adjust the Locations of the Four Corners Designated  

If the corners are clicked on the optical distortion correction image when this is 

checked, the locations of the four corners are automatically set to estimated 

locations.    

If unchecked, the clicked coordinates are manually set.  

 

Auto Detect Intersections 

After inputting the four corners, press auto detect intersection to auto detect the 

grid. 

Auto detection failure may occur with distorted images. Refer to エラー! 参照元が見つ

かりません。 (p. エラー! ブックマークが定義されていません。) for details on auto 

detection of intersections. 

 

Show Corrected Image ／Show Original Image 。

After setting all of the intersections, click show corrected image to show the image 

after optical distortion correction. During display of the corrected image, the button 

to show the original image will appear. Click show original image to display the 

original image. 

          
Show Original Image      Show Corrected Image 

⚫  [Comments] Tab 

You can enter comments relating to optical distortion correction. 

Data settings are loaded from the file (*.odc). 

Current settings are saved to the file (*.odc). 

Restore settings. 

Set the values to finish calibration. Calibration 

calculations done automatically. 
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5.5.4  Extended Optical Distortion Correction 

Extended optical distortion correction performs the following.  

⚫ Qualitative distortion correction without an optical distortion correction chart 

⚫ Auto detection of intersections from a grid or chessboard 

⚫ Revised optical distortion correction 

To perform optical distortion correction, perform the following operations with the 

measurement image or optical distortion correction image shown. The optical distortion 

correction image is preferentially used. After adding an optical distortion correction 

image, you must delete the optical distortion correction image from the project tree to 

perform manual distortion correction on the measurement image. 

✓ Click [2D Construction] ⇒  [Extended Optical Distortion Correction] (for 2D 

analysis) on the menu. 

✓ Click [3D Construction] ⇒  [Extended Optical Distortion Correction] (for 3D 

analysis) on the menu. 

The [Extended Optical Distortion Correction] dialog appears. Once extended optical 

distortion correction is applied, the display of the [Optical Distortion Correction Node] is 

updated according to the method applied.  

 

The operation is performed in the [Extended Optical Distortion Correction] dialog. The 

procedure is as follows. 

① Select either radial or the polynomial tab. 

② Set according to each tab. Refer to Radial  (p. 5－35) or エラー! 参照元が見つかり

ません。  (p. エラー ! ブックマークが定義されていません。 ) for the detailed 

settings. 

③ Check the corrected image and confirm that the distortion has been corrected.  

④ Click [OK] to finish the process and save the parameters. The distortion correction 

parameters are automatically applied when building measurement data. When 

clicking [OK], correction for the tab shown ([Radial] or [Polynomial]) is enabled. 

To set the hidden tab, reset and disable. 

 

Extended optical distortion 

correction dialog 

Depending on the correction method used, the 

optical distortion correction node displays the 

following. 

Radial correction when the measurement image is 

used 

 
Polynomial correction when the measurement 

image is used 

 
Radial correction when a chart is used 

 
Polynomial correction when a chart is used 
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5.5.5  Extended Optical Distortion Correction Dialog 

Extended optical distortion correction is performed with the extended optical distortion 

correction dialog.   

 
Use the radial tab or the polynomial tab to set the optical distortion correction.   

Include comments under the [Comments] tab. 

 

You can move the image in the image window with [Maximize], [Zoom In], [Zoom Out] or 

by using the mouse wheel.  

 

 

The data settings are loaded to the file 

(*.ndc). 

Current settings saved to the file(*.ndc). 

Restores the values. 

Perform zoom in/out on the optical 

distortion correction image and drag the 

points detected.  

Sets the value to complete the calibration. 

Calibration calculations are done automatically. 

 

 [Extended Optical Distortion Correction] 

dialog 

Zoom out 

Maximize 

Zoom in 
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⚫ Radial Tab 

 
Select the [Radial] tab in the extended optical distortion correction dialog to perform 

radial correction. 

Radial correction performs distortion correction without using specialty charts.  

Precise correction is not performed since it is qualitative correction. To perform 

precision correction, please refer to the エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。). 

 

Details of radial correction settings are shown in the figure below. 

Use the k1, k2 slider to apply distortion correction to the image.  

k1 is the parameter to correct the distortion mostly in the middle of the image while 

k2 is the parameter to correct the distortion mostly on the edges of the image. 

Click [Default] to disable distortion correction.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Negative Value:  

Pincushion 

distortion 

Positive Value:  

Barrel distortion 

Value of 0: No distortion 

Radial Correction Settings 

Select [Radial] tab 
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⚫ Polynomial Tab 

Select the [Polynomial] tab in the extended optical distortion correction dialog to 

perform polynomial correction. 

Optical distortion correction settings are made from the image of the optical 

distortion correction chart filmed.   

 

 
 

The procedure is as follows.  

① Set the number of vertical and horizontal detection points in a range from 5~50. 

② Select either grid or chessboard as the type of auto detection chart.  

③ Click [Auto Detect] to search. 

If auto detection is successful, the detection points are shown on the image. If 

auto detection fails, refer to エラー! 参照元が見つかりません。 (p. エラー! ブック

マークが定義されていません。). 

④ After auto detection, click [Corrected Image] to confirm the corrected image. 

 

(a) Chart Types  

The following charts can be used for auto detection with the polynomial method of 

correction. 

    
Chessboard (Detection of the corners) Grid (Detection of the intersections) 

① 

② 

③ 
④ 

[Polynomial] tab selection 
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(b) Manual Input of Intersections 

Manual input of intersections on the optical distortion correction image. 

If using something other than the standard optical distortion correction charts and if 

auto detection is not possible, you can manually input the intersections for correction. 

 

Select [List of Detection Points] from the right click menu of the extended optical 

distortion correction dialog and the [List of Detection Points] will appear.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the points to set manually from the list of detection points and click the image 

to set these as detection points. 

 
 

Also, the detection points on the image can be moved with drag and drop. 

    
 

List of detection points 
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5.5.6  Enable・Disable Optical Distortion Correction 

After setting the optical distortion 

correction, you can switch between 

enable・disable correction. 

 

To disable optical distortion correction, 

select the optical distortion correction node 

on the project tree and select [Disable] on 

the right click menu. If [Disable] is 

selected, the measurement data is updated 

without performing optical distortion 

correction.  

 

To enable optical distortion correction, 

select the optical distortion correction node 

on the project tree and select [Enable] in 

the right click menu. 

 

The [Enable] and [Disable] settings can be 

set while in the synchronized display mode 

or the display mode.  

 

To delete all of the optical distortion correction parameters select [Delete] from the 

right click menu of the optical distortion correction node. 

 

Right click menu on the 

optical distortion 

correction node 
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5.5.7  Auto Detect Function for Optical Distortion Correction 

Functions for optical distortion correction include the auto adjust function for the four 

corners and the function to auto detect intersections from an optical distortion correction 

chart. These functions have the following limitations. Images where auto detection failed 

can still use auto detect by reversing the colors or removing the chart part from the image. 

1. Intervals in the vertical・horizontal directions are equidistant. But the vertical・

horizontal intervals do not have to be the same. 

2. The following limitations apply to grids. 

 Chart must be created with black lines on a white background 

 Black lines other than those on the chart are not included 

 For optical distortion correction, a square chart where the lines do not extend 

from the outside of the chart   

 For extended optical distortion correction, a chart with a grid where the lines 

extend from the outside of the chart 

We recommend filming optical distortion correction charts as follows. 

1. There should be more intersections and corners in the horizontal direction than the 

intersections and corners in the vertical direction. 

2. Marker arrangement in chessboards and grids should have at least 17 columns and 

13 rows. 

3. The number of intersections and corners in the horizontal and vertical directions 

should be an odd number, and you should film by aiming at one intersection centered 

on the camera image. 

These limitations do not apply if manually inputting the intersections. 

The chart below shows image examples of successful and failed auto detection of 

intersections. 

Auto 

Detection 

Possible 

 

Example of an image for auto detection of 

intersections. 

However, auto detection of intersections 

may fail if the image has severe distortion. 

Auto 

Detection 

Not 

Possible 

 

The chart image must have black lines on a 

white background to perform auto 

detection.  

Auto detection fails in the figure to the left 

because the chart image has white lines on 

a black background.  

Auto 

Detection 

Not 

Possible 

 

Detection fails due to the presence of an 

unrelated black line at the bottom of the 

chart. 

Black line unrelated to 

the chart 
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6. Create Measurement Data 
 

6.1  Create Measurement Data 

Measurement data refers to the values from calibration of tracking data and the 

application of parameters such as coordinate conversion and distortion correction.  

Tracking data and calibration parameters are used to create measurement data. 

6.1.1  Create Measurement Data for a 2D Analysis Project 

Measurement data is automatically calculated for 2D analysis projects when switching 

to that mode. If no calibration was performed, the measurement data is created using 1 

mm /pixel and a Z coordinate of “0”. 

 

The calculation results can be confirmed on a measurement graph・measurement list・

measurement Trajectory Figure. For details, refer to 6.1.3 Measurement Graphs, 

Measurement Lists (p. 6－2). 

6.1.2  Create Measurement Data for a 3D Analysis Project 

Perform any of the following to create measurement data for 3D analysis projects. You 

must conduct calibration in advance. 

 

✓ Click [3D Construction] ⇒ [Create 3D Measurement Data] on the menu. 

✓ Check [Automatically Construct Measurement Data during 3D Analysis] under 

the [Reconstruction Settings] in the [Environmental Settings] dialog to 

automatically create measurement data in this mode. 

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for details on measurement data construction 

failures. 

 

Calculation results can be confirmed with a measurement graph, measurement list, 

measurement Trajectory Figure. For details, refer to 6.1.3 Measurement Graphs, 

Measurement Lists (p. 6－2). 
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6.1.3  Measurement Graphs, Measurement Lists, Measurement Trajectory 

Figures 

If the measurement data is created, the current project node is added to the 

measurement data node. 

Measurement graphs, measurement lists and measurement trajectory figures can be 

displayed from the right click menu of the current project. 

 (Double click on the current project node to show the measurement list.)  

 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) to check the tracking data. 

 

 
 

   
Measurement List Measurement Graph Measurement Trajectory Figure 

 

6.1.4  Automatic Updates of Measurement Data 

If repositioning or deleting measurement points that make up virtual points (p. エラー! 

ブックマークが定義されていません。) or calculate partial gravity (p. エラー! ブックマー

クが定義されていません。) or if updating measurement data by performing calibration, 

the virtual points and calculate partial gravity are recalculated. 

 

If updating measurement data by performing calibration, the virtual points and center 

of gravity points are recalculated. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) to automatically update graphs. 

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 6－3 

6.1.5  Evaluate 3D Data Construction Errors 

Shows the data errors made during creation of the 3D measurement data. 

 

Click [3D Construction] ⇒ [Evaluate 3D Construction Errors] on the menu to display 

the data errors. 

 

   
 

The coordinates calculated from the image coordinates, the calculated coordinates and 

their differences are shown in the [Construction Errors in 3D Calibration Charts] dialog. 

The units and mean errors are also shown. 

 

The calculated values are the 3D coordinates calculated from the image coordinates 

input during 3D calibration. The units for the coordinates are the units from the real 

space coordinates on the calibration chart. 

 

This is different from the errors shown under the エラー! 参照元が見つかりません。 (p. 

エラー! ブックマークが定義されていません。) in the [3D Calibration] dialog. 

 

6.1.6  Show Measurement Data Construction Status 

Displays information on measurement points that failed during construction of 

measurement data. 

Identifies the restore status when only a certain camera does not track. 

 

Perform any of the following to show information on failures during measurement data 

construction. 

✓ Click [2D Construction] ⇒ [Show Measurement Data Construction Status] (for 

2D measurement) on the menu. 

✓ Click [3D Construction] ⇒ [Show Measurement Data Construction Status] (for 

3D measurement) on the menu. 

 

 

Shows information for the point in the [Frames with Calculation Failure] dialog. If the 

measurement data construction is successful, [Show Measurement Data Construction 

Status] on the menu is not used.
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If there is a failure during construction when [Show Restore Results During Data 

Construction] is checked under the [Restore Settings] tab in [Environment Settings], the 

[Frames with Calculation Failure] dialog will automatically appear.  

 

 
 

The figure above shows an example of when one point is not tracked during 3D 

analysis. 

 

Frame 

Frames with issues. 

 

Cause 

PointID for the point where there was a failure or an issue, and the camera ID 

affiliated with that point. 

 

Error Code 

Shows the internal error codes. 

 

Error codes 

Frame numbers 

Cause・PointID・Camera ID 
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⚫ List of Error Codes 

 

During Real Scale Conversion 

-1 The specified dynamic markers do not exist in this frame. 

If setting with measurement points as the origin or axis, these 

measurement points are not tracked in the specified frame so construction 

failed 

-2 Two points superimposed on the designated X axis 

Since the coordinates match the axis settings, calculations in the axial 

direction could not be performed. 

Other Undetermined error code   2D Scale Calibration Failed 

Any other failures. 

 

When Changing Perspective 

-1 The specified dynamic markers do not exist in this frame 

If setting with measurement points as the origin or axis, these 

measurement points are not tracked in the specified frame so construction 

failed. 

-2 Two points superimposed on the designated X axis 

Since the coordinates match the axis settings, calculations in the axial 

direction could not be performed. 

-3 Input value error for the actual length of the reference point  

The actual length for the reference plane setting is incorrect. Check the 

input value. 

-4 DLT parameter error (designated reference point error, Ex: common line)  

The coordinates input for the reference plane setting are incorrect. Check 

that the coordinates input are correct. 

Other Undetermined error code  2D-DLT Calibration Failed 

Any other failures. 

 

During 3D Calibration 

-1 Void point  PointID[number] state[number] CamID[number] 

PointID point within the CamID camera was in a state other than 

[Ready], construction could not be performed. 

If the state is not 1, tracking cannot be conducted properly. Check the 

tracking state of the frame. 

-2 The specified point does not exist  PointID[number] CamID[number] 

The measurement point for the PointID on the camera with this CamID 

does not exist on this camera. 

-3 The specified frame does not exist CamID［number］ 

Data for the specified frame on the camera with this CamID does not 

exist. 

 

The CamID is the number from the top of the camera node on the project tree. It starts 

with 0. 
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6.2  Virtual Points 

New measurement points are added from the measurement data using calculations. 

These points are called virtual points. 

Includes MOVIAS Neo standard feature virtual points (common virtual points) and 

future extension virtual points (custom virtual points). 

6.2.1  Common Virtual Points 

Common virtual points are a kind of measurement point created from 2 or 3 

measurement points and their coefficients. 

 

Perform any of the following to add common virtual points. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見

つかりません。. 

✓ Click [Analysis] ⇒ [Add Common Virtual Point] on the menu.  

✓ The measurement trajectory figure appears. Click [Add Common Virtural 

Point] on the right click menu. 

 

The common virtual point settings dialog and the current project trajectory figure 

appears. 

Perform the operations in the current project trajectory figure window and the create 

virtual point dialog. 

 
 

 

Virtual Point Name 

Set the name of the virtual point. 

 

Virtual Point Color 

Set the color of the virtual point. 

 

Display settings 

List of reference points 

based on the virtual point 

calculations 

List of virtual points 

Type of virtual point 

Virtual point parameters 

Calculate virtual points now 
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Show Trajectory 

Check to show the trajectory of the virtual points. 

 

Number of Frames Behind・Number of Frames Ahead 

Set the number of frames in the forward and reverse directions to show the 

trajectory. 

 

Type of Virtual Point 

Select from 3 point and 2 point, numeral and percentage. 

 

Virtual Point Parameters 

Parameters used for calculations. The effect and number changes according to the 

type of virtual point. 

 

List of Points for Virtual Point Calculations  

The measurement points specified for virtual point calculations. 

To add, select the measurement points on the list of measurement points and click  

 . To delete, select the measurement points on the list of points for virtual point 

calculations and click  . 

 

List of Virtual Points 

Displays the virtual points currently created. Manual editing of the name, color, 

show/hide display, and length of trajectory on the image can be performed. 

 

Virtual Point Calculations 

Calculate the currently set virtual point now. Press calculates virtual points and the 

currently set virtual point is added to the measurement point list and is also shown 

on the trajectory figure. 

(Virtual point calculations are automatically performed, even when [Finish] is 

pressed) 

 

6.2.2  Calculation Method for Common Virtual Points 

This describes the calculations for common virtual points. 

The virtual points are called P1, P2, and P3, and the virtual point parameters are called 

L1, L2, and L3. 

 
⚫ 3 Points (Percentage) ・ (Numeral)  

Calculates the virtual points on a 3D space from 3 measurement points. The points of 

movement from P1 with a length of L1 in the direction of “P1 → P2”, the movement with 

a length of L2 in the “direction from the direction of P1 → P3 minus the components in the 

P1→ P2 direction” and the movement L3 in the “direction of the two previous vectors” 

constitute the virtual points. 

With [Numeral], input the coefficient as the calibration unit. 

With [Percentage], input the coefficient as a proportion (%) of the length “P1→ P2”. 
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Input 

L1, L2, L3:  Values input for the virtual point parameters on the dialog 

P1, P2, P3:  Points based on the virtual point calculations 

Output 

P:  Virtual points calculated 

Vector Calculations 

𝒖′
→
= (𝑷𝟐
→  
− 𝑷𝟏
→  
), 𝒖→ =

𝒖′
→

‖𝒖′
→
‖

 

𝒗′
→
= (𝑷𝟑
→  
− 𝑷𝟏
→  
) − ((𝑷𝟑

→  
− 𝑷𝟏
→  
) • 𝒖→) 𝒖→ , 𝒗→ =

𝒗′
→

‖𝒗′
→
‖

 

𝒘→ = 𝒖→× 𝒗→ 

 

Coefficient Calculations (Numeral)  

33

22

11

LM

LM

LM

=

=

=

 

Coefficient Calculations (Percentage)  

P1P2

P1P2

P1P2

−=

−=

−=

*100/

*100/

*100/

33

22

11

LM

LM

LM

 

 

Final Calculation of Virtual Points 

𝑷
→
= 𝑀1 𝒖

→+𝑀2 𝒗
→+𝑀3𝒘

→+𝑷𝟏
→  

 

where 𝒂→ • 𝒃
→

is the scalar product of vectors a and b, ‖𝒂→‖is length of vector a, and 𝒂→ × 𝒃
→

is 

the product of vectors a and b. 
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⚫ ２Points (Percentage) ・ (Numeral) 

Virtual points are calculated along a line from two measurement points. Points from P1 

and those L1 from P1 towards P2 are new virtual points.   

With [Numeral], input the coefficient as the calibration unit. 

With [Percentage], input the coefficient as a proportion (%) of the length “P1→ P2”. 
With percentage, if L1 is０, it matches P1, and if L1 is 100, it matches P2.  

 
 

Input 

L1:  Values input for the virtual point parameters on the dialog 

P1, P2:  Points based on the virtual point calculations 

Output 

P:  Virtual points calculated 

 

Vector Calculations 

𝒖′
→
= (𝑷𝟐
→  
− 𝑷𝟏
→  
), 𝒖→ =

𝒖′
→

‖𝒖′
→
‖

 

Coefficient Calculations (Numeral)  

𝑀1 = 𝐿1 
Coefficient Calculations (Percentage)  

𝑀1 = 𝐿1/100 ∗ ‖𝑷𝟐
→  
− 𝑷𝟏
→  
‖ 

Final Calculation of Virtual Points 

𝑷
→
= 𝑀1 𝒖

→+ 𝑷𝟏
→  

 

 

 

 

6.2.3  Custom Virtual Points  

Custom virtual points are virtual points with an add-in function. After MOVIAS Neo 

Ver1.01, “virtual points away from line segments” can be used as custom virtual points. 

Other virtual points can have the add-in function.  

 

⚫ Virtual Points Away from Line Segments 

One point is created from the two points of P1, P2, by moving from P1 along the plane 

parallel to XY. 

 

To add virtual points away from line segments, click [Analysis] → [Add Custom Virtual 

Points] → [Virtual Point Away from Line Segments] on the menu. 

 

The [Create Virtual Point on the XY-Plane] dialog appears. 
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Using P1 and P2 as the original virtual points, the [Length from P1 on the Horizontal 

Axis] for [Virtual Point Parameters] is Q and the [Distance from the Vector] is P. 

 

Create the vector in the direction from P1 to P2 and proceed only Q from P1. 

The virtual point is the point from Q only in the amount of P in the direction 

perpendicular to the vector. 

 (Q is positive in the direction from P1 to P2, and negative in the direction from P2 to P1. 

P is positive to the left of the vector and negative to the right of the vector.)  

Input the virtual point parameters in calibrated units.  

 
Input 

Q set value:  Length from P1 on the horizontal axis (dialog input value)  

P set value:  Distance from the vector (dialog input value)  

P1, P2:  Points based on virtual point calculations 

Output 

P:  Calculated virtual points 

Vector Calculations 

 

 
Coefficient Calculations 

 

 

Final Calculation 

 

Virtual point 

parameters 

List of points based on 

the virtual point 

calculations 

Display 

settings 

Q set value 

P set value 

Vector rotated counterclockwise 90° 
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6.3  3D Coordinate Conversion 

Converts from the calibration coordinate system to a different coordinate system. 

Enabled only during 3D measurement 

 

Perform either of the following for 3D coordinate conversion. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見

つかりません。. 

✓ Click [Tool] → [3D Coordinate Conversion] on the menu.  

 

The [3D Coordinate Conversion Settings] dialog appears. 

 

 Select [Calibration Coordinate System], [3-2-1 Conversion], [Parallel Transport] or [Best 

Fit for Reference Points] from [Select a Conversion Method] as the conversion method. 

 

Calibration Coordinate System 

Use the calibration coordinate system. 

 

3-2-1 Conversion 

Conversion defined as a plane with 3 

points, axis with 2 points and 1 point.  

 

Parallel Transport 

Move parallel using the input 

coordinates as the starting point. 

 

Best Fit for Reference Points 

Conversion defined as 3 points with 

real coordinates from the desired 

coordinate system.   

  
[3D Coordinate Conversion Settings] 

Dialog 

Click OK to save the coordinate conversion settings selected with [Select Conversion 

Method]. 

 

If the [Automatically Construct Measurement Data during 3D Analysis] setting under 

the エラー! 参照元が見つかりません。 in エラー! 参照元が見つかりません。 is enabled, 

click OK to automatically apply coordinate conversion to the measurement data. If the 

[Automatically Construct Measurement Data during 3D Analysis] setting is disabled, 

click [3D Construction] → [Create 3D Measurement Data] on the menu and manually 

construct the measurement data. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for details. 

 

After coordinate conversion, analysis is performed using coordinate converted data for 

virtual points, analysis graph creation, trajectory figure creation and stick display. If 

Auto Update Graphs (p. エラー! ブックマークが定義されていません。) is enabled, the 

graph created is recalculated with the new coordinate system and then displayed. 

 

The calibration coordinate system can be saved even after coordinate conversion. You 

can repeatedly switch to a 3D coordinate system calibration based on the coordinate 

system. 
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If you delete measurement points used with the coordinate conversion settings (such as 

the plane settings), the coordinate conversion settings are deleted, and the calibration 

coordinate system is applied to the measurement data. 

6.3.1  Calibration Coordinates 

Cancels the coordinate conversion currently set and employs the coordinates used during 

calibration. 

 

6.3.2  3-2-1 Conversion 

Defined as a plane forming two coordinate axes with 3 points, 2 points in the direction 

of one coordinate axis and the coordinate axis where 1 point intersects that plane (the 

intersection is the starting point). 

In the following figure, the 3 points are the X-Y plane, the 2 points are the Y axis and 

the 1 point is the Z axis passing through the starting point. 

The order of point input changes according to the axis direction so adjust by checking 

[Reverse the Plane] or [Reverse the Axis] and apply to the left and right coordinate 

systems. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for detailed calculations. 

 

Select 

Ignore this setting 

when selecting the 

calibration 

coordinates 
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Select 

Select from these 6 

Plane・axis・point settings 

Reverse the plane・axis 
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6.3.3  Parallel Transport 

Input the movement amount from the calibration coordinate starting point using 

numbers (mm units), or specify the measurement point as the origin point. Refer to エラ

ー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。) for the 

detailed calculations. 

 

 
 

6.3.4  Best Fit for Reference Points 

Defines 3 points as the real coordinates after conversion and conduct coordinate 

conversion. The standard deviation for errors after conversion is shown to determine the 

optimal conversion. Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマーク

が定義されていません。) for detailed calculations. 

 

 
 

 

Select 

Select 

Set 3 real coordinates after 

conversion 

The overall standard 

deviation is shown 
Select point for conversion 

Specify the amount of parallel 

transport 

 
Numeral 

Manually input the amount of 

movement 

 

Select Point 

Specify the measurement point 

to be starting point 
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6.4  Mass Settings 

By assigning mass to the measurement points, an analysis of momentum, force, power, 

energy and center of gravity can be conducted. 

6.4.1  Mass Settings 

Sets the mass to the measurement points. 

Perform the following for the mass settings. 

 

✓ Click [Analysis] ⇒ [Mass Settings] on the menu. 

 

The mass setting dialog appears. 

 

 
 

Measurement Point Name 

Shows the name of the measurement point. 

 

Mass 

Sets the mass. Double click to manually input numerals. 

 

Units 

Select from kg, g or mg. 

 

Click OK to set the mass to the measurement points.  

 

The momentum, force, power, and energy can be calculated using the mass set. Refer to 

the エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。) 

for details of analysis. 

 

Measurement point name 

Units setting 

Mass settings 
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6.4.2  Calculate Partial Gravity 

Calculates the center of gravity and adds it to the current measurement data. 

Perform the following for the center of gravity. 

 

✓ Click [Analysis] ⇒ [Calculate Partial Gravity] on the menu. 

 

The center of gravity dialog appears. 

 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on calculating the center of gravity. 

 

 

 

Component 

Measurement points are shown so 

multiple components can be selected to 

calculate the center of gravity. 

 

 Name and Color of Partial Gravity 

Set the name and display color for the 

center of gravity. 

 

 

 

 

 

 

 

 

Click OK to add the center of gravity point to the measurement data. 

Just as with other measurement points, select from the measurement data list or the 

measurement point list in the graph creation dialog. 

 

 

  
After Adding the Center of Gravity 

 

 

 

Used to create graphs Show on measurement data 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 7－1 

7. Analysis of Measurement Data 

7.1  Analysis Graph 

7.1.1  Create a Graph 

Various physical amounts can be calculated from the measurement data to create graphs. 

Perform either of the following to create a graph. 

 

✓ Click [Analysis] ⇒ [Create Graph] on the menu. 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

 

The [Create New Graph] dialog appears。 

 

 

  

Overview of Create Graph Dialog  After Graph is Drawn 

 

After creating a graph in the [Create New Graph] dialog (p. エラー! ブックマークが定義

されていません。), the graph created appears in the window. Also, a graph item node is 

created under the graph node on the project tree. The graph title set is shown on the 

graph item node. 

 

 
 

The physical amounts that can be created are as follows. For details, refer to the 

descriptions for each tab. 

エラー! 参照元が見つかりません。:   “ エラー! 参照元が見つかりません。”, “エラ

ー! 参照元が見つかりません。”, “エラー! 参照元が見つかりません。”, 

“Velocity”, “Acceleration”, “Displacement”, “エラー! 参照元が見つか

Graph Node 

is under the analysis data node. 

Graph Item Node 

is under the graph node. 

Create graph dialog (minimize) 

Graph that was drawn Create graph dialog 
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りません。”, “Momentum”, “Force”, “エラー! 参照元が見つかりませ

ん。”, “Energy”. 

エラー! 参照元が見つかりません。:   “エラー! 参照元が見つかりません。”, “エラ

ー! 参照元が見つかりません。”, “エラー! 参照元が見つかりません。”. 

エラー! 参照元が見つかりません。:   “エラー! 参照元が見つかりません。”, “エラ

ー! 参照元が見つかりません。”, “エラー! 参照元が見つかりません。”. 

エラー! 参照元が見つかりません。:   “エラー! 参照元が見つかりません。”, “エラ

ー! 参照元が見つかりません。”, “エラー! 参照元が見つかりません。”  

Measurement Point Angle Tab [Measurement Point Angle (quadrant angle, group 

angle for group tracking)] 

7.1.2   [Create a New Graph] Dialog 

The procedure for creating graphs is as follows. 

① Set the physical amounts. 

② Set the filter, if necessary. 

③ Set the title, series name and series color. Use a different title for each graph.  

④ Check the graph preview and use  to add to the [List of Graph Display 

Points]. 

⑤ Select whether or not to draw on the same graph and click . 

⑥ The [Create New Graph] dialog is minimized and the graph is drawn in the 

graph window.  

 

Click  to close the [Create New Graph] dialog.  

 

The graph settings can be imported and saved as a template. 

 
 

プレビュー表示 

Filter settings Create graph 

End dialog 

Save and load 

Graph title 

List of graph series 

Series name 

Add/delete series 

Series color 

Calculate physical amounts 
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Create Graph Dialog 

 

 

Next are descriptions of the items set with each tab for calculating the physical amounts. 
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⚫  [General] Tab 

(a) Basic Operation 

 

 
List of Measurement Points:  Select the measurement points to be used for 

calculation. 

Axis Settings:  Set the horizontal and vertical axis. 

 Sets the details for physical amounts, units and components. 

 

Calculate the basic physical amounts and create graphs. 

 

Physical amounts that can be used for horizontal and vertical axes include “エラー! 参

照元が見つかりません。”, “エラー! 参照元が見つかりません。” , “エラー! 参照元が見つか

りません。”, “Velocity”, “Acceleration”, “Displacement”, “エラー! 参照元が見つかりませ

ん。”, “Momentum”, “Force”, “エラー! 参照元が見つかりません。”, “Energy”. 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for a description of the physical quantities. 

 

Specify the points to be calculated in the measurement point list and specify the physical 

quantities, units and components for both the horizontal and vertical axis. If necessary, 

make detailed settings to the selected physical amounts. 

 

When registering multiple axes, the physical quantities must be identical to the 

horizontal axis. 

 

(b) Physical Quantities 

(i) Time 

Plots the time for the measurement data. Physical 

Quantities 

TIme 

Units sec, msec,  

μsec 

Components  (None)  
 

 

(ii) Frame Number 

Plots the frame numbers for the 

measurement data. 
Physical 

Quantities 

Frame Number 

Units  (None)  

Components  (None)  
 

 

 

List of measurement points Axis setting 
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(iii) Position 

Plots the coordinates for the 

measurement data. 

Calculations for the relative position to 

other points can be made in the detailed 

settings. 

 

Physical 

Quantities 

Position 

Units m, cm, mm,  

μm 

Components x, y, z,  

Abs (absolute 

value) 
 

 

Offset Settings (Position・Displacement・Movement)  

Sets the offset values for position, displacement, and movement. These can be changed 

after creating a graph. Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマー

クが定義されていません。). 

 
 

 

 

 

 

 

Detailed Settings Dialog (Position) 

 

Calculate the Relative Position to Other Points 

Check to calculate the relative position with 

measurement points selected with the following combo 

box. 

Select the reference point to calculate the relative 

position. 

 

 

 

Manually set offset for position, displacement and movement 
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(iv) Velocity 

Calculates the velocity of the selected 

point. 

Select the differential method under 

detailed settings. 

 

 

Physical 

Quantities 

Velocity 

Units m/sec,  

cm/sec,  

mm/sec,  

μm/sec,  

km/h 

Components x, y, z,  

Abs (absolute 

value) 
 

 

Detailed Settings Dialog (Velocity, Acceleration, Momentum, Force, Power, Energy) 

Select the method of calculating the differential. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) and エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on the calculations. 

 

Forward Difference 

Differential calculations using forward differences. 

Centered Difference 

Differential calculations using central differences. 

Apply Function (3 points, 5 points, 7 points, 9 points)  

Differential calculations made with quadratic functions 

using a specified number of points. 

Calculate End Point 

Switches between enable and disable the differential 

calculations for the start and end frames. The operations 

differ according to the differential method selected. 

 

(v) Acceleration 

Calculates the acceleration for selected 

points. Select the differential method 

under detailed settings. 

 

 

Physical 

Quantities 

Acceleration 

Units m/sec2,  

cm/sec2,  

mm/sec2,  

um/sec2,  

g (gravity 

acceleration)  

Components x, y, z,  

Abs (absolute 

value) 
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(vi) Displacement 

Calculates the displacement from the 

reference frame for a specified 

measurement point. Reference frames 

are set under detailed settings. 

Physical 

Quantities 

Displacement  

Units m, cm, mm,  

μm 

Component x, y, z,  

Abs (absolute 

value) 
 

 

 
Example calculating the amount of displacement (Component X) : The original 

coordinate graph is on the left and the graph of displacement is on the right. The 

figures show the X coordinates but other components are calculated in the same 

manner. Displacement for the reference frame is 0. 

 

Reference Frame Settings (Displacement・Movement) 

Sets the reference frame using the calculations from the physical quantities. Sets the 

reference frame corresponding to the number when a graph of displacement or 

movement was added. The reference frame can be specified for each graph series. 

 
 

Reference Frame 

Selects the frame to use as a reference from the reference frame 

combo box (right). 

 

Current Frame 

Click to set the time for the image displayed in the current 

window as the reference frame.  

 

Switch Display 

Switches the frame number or time display in the reference frame 

combo box.  

 

Reference frame settings 
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(vii) Movement 

Calculates the accumulated value from 

the coordinate of the reference frame. Set 

the reference frame in detailed settings.  

The detailed settings are identical to that 

for [(vi) Displacement].  

Physical 

Quantities 

Movement 

Units m, cm, mm,  

μm 

Components x, y, z,  

Abs (absolute 

value) 
 

 

 
Example calculating the amount of movement (Component X) : The original coordinate 

graph is on the left and the graph of movement is on the right. The figures show the X 

coordinates but other components are calculated in the same manner. Movement for 

the reference frame is 0. Negatives are before the reference frame and positives are 

after. 

 

(viii) Momentum 

Calculates the momentum of the selected 

points. Select the differential method in 

detailed settings.  

Calculates with the mass set in エラー! 

参照元が見つかりません。エラー! 参照元

が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。).  

Physical 

Quantities 

Momentum 

Units kgm/s 

Components x, y, z,  

Abs (absolute 

value) 
 

 

(ix) Force 

Calculates the force of the selected 

points. Select the differential method 

under detailed settings.  

Calculates with the mass set in エラー! 

参照元が見つかりません。エラー! 参照元

が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。). 

 

Physical 

Quantities 

Force 

Units N, mN, μN,  

kN 

Components x, y, z,  

Abs (absolute 

value) 
 

 

(x) Power 

Calculates the power of the selected 

points. Select the differential method 

under detailed settings. 

Calculates with the mass set in エラー! 

参照元が見つかりません。エラー! 参照元

が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。). 

 

Physical 

Quantities 

Power 

Units W, mW, μW,  

kW 

Components x, y, z,  

Abs (absolute 

value) 
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(xi) Energy 

Calculates the energy of the selected 

points. Select the differential method 

under detailed settings 

Calculates with the mass set in エラー! 

参照元が見つかりません。エラー! 参照元

が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。). 

 

Physical 

Quantities 

Energy 

Units J, mJ, μJ,  

kJ 

Components x, y, z,  

Abs (absolute 

value) 
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⚫  [Length] Tab 

(a) Basic Operation 

 

 

 
 

List of Line Segments:  Shows the measurement points used for calculating lengths. 

Axis Settings:  Sets the physical quantities, components and units to be calculated 

Detailed Settings:  Sets the details for calculating lengths. 

 

Calculates the length and its first and second derivatives, and creates a graph. 

Measurement results for at least two points are required. 

 

Physical quantities used for the vertical axis include “Length”, “First Derivative for 

Length” and “Second Derivative for Length”. 

Physical quantities used for the horizontal axis include “Time” and “Frame Number”. 

Refer to エラー! 参照元が見つかりません。  エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for a description of the physical quantities. 

 

Designate the components from Lx (length filmed towards the y-z plane), Ly (length 

filmed towards the z-x plane), Lz (length filmed towards the x-y plane), La (absolute 

value for length). 

 

Use   (Add) and  (Delete) to create the list of line segments to create. Calculations 

are performed in the order found on the list of line segments. 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for details on using the list of line segments. 

 

Calculation of lengths is performed in the order registered to the line segment list. For 

example, if registered in an order of “Point1”, “Point2”, “Point5”, “Point3”, “Point4”, the 

sum of the lengths in the path is calculated according to “Point1” ⇒ “Point2” ⇒ 

“Point5” ⇒ “Point3” ⇒ “Point4”. 

 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for details on how to calculate length. 

List of line segments 

Detailed settings (length) 

Axis settings 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 7－11 

(b) Using the List of Line Segments (Line Segment Points) 

(i) Adding to the List of Line Segments 

 

① Select the measurement points on 

the list of measurement points 

(multiple selections allowed). 

 

② Click  (Add). Multiple selections 

are added from the top of the list.   

 

 
 

 

(ii) Delete from the List of Line Segments 

 

① Select the points to be deleted from 

the list of measurement points 

(multiple selections allowed). 

 

② Click  (Delete). 

 

 

 

 
 

 

(iii) Delete All from the List of Line Segments 

 

① Click  (Delete All). 

 

 

 
 

 

 

① 

② 

① 

② 

① 
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(c) Physical Quantities 

(i) Length 

Calculates the lengths. Calculates the 

sum on the path of points on the list of line 

segments. 

 

For example, if registered in the order of 

Point1, Point2, Point4, the lengths will be 

calculated in the order of Point1⇒Point2

⇒Point4. 

 

Physical 

Quantities 

Length 

Units m, cm, mm,  

μm 

Components Lx(y-z plane),  

Ly(z-x plane),  

Lz(x-y plane),  

La(absolute 

value) 
 

 

 

(ii) First Derivative for Length 

Calculates the rate of change in the 

lengths. Calculates the sum of derivatives 

for the path of points on the list of line 

segments. Select the differential method 

in detailed settings. 

 

 

Physical 

Quantities 

Rate of Change in 

Length 

Units m/sec, cm/sec,  

mm/sec, μm/sec 

Components Lx(y-z plane),  

Ly(z-x plane),  

Lz(x-y plane),  

La(absolute 

value) 
 

 

 

(iii) Second Derivative for Length 

Calculates the acceleration of the lengths. 

Calculates the sum of the second 

derivative for the path of points on the list 

of line segments. Select the differential 

method for detailed settings. 

 

 

Physical 

Quantities 

Acceleration of 

the Lengths 

Units m/sec2,  

cm/sec2,  

mm/sec2,  

μm/sec2,  

g (Acceleration of 

gravity)  

Components Lx(y-z plane),  

Ly(z-x plane),  

Lz(x-y plane),  

La(absolute 

value) 
 

 

 

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 7－13 

⚫  [Angle] Tab 

(a) Basic Operation 

 

 
 

 

List of Angles:  Shows the measurement points used for calculating angles. 

Type of Angle:  Specifies the type of angle to calculate. 

Axis Settings:  Sets the physical quantities, units, coordinate axis or plane of 

projection to be calculated. 

Detailed Settings:  Sets the details of the angles. 

 

Calculates the angle, angle velocity and angle acceleration, and creates a graph. 

Measurement results for at least two points are required. 

 

Physical quantities used for the vertical axis include “エラー! 参照元が見つかりませ

ん。”, “エラー! 参照元が見つかりません。”, “エラー! 参照元が見つかりません。”. 

Physical quantities used for the horizontal axis include “Time” and “Frame Number”. 

 

Refer to エラー! 参照元が見つかりません。  エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for a description of the physical quantities. 

 

Various types of angles can be calculated by specifying the type of angle and axis/plane 

of projection. 

Angles that can be calculated are shown in the following table. 
 Type of Angle 

2 Points 3 Points 4 Points 

Angle 

Vector angle None 

(2D) Standard 

(3D) Standard, 

absolute value 

(2D) Standard 

(3D) Standard, 

absolute value 

Angle with axis 
(2D) vs. X,Y,Z axis 

(3D) vs. X,Y,Z axis 
None None 

Angle on plane of 

projection 
None 

(2D) None 

(3D) vs. X,Y,Z plane 

(2D) None 

(3D) vs. X,Y,Z plane 

 

Select from 2, 3 and 4 point angles to specify the points making angles. 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for the types of angles. 

 

After setting the type of angle, create a list of angles and specify the desired angle. 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on using the list of angles. 

Use the detailed settings if necessary. 

Detailed settings (angle) 

Type of angle 

List of angles 

Axis settings 
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(b) Types of Angles 

 

(i) 2 Points 

Angle type where two measurement points are specified. 

Calculates the angle between the coordinate axis and the 

specified line segment. 

Set two points to calculate the angle from the same vector to 

the coordinate axis. 

Select the coordinate axis from the X axis, Y axis or Z axis. 

 

Set P1, P2 on the list of angles. 

 

 

(ii) 3 Points 

Angle type where three measurement points are specified. Calculates the angle between 

vector t extending from P1 to P2 and vector u extending from 

P1 to P3. The direction of the angle is the angle of rotation from 

t to u. For 3D analysis, the photographic angle and the absolute 

value of the angle can be calculated. 

 

Set the three points of P1～P3 on the list of angles. 

 

 

(iii) 4 Points 

Angle type where four measurement points are specified. 

Calculates the angle between vector t extending from P1 to P2 

and vector u extending from P3 to P4. The direction of the 

angle is the angle of rotation from t to u. For 3D analysis, the 

photographic angle and the absolute value of the angle can be 

calculated. 

 

Set the four points of P1～P4 on the list of angles. 

 

(c)  Axis Setting or Plane of Projection 

(i) Coordinate Axis 

Shows when the type of angle is one that has 2 

points. 

Select from “X Axis”, “Y Axis” and “Z Axis.  

 

 

 

(ii) Plane of Projection 

Shows a 3 point and 4 point angle during 3D 

analysis. 

 Select from “Standard”, “Ax (y-z plane)”, “Ay (z-x 

plane)”, “Az (x-y plane)”, “Aa (absolute value)”. 

 

Refer to エラー! 参照元が見つかりません。 エラー! 

参照元が見つかりません。 Angles (p. エラー! ブック

マークが定義されていません。) for details on each 
投影面設定(3 次元解析時) 

Coordinate axis settings (both 2D analysis 

and 3D analysis) 
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calculation. 
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(d) Using the List of Angles (Points that Create Angles) 

Builds a list of selection points in the same manner as that for length and area. However, 

an operation ((i)-②) to select points to create angles on the list of angles (list on the right 

side) is required. 

 

(i) Adding to the List of Angles 

 

① Select the type of angle. 

② Select the measurement points to add 

to the list of angles. 

③ Select the setting. 

 

④ Click  (Add). 

 

 

 
(ii) Delete from the List of Angles 

 

Select the points to be deleted. 

 

Click  (Delete). 

 

  
(iii) Delete All from the List of Angles 

 

Click  (Delete All). 

 

 

(e) Physical Quantities 

(i) Angle 

 

Calculates the angle based on the type of 

angle set. 
Physical 

Quantities 

Angle 

Units deg, rad 

“deg” refers to 

degree, “rad” refers 

to radian. 

Components Coordinate axis or 

plane of projection 
 

① 

② 
③ 

④ 

① 

② 

① 
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(ii) Angle Velocity 

Calculates the angle velocity. 

Refer to p. エラー! ブックマークが定義さ

れていません。 for detailed settings. 

Physical 

Quantities 

Angle Velocity 

Units deg/sec,  

rad/sec,  

rpm 

Components Coordinate axis or 

plane of projection 
 

 

(iii)  Angle Acceleration 

Calculates the angle acceleration. 

Refer to p. エラー! ブックマークが定義さ

れていません。 for detailed settings. 

Physical 

Quantities 

Angle Acceleration 

Units deg/sec2,  

rad/sec2 

Components Coordinate axis or 

plane of projection 
 

(f) Detailed Settings for Angles 

Sets the detailed settings for the angles. 

 
[Detailed Settings for Angles] dialog 

 

Description of the Angles 

－π～π 

(-180°～180°) 

Shows angles in a range of(−𝜋: 𝜋]. 
If the angle is aroundπ , －π , the graph may not be 

continuous.  

0～2π 

(0°～360°) 

Shows angles in a range of [0: 2𝜋). 
If the angle is around0, 2 π , the graph may not be 

continuous. 

Accumulated 

angle 

Angles are not rounded and are added to the value of the 

previous frame.  

Rotational Direction 

Counterclockwise:  Angle calculations performed on the screen 

counterclockwise in the + direction. 

Clockwise:  Angle calculations performed on the screen clockwise in the + 

direction 

Differential Calculation Method 

Set the differential calculation method using the angle velocity and angle 

acceleration. 

This is the same as the method used to calculate velocity. 

 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 

(p. エラー! ブックマークが定義されていません。) and エラー! 参照元が見つかり
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ません。 エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義され

ていません。) for details on the calculations. 
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⚫  [Area] Tab 

(a) Basic Operation 

 

 

 
 

Area List:  Displays the measurement points used for calculating area. 

Axis Settings:  Specifies the physical amounts, units and plane of projection to 

calculate. 

Detailed Settings:  Sets the differential method for the area. 

 

Calculates the area and its first and second derivatives, and creates a graph. 

Measurement results for at least three points are required. 

 

Physical quantities used for the vertical axis include [Area], [First Derivative for Area], 

[Second Derivative for Area]. 

Physical quantities used for the horizontal axis include [Time] and [Frame Number]. 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) for a description of the physical quantities. 

 

Designate the components from Sx (area projected to the y-z plane), Sy (area projected 

to the z-x plane) and Sz (area projected to the x-y plane). 

 

Use   (Add) and  (Delete) to create the area list.  

The operation for the area list is the same as that for the line segment list. Refer to the

エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。エラー! 参照元が見

つかりません。 (p. エラー! ブックマークが定義されていません。). 

 

Calculation of area is performed in the order registered to the area list. For example, if 

registered in an order of “Point1”, “Point2”, “Point5”, “Point3”, “Point4” on the area list, 

the area of the region surrounded by 

“Point1”→“Point2”→“Point5”→“Point3”→“Point4”→“Point1” is calculated. 

 

Area calculations cannot be properly made with intersecting lines. Do not intersect. 

Refer to エラー! 参照元が見つかりません。  エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for details on the calculations. 

 

 

Detailed settings (area) 

Area List 

Axis 

settings 
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(b) Physical Quantities 

(i) Area 

Calculates the area. 

Calculates the triangle in the area list. 

For example, if registered in the order of 

Point1, Point2, Point4, Point5, Point7, the 

area projected on the plane designated to 

be the area surrounded by P1→P2→P4→

P5→P7→P1 will be calculated. 

 

Physical 

Quantities 

Area 

Units m2, cm2, mm2,  

μm2 

Components Sx (y-z plane),  

Sy (z-x plane),  

Sz (x-y plane) 
 

 

(ii) First Derivative for Area 

Calculates the rate of change in the area. 

Calculates the derivative after calculating 

the area. 

Select the differential method in detailed 

settings.  

Physical 

Quantities 

Rate of Change in 

Area 

Units m2/sec,  

cm2/sec,  

mm2/sec,  

μm2/sec 

Components Sx (y-z plane),  

Sy (z-x plane),  

Sz (x-y plane) 
 

 

(iii) Second Derivative for Area 

Calculates the acceleration of the area. 

Calculates the derivative after calculating 

the area. 

Select the differential method in detailed 

settings. 

Physical 

Quantities 

Acceleration of the 

Area 

Units m2/sec2,  

cm2/sec2,  

mm2/sec2,  

μm2/sec2 

Components Sx (y-z plane),  

Sy (z-x plane),  

Sz (x-y plane) 
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⚫  [Angle of Measurement Points] Tab 

(a) Basic Operation 

 
List of Measurement Points:  Selects the angles for the measurement points or the 

angles for the group points used in the calculations. 

Axis Settings:  Performs the settings for the vertical axis・horizontal axis. 

 Physical quantities, units and detailed settings can be made for 

each. 

 

Creates a graph of the angles from the quadrant tracking results and the group tracking 

results. Can only be created in a 2D analysis project. A group angle reference frame can 

be selected for group angles. With the group angle of the frame selected here at 0°, the 

relative angle of each frame is calculated.   

 

(b) Physical Quantities 

(i) Angle 

Outputs the measurement point angle or 

the group angle. During group angle 

selection, you can set the reference frame 

for the group angle. 

Physical 

Quantities 

Angle 

Units deg, rad 

Components  (None)  
 

 

Reference Frame 

Selects the frame to use as a reference from the reference frame combo box. 

 

Current Frame 

Click to set the time for the image displayed in the current window as the reference 

frame. 

 

Switch Display 

Switches the frame number or time display in the reference frame combo box。 

 

List of measurement points 
Axis settings 

When group angle is selected Reference frame 

select for group angle 
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(ii) Angle Velocity 

Calculates the angle velocity for the 

measurement point angle or the group 

angle. 

Physical 

Quantities 

Angle Velocity 

Units deg/sec,  

rad/sec,  

rpm 

Components  (None)  
 

 

(iii)  Angle Acceleration 

Calculates the angle acceleration for the 

measurement point angle or the group 

angle. 

Physical 

Quantities 

Angle Acceleration 

Units deg/sec2,  

rad/sec2 

Components  (None)  
 

 

(c) Detailed Settings for Measurement Point Angles 

Set in the same manner as for エラー! 参照元が見つかりません。 (p. エラー! ブックマー

クが定義されていません。). 

 
Rotational Direction 

Counterclockwise:  Angle calculations performed on the screen counterclockwise 

in the + direction. 

Clockwise:  Angle calculations performed on the screen clockwise in the + 

direction. 
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(d) Calculation for Quadrants and Group Angles 

Angles for quadrant and group tracking are calculated as follows. 

 

(i) Quadrants 

The quadrant angles are calculated for each frame at ±180°.  

If using the default settings for [Origin and Axis] for calibration, it is calculated as 0° 

with the arrangement in the left diagram below.  

If the axis direction is set as shown in the following diagram on the right, and the angle 

of the quadrant matches the angle of the axial direction, it is calculated as 0°. 

 

Positive and negative angles can be set for the rotational direction in [Detailed Settings] 

under [Angles for Measurement Points]. 

   
Left Figure:  Quadrant angle of 0° when the calibration settings are the defaults. 

Right Figure:  Quadrant angle of 0° when the calibration is set in the axial 

direction. 
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(ii) Group 

Calculates the differential between the angle of the current frame (－180°- 180°) 

and the angle of the frame before it. Also adds the offset so the reference frame of the 

group angle set in the dialog becomes 0°.  The method of calculating the group is as 

follows.  

 

  
 

 

 

 

 

 
1. Parallel transport so the centers of gravity for the t+1 group and the t group overlap. 

2. Calculates the angle of rotation (𝜃𝑔𝑟𝑜𝑢𝑝
(𝑖)

) between the time t and the time t+1 for the 

measurement point 𝑖 for each pont in the group as the rotational center of gravity. 

3. Calculates the mean for the 𝜃𝑔𝑟𝑜𝑢𝑝
(𝑖)

 as the rotational angle 𝜃𝑔𝑟𝑜𝑢𝑝 for this group.   

4. Angle calculations are performed in the rotational direction from the [Detailed 

Settings] so they become + from the set direction. 

 

Also adds the offset so the angle of the time set by the reference frame of the group angle 

becomes 0°and calculates the group angle.   

 

 

4 分円の回転方向 

Example of a group with a time of 

t:  Group created with quadrants. 

The red X is the center of gravity 

for the quadrant. 

Example of a group with a time 

of t+1:  the time t group rotates.  
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⚫ [Plane Distance] Tab 

(a) Basic Operation 

 

 
 

Points subject to Measurement:  Shows the measurement points used for calculating 

distance. 

List of Planes:  Shows the plane construction points used for calculating distance. 

Axis Settings:  Sets the physical quantities, components, and units to be calculated. 

 

Calculates the points subject to measurement and the plane distance, and creates a 

graph. 

 

Measurement results for at least three points are required. 

 

Physical quantities used for the vertical axis include “Length”. 

Physical quantities used for the horizontal axis include “Time” and “Frame Number”. 

 

 

Use   (Add) and  (Delete) to create a list of planes. The calculations are performed 

according to the order in the list of planes. 

Refer to  エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラー! 

ブックマークが定義されていません。) to use the list of planes. 

 

The methods for specifying planes differ between 2D measurement and 3D measurement. 

Real Scale Conversion:  Plane passing through the vertical direction between 2 points 

and the screen  

Changing Perspectives:  Plane passing through the vertical direction on the 

perspective plane and 2 points 

3D:  Plane passing through the 3D points  

 

List of planes 

Axis settings 
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(b) Points Subject to Measurement  

Determines the distance between the points selected for measurement here and the 

plane selected on the list of planes.  

 

(c) Using the List of Planes 

(i) Adding to the List of Planes 

 

1. Select a measurement point on the list 

of measurement points. (multiple 

selections allowed.) 

 

2. Click  (Add). With multiple 

selections, they are added according to 

the order on the list.   

 

  
 

 

(ii) Deleting from the List of Planes 

 

1. Select a point on the list of planes to 

be deleted. (multiple selections allowed.) 

 

2. Click  (Delete) . 

 

 

  
 

 

① 

② 

① 

② 
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⚫ Filter 

Smoothing out the graph. 

 

 
 

Filters that can be selected include [Butterworth], [CFC] and [Moving Average]. The 

default is [No Filter] 

If the horizontal axis of the graph is time/frame number, a filter is not used. 

 

(a) Order of Filter Application 

MOVIAS Neo can select the order of filter application for the physical quantity 

calculations. 

 

 
Check [Apply before physical calculation] to apply the filter to the XYZ coordinates before 

Butterworth Filter 

Specify the cutoff 

frequency. 

CFC 

Specify the frequency 

class. 

Select from 60, 180, 600，

1000. 

Moving Average 

Input the parameters for the 

moving average. 

Specify the type (3 point 

average, 5 point average) and 

the application frequency.  

 

   
 

 

 

 

 
 

cutoff frequency 

frequency class 

application 

frequency 

type 
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calculating physical amounts. 

Handling the absolute values of multiple components impacts the calculations for the 

physical quantities. On the other hand, there is almost no difference when calculating 

only particular components. When calculating absolute values, a version 1.01 or earlier 

filter has a better smoothing effect. 

 

Uncheck [Apply before physical calculation] to apply the filter after calculating physical 

quantities. This setting is not available on MOVIAS Neo versions 1.01 or earlier. 

 

 
Comparison of Filter Applications 

Solid Line:  Applied before calculating physical quantities (if checked)  

Dotted Line:  Applied after calculating physical quantities (if not 

checked)  

 

⚫ Title, Series Names 

Sets the graph title and the names of each series. The title is also set to the name of the 

graph node. Use a title that is different for each graph. 

 

⚫ Series Colors 

Designates the series color. Can be set to a custom color. 

 

⚫ Using Series (Add, Delete, Delete All)  

Add  Adds the series shown in the current dialog to the graph list. 

Delete  Deletes the series selected in the graph list. 

Delete All  Deletes all the series registered in the graph list. 

 

⚫ List of Graph Points Shown 

Displays the graph series currently created. Select a series to load the data for the series 

selected and set in the dialog 

 

⚫ Load or Save Template 

Loads set data from the saved template file. Also saves data currently registered to the 

[List of Graph Points Displayed] to a file. 

 

⚫ Draw Graph 

Adds data created to a project and displays the graph window. After drawing a graph, 

the [Create New Graph] dialog is minimized. 

Check [Draw in the Same Graph] to display the graph for the series registered in the list 

in the first window. Uncheck to create a graph item node for each series and display in 

their own graph window. For example, if three series are registered to the list, three 
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graph item nodes are created, which are displayed in their own graph window. 

 

⚫ Close  

Closes the [Create New Graph] dialog. 

 

7.1.3  Differential Calculations 

⚫ Function Fitting Differentials 

With function fitting (3 points, 5 points, 7 points, 9 points) in [Detailed Settings Dialog] 

for velocity and acceleration, differential calculations are performed with quadratic 

functions using a specific number of points. Since differentials have a bit of a smoothing 

effect, there is an effect if there is significant noise from “forward differences” and 

“central differences”. 

 
Settings Dialog for [Function Fitting]  

 

Next is a comparison with “central differences”. 

 

   
Comparisons between [Function Fitting] and [Central Differences] 

 (Left) 7 point [Function Fitting] (Center) 5 point [Function Fitting]    

(Right) [Central Differences] 

 

With [Central Differences], noise is evident while [Function Fitting] shows the graphs 

smoothed out. The more points, the smoother the differential effect 
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⚫ Example Reproducing the Effect of the MOVIAS Pro Calculations with MOVIAS 

Neo Ver1.01 or earlier 

(i) Reproducing the Calculation Effect with MOVIAS Neo Ver1.01 or Earlier 

Method of Calculating Differentials:  Select either [Central Differences] or 

[Forward Differences].  

Calculating End Points:  Check [Calculate End Points]. 

Filter Application:  Uncheck [Apply Before Calculating Physical Quantities]. 

   
 

 

(ii) Reproducing the Calculation Effect with Movias Pro 

Method of Calculating Differentials:  Select either [Central Differences] or 

[Forward Differences]. 

Calculating End Points:  Check [Calculate End Points]. 

Filter Application:  Uncheck [Apply Before Calculating Physical Quantities]. 
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⚫ Handling End Frames during Differential Calculations 

Check [Calculate End Points] to calculate differentials with MOVIAS Neo version 1.02 

or later and switch between calculations for end points (starting frame・ending frame). 

End point calculations are as follows, according to the differential method selected 

 

(i) [Forward Differences] or [Central Differences] 

Check [Calculate End Points] 

Performs differential calculations on all frames. At this point, differential 

calculations are performed with linear approximation of the base data in the 

ending frame. 

 

Uncheck [Calculate End Points] 

Performs differential calculations only on frames that can be calculated with the 

differential method specified. 

 

(ii) [Function Fitting] 

Check [Calculate End Points] 

３ Points: Performs differential calculations starting with two frames from the 

beginning and ending with two frames from the end. 

５ Points: Calculates with five points starting with three frames from the 

beginning and ending with three frames from the end, and three points 

starting with two frames from the beginning and ending with two frames 

from the end 

７ Points: Calculates with 7 points starting with 4 frames from the beginning and 

ending with 4 frames from the end, 5 points starting with 3 frames from the 

beginning and ending with 3 frames from the end, and 3 points starting 

with 2 frames from the beginning and ending with 2 frames from the end。 

９ Points: Calculates with 9 points starting with 5 frames from the beginning and 

ending with 5 frames from the end, 7 points starting with 4 frames from the 

beginning and ending with 4 frames from the end, 5 points starting with 3 

frames from the beginning and ending with 3 frames from the end, and 3 

points starting with 2 frames from the beginning and ending with 2 frames 

from the end. 

 

Uncheck [Calculate End Points] 

３ Points: Performs function fitting differential calculations using 3 points, 

starting with 2 frames from the beginning and ending with 2 frames from 

the end 

５ Points: Performs function fitting differential calculations using 5 points, 

starting with 3 frames from the beginning and ending with 3 frames from 

the end. 

７ Points: Performs function fitting differential calculations using 7 points only 

starting with 4 frames from the beginning and ending with 4 frames from 

the end. 

９ Points: Performs function fitting differential calculations using 9 points, 

starting with 5 frames from the beginning and ending with 5 frames from 

the end. 
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7.1.4  Graphing 

Double click the analysis graph item node or click draw graph in the create graph dialog 

to display the analysis graph. 

 

 

 

 
 

 

 

 

 

⚫ Jump Frames 

Move the mouse on the graph series and click to select the points (figure at 

the right) to jump to that frame. 

Drage to move the frame. 

 

During playback, the cursor and position selected on the list move. Click a series during 

sync playback to jump all of the frames in the window. 

 

 

 

Series settings 

Title 

Series 

Axis settings 
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⚫ Drag and Drop 

A graph series can be added to other graphs with the same horizontal axis using drag 

and drop if the frame rates match. 

 (A maximum of 6 axes can be added) 

 

 
 

  
 

 
 

 

⚫ Change Titles 

Double click on a section of the graph title to show the [Graph 

Title Settings] dialog. Input the title and click OK to change the 

title of the graph. The graph item node display on the project tree 

can be changed at the same time 

 

⚫ Series Settings 

The name and color of the series can be changed for 

each series. 

Right click on the name of the series or double click 

a point on the series to display the popup menu. 

Click on the settings to change. 

 

Drag 

Select the series to be copied. 

Dropped series are copied 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 7－34 

⚫ Font Settings  

Click [Detailed Settings for Graphs] on the right click menu on the graph to display the 

[Detailed Settings for Graphs] dialog and set the graph font. 

Sets the title font, series and axis font as well as the graph character size. 

 

 
 

 

⚫ Specify Axis 

Double click on a part of the target axis (figure to the 

right) to set the data range for the horizontal and 

vertical axis, and to display the [Graph Axis Settings] 

dialog appears. If there are multiple vertical axes, the 

range for each axis can be set 

 

 

 

 

If [Auto] is selected, all of the data will be graphed. If 

[Manual] is selected, the desired range can be set. The 

default is [Auto]. 

 

If the vertical axis or horizontal axis is time or frame 

number, you can set the playback range using the 

playback slider. 

 

If you set the playback range using a playback slider while in the display mode, the 

playback range will be reflected on the graph display range.  

Title font 

Other fonts 

Graph character size 
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Top: Default playback range (All)    Bottom: After setting the playback range. The graph 

display range changes with the playback range. 

Display the 0～159 (ms) range 

Display the 40～100 (ms) range 

Start playback 0(ms) End playback 159(ms) 

Start playback 40(ms) End playback 100(ms) 
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⚫ Analysis Graph Information Dialog 

Confirms the information for the current analysis graph. 

Click [Graph Information] on the right click menu of the graph. 

The [Analysis Graph Property] dialog appears so set [Auto Update of Graph] and confirm 

the [Graph Information]. 

 

[Enable Auto Update of Analysis Graph] Check Box 

Setting for auto updates on each graph. When correcting or deleting tracking 

measurement points or when correcting calibration, the finished graph is 

automatically updated with the latest data. 

Check [Enable Auto Update of Analysis Graph] to automatically update the graph 

when creating measurement data (p. エラー! ブックマークが定義されていません。). 

The default is checked. Uncheck and graphs are not automatically updated. 

To enable this setting, the auto update graph settings in [Environment Settings] (p. 

エラー! ブックマークが定義されていません。) must be enabled. 

 

 [Graph Information] 

Displays all the analysis graph information, including [Physical Quantities], [Units], 

[Filter] and [Detailed Settings] specified during creation of the analysis graph.  

Displays the graph information for the series selected with the [Select Series] combo 

box. 

 

 
[Analysis Graph Information] Dialog 

 

[Enable Auto Update 

of Analysis Graph] 

check box 
[Select Series] combo box 

[Graph Information] box 
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⚫ Offset Graphs 

Set the amount of offset for graphs of position・ 

displacement・movement. 

The values set are the same as those under the エラ

ー! 参照元が見つかりません。 in the エラー! 参照元が

見つかりません。. 

Click [Offset Settings] on the right click menu of the 

graph series to display the [Offset Settings] dialog. 

Set or cancel the offset with this dialog. 

 

 

 

 
Change the values when checked to preview after applying the offset values to the series. 

Click OK to apply or cancel to return to the previous dialog 

Only the physical quantities of position・displacement・movement on the vertical axis 

and horizontal axis can be used with [Offset Settings]. 

Check to apply 

offset value. 
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7.2  Trajectory Figures 

7.2.1  Create a Trajectory Figure 

Perform the following to create a trajectory figure of measurement data. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。. 

✓ Click [Analysis] ⇒ [Create a Trajectory Figure] on the menu. 

✓ Click the trajectory figure node under the analysis data node on the project tree 

and then click [Create New] on the right click menu.  

 

The [Create Trajectory Figure] dialog appears. 

 
Create Trajectory Figure Dialog 

Select the measurement points to display under the [Select Data to Display] tab.  

 

 
 

 
 

 

After creating a trajectory figure, click [Properties] on the right click menu of the 

trajectory figure to switch between show/hide the measurement points and display the 

[Trajectory Graph] dialog. 

 

The title and auto update of the trajectory figure can be set under the [Title Settings] 

tab (p. エラー! ブックマークが定義されていません。). 

 

 
 

Click OK to add the trajectory figure to the project and display the trajectory figure 

Show the trajectory of 

measurement points 

checked 

Do not show the trajectory of 

measurement points if unchecked. 
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window. 
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7.2.2  Using Trajectory Figures 

Drag to change the perspective. Rotate 360° or tilt approximately 80°. 

Right click the measurement point name or double click a point on the trajectory to 

display a popup menu and change the color or name. 

Double click on the graph title to change the graph title. 

 

 

⚫ Auto Update of the Trajectory Figure 

Setting to automatically update the trajectory figure. When correcting or deleting 

tracking measurement points or correcting calibration, the finished graph is 

automatically updated with the latest data.  

Click [Properties] using the right click menu on the graph. 

 

 

 
Title Settings Tab in the [Trajectory Graph] Dialog 

 

Check [Enable Auto Update] under the [Title Settings] tab of the [Trajectory Graph] 

dialog to automatically update the trajectory figure when creating measurement data (p. 

エラー! ブックマークが定義されていません。). The default is checked.  

Uncheck and the trajectory figures are not updated.  

 

To enable this setting, the auto update graph settings in [Environment Settings] (p. エ

ラー! ブックマークが定義されていません。) must be enabled. 
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7.3  Analysis List 

Switch between analysis graph・trajectory figure tabs to display the graph, the list or 

both the graph and the list. 

 

 
 

 

   
 

 

 

Display List Display Graph and List Display Graph 
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7.4  Sticks 

A straight line between measurement points is called a stick. Sticks are displayed in the 

stick window. Also, they can be superimposed on the measurement image window. 

3D analysis results are drawn with points and lines (sticks). 

7.4.1  Define Stick Dialog 

To create or edit stick definitions, perform any of the following when the stick item node 

(refer to p. エラー! ブックマークが定義されていません。) in the project tree is not 

selected.  

 

✓ Click  the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つか

りません。. 

✓ Click [Tool] ⇒ [Define Sticks]. 

 

The [Define Sticks] dialog appears. 

 

 
[Define Sticks] Dialog 

 

Individual Settings 

Settings for currently created sticks. Sets the stick name, color and thickness. 

 

List of Measurement Points 

Displays a list of measurement points available for constructing sticks. 

 

Construct Sticks 

Measurement points currently constructing sticks. 

 

Window Background Color 

Sets the background color for the stick window. 

 

Individual settings 

Construct sticks List of measurement points 

Registered sticks 

Window background color 
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Registered Sticks 

List of registered sticks. 

After clicking Finish, the defined stick can be used. 

 

Load Settings 

Loads the defined stick saved in the file (*.stk). 

 

Save Settings 

Saves the currently defined stick in a file (*.stk). 

 

Reset 

Reverts to the settings from when the dialog was opened. 

 

⚫ Stick Registration 

Sets the name・color・thickness of each stick and registers them to a list. To register a 

stick, perform either (a) エラー! 参照元が見つかりません。 or (b) エラー! 参照元が見つか

りません。. 

 

Defined sticks are superimposed on the measurement image. 

If the starting and ending points of a stick are the same, it is treated as a point. If 

specifying a series of multiple points, these connected points create a stick. For example, 

if adding “Point1”, “Point2”, “Point4”, “Point5”, “Point3” in that order, a total of four 

sticks will be registered, specifically “Point1－Point2 stick”, “Point2－Point4 stick”, 

“Point4－Point5 stick”, “Point5－Point3 stick”. 

 

(a) Using the Construction Point List 

After adding or deleting from the [List of Stick Construction Points], add them to register 

the sticks. Straight line sticks and point sticks can be created 

    
 

 

Add to construction list 

Add to registration list 

List of construction points 
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(b) Manually Add to Registration List 

Manually add to the registration list. Registration of straight line sticks is sequential. 

 

 
 

(c) Editing after Registration 

Double click on the item registered to manually edit the name, starting point, ending 

point, color or width. 

 

 
 

7.4.2  Create and Edit Stick Item Nodes 

The stick item node can be created after creating a defined stick. Perform any of the 

following. 

 

✓ Click  on the エラー! 参照元が見つかりません。 on the エラー! 参照元が見つ

かりません。 

✓ Click [Analysis] ⇒ [Create Stick] on the menu. 

✓ Click [Create New] on the right click menu under the analysis data node.  

 

 

 
Perform either of the following on the project tree to edit the stick item node. 

Empty list of construction points 

Add to registration list 

Example of manually editing color 

The stick node is directly under the 

analysis data node. 

The stick item node is under the stick node.  

The stick item node is created by copying from the 

defined stick in the stick node. 
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✓ Select the stick item node and click the define stick  button. 

✓ Click [Edit Stick] on the right click menu in the stick item node.  

 

The Stick Definition dialog appears. Edit the stick definition for the selected stick item 

node. 

 

7.4.3  Stick Window 

Use the mouse to create sticks. The right click menu has settings for [Superimpose 

Settings], [Projection Method], [Show Grid], [Rotation Center Settings] as well as [Save 

to Image File]. 

 

 
Overview of Stick Operation 

 

⚫ Mouse Operation 

Use the mouse to display. 

Rotate:  Drag 

Zoom In:  Shift + drag upwards/rotate mouse wheel upwards 

Zoom Out:  Shift + drag downwards/rotate mouse wheel downwards 

Move Parallel:  Ctrl + drag/drag mouse wheel 
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⚫ Superimpose Display Settings 

Click [Superimpose Settings] on the right click menu and the stick display settings dialog 

will appear.  

 
[Stick Display Setting] Dialog 

 

Set the display method from [Standard], [Show Superimposed], [Time Shift] or 

[Superimpose Specified Points]. 

 

Standard 

Shows only the selected sticks. 

 

Superimposed Display  

Sets the number of superimposed frames to show and displays the sticks in that range 

of frames. Frames not current are shown as semi-transparent. Sets the number of 

frames for the superimposed display. 

 

 
 

If the number of superimposed frames to display is set as in the above figures, the 

following sticks for the frames are shown in the window when the current frame is 0. 

Stick for the -9th frame 

Stick for the -6th frame 

Stick for the -3rd frame 

Stick for the 0 frame 

Stick for the 3rd frame 
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Time Shift 

Sticks for specified pixels are shifted to display afterimages. 

Sets the number of superimposed frames to display and the offset settings for the 

amount of the shift. 

The number of frames displayed before and after are automatically set to the same 

number. 

  
Superimpose Specified Points 

Superimposes the specified measurement points on the current frame for a 

superimposed display. 

Sets the number of superimposed frames to display and the standard superimposed 

points.   

Other than superimposing one point, it is the same as the superimposed display.   

  
 

⚫ Projection Method 

Select the projection method with the right click menu. 

Select from [Perspective Projection], [Front Orthogonal Projection], [Top Orthogonal 

Projection] and [Side Orthogonal Projection]. 

 

Perspective Projection 

Converts the perspective for display. 

Objects far away are shown smaller and closer objects are larger. 

 

Front Orthogonal Projection 

Converts the current display to the front orthographic display. Displays without 

Superimposed points 

ΔX=0 

ΔY=120 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 7－48 

regard to distance. 

 

Top Orthogonal Projection 

Point viewed is shown from the camera top orthographic perspective. Displays 

without regard to distance. 

 

Side Orthogonal Projection 

Point viewed is shown from the camera side view orthographic perspective. Displays 

without regard to distance. 

 

⚫ Show Grid 

Displays a grid on the X,Y,Z planes. Click [Show Grid] on the right click menu → then [y-

z plane], [z-x plane], [x-y plane] to switch the grid from show/hide. 

For settings for each plane, click [Show Grid] on the right click menu ⇒ [Grid Properties] 

to display the [Grid Settings] dialog. 

 

 

 

 

Select Grid 

Grid for the target settings. Settings for [Grid 

Position], [Grid Scale], [Number of Lines] and 

[Color] for the selected grid.  

 

Grid Position 

Designate the offset from the coordinate axis 

on the grid plane. 

 

Grid Scale 

The scale for the grid. 

 

Number of Lines 

Number of lines on the grid. 

 

Color 

Designates the color of the grid. 

 

Show Coordinates 

Shows the grid position in the window. 

 

⚫ Rotation Center Settings 

Select the rotation center for mouse rotation. 

 

Center of Gravity for Measurement Points 

Use for the center of gravity. 

 

Select a Measurement Point as the Center of Gravity 

Set a specific measurement point as the center of gravity. 

Click a measurement point on a stick to select. 

 

Calibration Starting Point 

Establishes a calibration starting point. 
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⚫ Stick Settings 

Click [Properties] on the right click menu to display the [Stick Settings] dialog. 

 
 [Stick Settings] Dialog 

Use 3D Rotation 

Sets limits for the 3D rotation relative to the mouse drag operation. 

Check for 3D rotation. Uncheck so there is no 3D rotation. Limits it to 2D rotation. 

The initial value when creating sticks during 2D analysis has [Use 3D Rotation] 

disabled. 

The initial value for 3D analysis enables [Use 3D Rotation]. 

 

Enable Auto Update 

Check to enable automatic updates to stick displays when measurement points are 

changed. The default is checked. Uncheck and automatic updates of stick displays 

are not conducted. 

 

To enable this setting, the auto update graph settings in [Environment Settings] (p. エ

ラー! ブックマークが定義されていません。) must be enabled. 
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⚫ Coodinate Axis 

The axis showing the current coordinates is shown at the top right of the 

window 

The X, Y and Z axis colors are red, green and blue, respectively. 

Click [Show Coordinate Axis] on the right click menu to switch between 

show/hide. 

 

 

⚫ Camera Icon 

Icon in the upper left of the window. Set the perspective to the 

position of the camera clicked to reset the mouse 

 

Data on the position of the camera icon is arranged in order from 

the camera item node on the project tree. (Refer to the example 

in the following figure.) 

 

 

 
Example of the Position Data 

 

Cameras not calibrated are not set even if they are clicked. 

 

⚫ Show Measurement Points 

Setting to display all of the points with measurement results. 

Click [Show Measurement Points] on the right click menu to switch from show/hide. 

Measurement points are displayed after the sticks are displayed. 

 

The figure on the left does not show them, while they are shown in the figure on the right. 

 

    
 

⚫ Show Rotation Center  

Shows the points indicating the center of rotation. Click [Show Rotation Center] on the 

right click menu to switch between show/hide. 
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7.5  Auto Update Graphs 

Settings for analysis graphs as well as trajectory figures and sticks to automatically 

update graphs. 

If correcting or deleting tracked measurement points or if correcting calibration, 

completed graphs are updated with the latest data when the measurement data is 

updated. 

 

The auto update graph settings in [Environment Settings] (p. エラー! ブックマークが定

義されていません。) must be enabled. 

 

Also, the auto update settings can be individually set for each graph. 

Refer to the following for individual auto update graph settings. 

 

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。)  

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。)   

エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。)  
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7.6  Simple 6DOF Measurement  

Performs 6DOF measurement for the measurement target. Since 3D measurements are 

linked, create a 3D measurement project to perform 6DOF measurement.  

The following inputs and files are needed to perform 6DOF measurement. 

✓ 4 or more measurement points. 

✓ エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。)  

 

Measurement results are output as [6DOF Analysis Result Files] 

Refer to エラー! 参照元が見つかりません。 (p. 7－55) for details. 

 
 

 

 The relationship between the 6DOF 

calculated values (𝑋, 𝑌, 𝑍, 𝜃roll, 𝜃pitch, 𝜃yaw) is 

shown in the figure to the right. 

When each axis is viewed from the + direction, 

the angle is calculated with the 

counterclockwise rotation as the positive 

rotation direction.  

Also, the coordinates are displaced from the 

top frame coordinates. 

 

 

 

0X+

0Z+

0Y+

0X-

0Z-

0Y-

rollθ+

pitchθ+

yawθ+
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7.6.1  6DOF Calculation Process 

[Construct 3D Measurement Data] must be completed to perform 6DOF calculations. 

Check to make sure construction of the 3D measurement data has been completed. 

 

The procedure is as follows. 

1. Select [Analysis] ⇒ [6DOF Analysis] on the menu to display the [6DOF Analysis 

Dialog].  

 
6DOF Analysis Menu 

 

 
           6DOF Analysis Dialog 

 

2. Set the input for the [6DOF Input Coordinate File] and the output for the [6DOF 

Analysis Results File]. 

Also, since a list of names of points is input to [6DOF Calculated Reference 

Points] with [6DOF Input Coordinate File], select a point to be the 6DOF 

calculation reference point.   

3. Click [OK] to export the 6DOF analysis results file. 

 

 

Select 6 DOF 

calculation 

reference points 

 

 [6 DOF Input Coordinate File] 

Input settings 

[エラー! 参照元が見つかりません。 

Output settings 
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7.6.2  6DOF Input Coordinates File 

Coordinate positions with markers on the measurement target are required for 6DOF 

calculations. Measure the separate marker positions and create a file. The 6DOF position 

and rotation is calculated with the coordinates of this file. 

The file format is as follows. Input numbers as integers. If the line heading is not a 

number, it is considered a comment and is disregarded. The input coordinate units are 

3D calibration units. 

 

      Measurement point ID, X coordinates, Y coordinates, Z coordinates 

 

 

 

 

 

 

 

Example of 6DOF input coordinate file. The 

markers on the measurement targets are 

noted on each line. 
 

 

1, 10, 10, 3, 

2, 20, 10, 3, 

3, 10, 20, 3, 

4, 20, 20, 3, 
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7.6.3  エラー! 参照元が見つかりません。 

The エラー! 参照元が見つかりません。 format is as follows. 

The coordinates and rotation (Roll/Pitch/Yaw) for the designated points are output for 

each time. They are separated by “；”. 

If the 6DOF calculations are for a time that is not possible, the following time data will 

be output for that line. 

 

 Time；  X； Y； Z； Roll； Pitch； Yaw 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example of a エラー! 参照元が見つかりません。 

 

The 6DOF calculation results for the top frame are fixed at 

0.000; 0.000; 0.000; 0.000; 0.000; 0.000; 0.000. 

 

Time:  

Units for times are fixed at “seconds”.  

 

X, Y, Z:  

Displacement from the top frame of the [6DOF Calculation Reference Point]. 

The coordinates are those from the [エラー! 参照元が見つかりません。]. 

The units are the units from calibration. 

 

Roll, Pitch, Yaw:  

The angle units are degrees. 

The range for Roll, Pitch, Yaw is as follows. 

 −180° < 𝜃roll ≤ 180°, −90° ≤ 𝜃pitch ≤ 90°, −180° < 𝜃yaw ≤ 180° 

 

  

 0.000; 0.000; 0.000; 0.000; 0.000; 0.000; 0.000 

 0.005; -0.050; -0.030; -0.074; -0.014; 0.053; -0.010 

 0.010; 0.476; 0.136; -0.085; -0.017; -0.043; 0.009 

 0.015; -0.102; 0.094; -0.034; 0.001; 0.010; 0.010 

 0.020; -0.113; -0.044; -0.104; -0.013; 0.053; -0.010 

              :  

        :  

 10.665; -0.003; 0.396; -0.019; -0.058; 0.008; 0.002 

 10.670; 0.028; 0.533; -0.003; -0.069; 0.003; 0.002 

 10.675; 0.039; 0.573; 0.001; -0.075; 0.003; 0.003 
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The final rotation is calculated as 𝑹 = 𝑹𝑥(𝜃roll)𝑹𝑦(𝜃pitch)𝑹𝑧(𝜃yaw). 

An example of each rotation is as follows. 
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8. Other Operations 

8.1  Export 

8.1.1  Export as CSV 

The currently active window data is exported in the CSV format. 

The data output varies according to the type of window. 

 

List of Tracking Data:  Tracking data・measurement point (quadrant) angle 

List of Measurement Data:  Measurement data coordinates 

List of Analysis Data:  Data values shown with analysis data 

List of Waveform Data:  Data values after setting the filters 

 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) for the CSV format. 

 

Perform any of the following to export data in the CSV format 

✓ Click [File] ⇒ [Export] ⇒ [Measurement Coordinate Data] on the menu. 

✓ In the tracking mode, click [Save Tracking Data As] ⇒ [CSV Format] on the 

right click menu in the measurement image window.  

✓ Click [Save Data in File Format] ⇒ [CSV Format] on the right click menu in 

the list of tracking data / measurement data / analysis data / waveform data.   

 

Detailed settings can be made when exporting CSV files. 

 

 
 

⚫ Detailed Settings 

When exporting in the CSV format, click detailed settings in the save file dialog to 

perform the following settings. 

 

Time Range for the Export Data 

Set the time range for the data to be exported. 

２D Calibration Parameters 

Check to export the 2D calibration parameters. 

Enabled while exporting the measurement data list. 

 

Select Measurement Points 

Click [Select Measurement Points] to display the [Select Measurement Points] 
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dialog. Use this dialog to select the measurement points to export.  

Comments 

Enter comments relating to the export data. 

 

8.1.2  Print 

Prints the currently displayed window. 

The print results vary by the type of window. 

 

Image Window:  Prints the current image displayed (also prints the 

superimposed items) 

Graph Window:  Prints the current graph 

List Window:  Prints the numerical data 

Stick:  Prints the current stick displayed 

 

Perform any of the following to print. 

✓ Click [Print Screen] on the right click menu of the image window. 

✓ Click [Print Graph] on the right click menu of the graph window. 

✓ Click [Print] on the right click menu of the list window. 

✓ Click [Print] on the right click menu of the stick window. 
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8.1.3  Export as AVI 

The [Export as AVI File] function exports the displayed window images to AVI files.  

Superimposed items (trajectories, sticks or annotations) are also exported. Zoomed or 

processed images are exported unchanged. 

Specify the [Compression Program] and [Resize] in the [Export AVI File Settings] dialog. 

If optical distortion correction is applied during AVI export of measurement images, the 

distortion corrected image can be exported.   

 

Refer to p. 8－4 for the AVI File Export Procedure and p. エラー! ブックマークが定義さ

れていません。 for the エラー! 参照元が見つかりません。. 

 

The export area is shown in the following figure. 

 

  
 

With the image window, the range of the image is exported to the AVI file. (parts not in 

the window are not exported). With the stick window, the entire window is exported. 

The size and aspect ratio of the AVI file standard to be exported is the size of the currently 

displayed image (inside the dotted lines in the figure above). 

 

 

Display image 
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⚫ AVI File Export Procedure 

The AVI file export procedure is as follows. 

 

① Access the AVI file export window (image・stick) and adjust the size. If an image, 

select the pixel size  for the エラー! 参照元が見つかりません。 to enable output 

of the entire image. We recommend AVI file export when the entire image area is 

displayed.  

 

② Designate the export range 

Set the playback range and designate the 

export range. 

 

③ [Export AVI File Settings] dialog 

To start an AVI export, perform any of the following to display the [Export AVI File 

Settings] dialog. 

✓ Click [File] ⇒ [Export] ⇒ [AVI File Format Window Image] on the menu. 

✓ Click [Export AVI File] on the right click menu in the measurement image 

window / stick window. 

 

Specify the file name and folder to be exported and designate the desired “resize” 

and “compression codec”.  

Refer to p. エラー! ブックマークが定義されていません。 for details of the エラー! 参

照元が見つかりません。 

 

Click OK  after setting the [Export AVI File Name] and the [Export AVI File] 

appears on the mode display bar at the top right, and the AVI export will 

automatically start.  

 

 

 

 

 

 

 

 

 

 

 

 

④ Once playback of the specified playback range 

is done, a message appears and the AVI file 

export processing ends. If paused during AVI 

file output, output will be only until the frame 

where paused. 

 

 

 

Finally, confirm the exported AVI file and make sure the image range and quality is as 

desired. 
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⚫ [Export AVI File Settings] Dialog 

Designates the name of the AVI file export in the [Export AVI File Settings] dialog. The 

[Compression Program] and [Resize] can be set. 

 
 [Output AVI File Settings] Dialog 

 
[Export AVI File Settings] Dialog (if optical distortion correction image is 

applied) 

ＯＫ 

Saves the settings and starts the AVI export. 

 

Export AVI File Name 

Input the path and file name for the AVI file to be exported. 

 

Compression Method and Compression Program・Compression Quality 

Compression settings. Specify the codec and the quality. 

Click [Details] to display the detailed settings dialog for the selected codec. 

Nothing will be displayed if the codec is not compatible with the detailed settings 

dialog. In this case, contact the codec manufacturer for questions relating to codec. 

Set the compression rate with the [Compression Quality] slider in [Compression 

Settings].  

MJPEG:  AVI compression using Motion JPEG. 

CODEC:  AVI compression with the codec selected under [Compression 

Programs].  

 

 

 

 

 

 

 

Resize 

Playback rate 

Compression settings 

Export 

file name 

Optical distortion 

correction image 

output settings 

Compression method 

Resize 

options 
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Playback Rate 

Specify the playback rate for the AVI export. Unrelated to the [Playback Rate] on the 

[Playback Settings Control Bar]. 

Select the playback rate from 1~30 frames/sec or annually input a number. 

 

Resize 

Designate the magnification of the AVI image size to be output. 

The following two types can be selected for [Resize]. 

Magnification 

 “1: 1”, “75％”, “50％”, “25％”, “125％”, “150％”, “175％”, “200％”  

Fixed Size 

 “640x480”, “480x360”, “320x240”  

 

With fixed size, the export is enlarged or reduced so it fits the specified size while 

keeping the aspect.  

 

Resize Options 

Export as is. (default)  

Export at the size specified in [Resize] (75％, 640x480 or such). 

Round to multiples of 4. 

After applying the resize settings, the frame size is rounded to multiples of 4. 

Make a border on the left/right sides or the top/bottom of the image so the image 

becomes that size and export to AVI.  

 

 The settings for “round to multiples of 4” use a codec required for sizes in multiples of 

4 so use for AVI file export. 

 

Some codecs may only handle certain sizes. 

Contact the codec manufacturer for any questions relating to codecs. 

 

Optical Distortion Correction Settings 

Used when distortion correction is applied to measurement images. When checked, 

the image exported reflects the distortion correction. If not, the standard image is 

exported. If there is an AVI export with distortion correction, the items superimposed 

on the image are only measurement points, trajectories and sticks.   
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⚫ Example of Export AVI File Settings 

This shows an example of AVI export. 

For example, AVI exports according to the following image window. 

Image Frame Size 464x464 

Image preprocessing None 

Zoom rate 121％ 

Displayed image size 561x561 

The following settings can be made in the [Export AVI File Settings] dialog. 

 

Resize 

１． If “1: 1”, then 

the export AVI size: 561x561 

Image is exported at “identical to the displayed image”. 

２． If “640x480”, then 

the export AVI size: 640x480 (image area size480x480)  

Exported image is centered with “displayed image is enlarged to a 480x480 

image” and then exported.  

 (the image area size is the size when the displayed image is fit to 640x480. 

With an image that has a layout that is landscape, it may be fit to the 

landscape size.)  

３． If “75％”, then 

the export AVI size: 420x420 

Image is exported as an “displayed image is shrunk to a 0.75x image”. 

 

Codec 

Codec attempts to create a file with the [export size] that reflects the results of the 

abovementioned resize. 

You will get an error if the size is not compatible with the codec used 

For example, if using “IndeoR video 5.1”, the width and height must be sized in 

multiples of 4. In the example above, the “1: 1” size is an incorrect size and the export 

will fail. 

Exports can be made with the “1: 1” size by applying [Round to multiples of 4] in the 

[Resize Options]. 
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8.1.4  Save to Image File 

Exports the window image currently displayed to a file. Select an image format from 

BMP, JPEG, PNG, and TIF.  

 

Image Window:  Exports the currently displayed image to a file. 

Graph Window:  Exports the current display to a file. 

Stick Window:  Exports the current display to a file. 

 

Perform any of the following to save the window image to a file. 

✓ Click [Copy to Image File] in the right click menu of the image window.  

✓ Click [Copy to Image File] in the right click menu of the graph window. 

✓ Click [Copy to Image File] in the right click menu of the stick window. 

 

The Save As dialog appears so assign a file name to save. 

 

During JPEG output, the image quality settings can be made. Set the image quality in 

a range from 0~100. The image quality drops as the value decreases, but the file size also 

decreases. The image quality improves as the value increases, but the file size also 

increases. The default value is 90. 

 

 
 

8.1.5  Merged Export 

This is a function to merge window exports from multiple windows. 

Images, graphs and sticks can be combined and exported as AVI exports or still images. 

For example, export images and graphs as synchronized video or multiple graphs as 

AVI exports. 

 

      

Graph 

Image 

Stick 

AVI output 

Still image output 

Combination 

settings 
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Perform the following to display the export window and enable merged exports. 

 

✓ Click [File] ⇒ [Export] ⇒ [Merged Export].  

 

The [Merged Export Settings] dialog appears. 

 

Layout 

Combined layout. Select from 6 types. 

 

Export 

Select AVI or still image for the export 

format. 

 

AVI Export Time Range (Start・End)  

Specify the AVI export time range. 

The default sets the playback range on 

the playback slider bar when the dialog is 

displayed. 

 

Background Color 

Specify the background color (color of the 

area where the image is now shown). 

 

Export Size 

Select the export size. 

Available sizes include “640x480”, 

“1280x1024”, or “sum of window size” (p. 

エラー! ブックマークが定義されていませ

ん。). 

 

Preview 

Drag the window to this area to see a 

preview of the contents of the window. 

Display of the part previewed can be 

switched according to the selected layout.   

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 8－11 

⚫ Merged Export Procedure 

① Specify the layout, export format and export size. 

Specify the export time range when AVI is selected as the export format. 

② Drag the window to export to inside the dialog preview window. 

③ Click OK to export. 

 

 
 

After clicking OK, the following appears according to the export format (AVI, still image). 

 

✓ If AVI is selected for exports, the [Export AVI File Settings] dialog appears. 

Refer to p. 8－4 for the AVI export procedure and p. エラー! ブックマークが定

義されていません。 for details on the [Export AVI File Settings] dialog. 

 
After finishing the AVI export settings, click the set button. The video for the 

export window is sequentially exported. 

 

✓ If still image is selected as the export, the [Save As] dialog appears. 

Refer to エラー! 参照元が見つかりません。エラー! 参照元が見つかりません。 

(p. エラー! ブックマークが定義されていません。) for details. 

Set the layout, output format, size and 

AVI output time range. 

Drag window 

Finish the window layout and 

click OK. 

① 

② 

③ 
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⚫ Sum of Window Size 

Exports the sizes necessary to arrange all of the windows in specific positions.  
 

If the layout to the right, exports as 

Width: 350 (= 200 + 150 > 320) 

Height: 400 (= 100 + 300 > 200 + 100) 

 

 

 

 

 

 

 

 

 

 

 

⚫ Aspect Ratio for Each Window after Export 

The image window・stick window are resized and merged to the export size that keeps 

the aspect ratio. The graph window does not save the aspect ratio and is fit to the export 

size. 
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8.1.6  Export Graphs to Excel 

Exports analysis graphs in projects to Excel. 

エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 

Analysis graphs are exported to Excel. 

エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。. Save settings for 

calculation formulas repeated for analysis graph data to Excel that will save time 

for the user during analysis. Add specific processing to an Excel spreadsheet 

output in (a) so MOVIAS Neo can be repeatedly utilized 

エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 

Exports analysis graph data to the Excel template created in エラー! 参照元が見つ

かりません。. 

 

(a) Batch export of graphs to Excel 

Perform the following. 

 

1. Show the analysis graph to export to Excel.  

 

2. Perform either of the following to show the [New Excel Book] tab in the [Excel 

Export] dialog.  

✓ Select [File] → [Export] → [Batch Export Graphs to Excel] from the main 

menu.  

✓ Click the エラー! 参照元が見つかりません。 ( ) on the エラー! 参照元が見つか

りません。. 

 

 
 [New Excel Book] Tab 
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3. All the analysis graphs are shown in the [List of Graphs Not Registered]. Select 

the graph in the [List of Graphs Not Registered] and click [Add] to add the graph 

exported to Excel to the [Export List] from the [List of Graphs Not Registered].  

In this example, [Graph of Angles] is exported to [Sheet 1] and [Graph of X 

Coordinates] is exported to [Sheet 2].   

 
 

4. After adding the graphs that require export, click [Export].  

The save dialog appears so assign a name to the Excel spreadsheet and save it. 

Excel starts, and the Excel spreadsheet created will automatically open.  

 

 

(b) Create an Excel Template 

Perform the following. 

 

1. Create an Excel spreadsheet based on the [Excel Template] file. 

In this example, use [Batch Export Graphs to Excel] to create an Excel 

spreadsheet called [Test Book.xls] and edit it as an [Excel Template].  

 

2. Excel spreadsheets from [Batch Export Graphs to Excel] are opened in Excel. 

 

 
Add new individual user calculations and sheets showing graphs. 

In this example, the Excel spreadsheet called [Analysis Spreadsheet] is added. 

 

 
Add individual calculations to the analysis spreadsheet added. 

In this example, the X coordinate average, standard deviation and angle average, 

and standard deviation are calculated. After editing the analysis spreadsheets, 

save to a file and close Excel. 
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3. Perform any of the following to show the [Register / Edit Templates] tab in the 

[Excel Export] dialog. 

 

✓ Select [File] → [Export] → [Batch Export of Graphs to Excel] from the main 

menu. The [Excel Export] dialog will appear, so select the [Register / Edit 

Template] tab. 

✓ Click the エラー! 参照元が見つかりません。 ( ) on the エラー! 参照元が見つか

りません。.  The [Excel Export] dialog will appear and the [Register / Edit 

Template] tab will be displayed. 

✓ Select [File] → [Export] → [Batch Export of Graphs to Excel] from the main 

menu. The [Excel Export] dialog will appear, so select the [Register / Edit 

Template] tab. 

✓ Click the エラー! 参照元が見つかりません。 ( ) on the エラー! 参照元が見つか

りません。 . The [Excel Export] dialog will appear and the [Register / Edit 

Template] tab will be displayed. 

 

 
[Register / Edit Template] Tab 

 

 

Template 

Select 

List 

Regist 

Unregist 

Direct Edit 

Comment 

List of data 
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4. Click [Register] and the file selection dialog appears so the previously created 

Excel spreadsheet is registered as the [Excel Template]. 

In this example, [Test Book.xls] is registered.  

 

         
 

5. A list of Excel spreadsheet templates appears in the [Select Data Spreadsheet] so 

uncheck the spreadsheets not previously exported.  

In this example, [Analysis Spreadsheet] is an individual calculation spreadsheet so 

uncheck to avoid its export. 

 

 
If necessary, enter comments. When comments are exported to an Excel template, 

they are displayed when that template is selected. 

Uncheck “Analysis” Sheet 
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(c) Export Graph to an Excel Template 

Perform the following. 

 

1. Display the analysis graph to export to the Excel template. 

 

2. The [Excel Export] dialog appears and then the [Export Excel Template] tab is 

displayed.  

 

✓ Select [File] → [Export] → [Batch Export of Graphs to Excel] from the main 

menu 

✓ Click the エラー! 参照元が見つかりません。 ( ) on the エラー! 参照元が見つか

りません。. 

 

 
 [Excel Template] Tab 

 
All the displayed analysis graphs are shown in the [List of Graphs Not Registered]. 

 

3. Select the template to be exported with the [Select Template] combination box. 

 

 

Template 

Select 

Combo Box 

Output 

Destination 

List 

Template 

Comment 

Unregist 

Graph 

List 

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 8－18 

4. Add the graph to be exported to the Excel template using [Export List] from the 

[List of Graphs Not Registered]. Select a spreadsheet from the [Export List] and 

select a graph from the [List of Graphs Not Registered] the click [Add].   

In this example, the [X Coordinate Graph_02] is added to the [X Coordinate 

Spreadsheet] and the [Angle Graph_02] is added to the [Angle Spreadsheet]. 

 

 
 

 

5. After adding the graphs requiring export to the export list, click [Export].  

 

 
 

 

6. The Save dialog appears so assign a name to the Excel spreadsheet and save. 

Excel will start, and the Excel file created will automatically open. 

 

 
 

 

If using the Excel VBA macro function, Excel can perform advanced processing. After 

exporting the data to the Excel spreadsheet, MOVIAS summons a procedure called 

MoviasStart(), which is used when performing automatic processing after exporting.  

 

 

Data calculated for the analysis data of the graph added 
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8.2  Import 

External images and waveform files can be imported to current analysis projects. Display, 

playback, and synchronized playback is possible with imported data. A filter can be 

applied to waveform data. 

 

 
Overview of Import 

 

 
Project Tree after an Import 

 

 

Waveform data (graph) 

Imported image 

Waveform data node 

Imported image node 
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8.2.1  Add Images 

Imports images to projects. 

Perform any of the following to import images. 

✓ Click Add Images  on the エラー! 参照元が見つかりません。 on the エラー! 

参照元が見つかりません。. 

✓ Click [File] ⇒ [Import] ⇒ [Reference Image] on the menu. 

✓ Click [Add Image File] on the right click menu of the primitive node.  

 

Each operation is performed from the following locations in the figures. 

 

 

 
 

 

 

 

 

The [Import Image] dialog appears. 

The contents shown and method of operation are identical to that in the [Create 2D 

Analysis Project] dialog (p. エラー! ブックマークが定義されていません。). 

 
 [Import Image] Dialog 

 

  

Add from the right click menu of the project node 

Add from import tool bar 

Add from menu 
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After adding, the external image node is added to the 

project tree. [External-**] is added to the top of the node 

name.  (** is a consecutive number)  

 

 

 

 

 

 

 

 

 

 

Imported images can only be displayed, played, and sync played. Analysis processing 

such as tracking, and calibration cannot be performed. 

 

 

Deletion of imported images is performed using 

[Delete] on the right click menu of the external image 

node.  

 

External image node added 
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8.2.2  Add Waveforms 

Imports waveform data files into projects. Imported waveform data is displayed on a 

graph or a list. 

 

The supported waveform data file formats include CSV graph data (*.csv), Library Wave 

File (*.WVB) and Nac Wave File (*.nwf) 

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) or エラー! 参照元が見つかりません。 エラー! 

参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。) for details 

on CSV graph data. 

 

Perform any of the following to import waveform data. 

 

✓ Click on the エラー! 参照元が見つかりません。  on the エラー! 参照元が見つ

かりません。. 

✓ Click [File] → [Import] → [Analog Waveform Data] on the menu.  

✓ Click [Add Analog Waveform] on the right click menu of the primitive node 

 

 Each operation is performed from the following locations in the figures. 

 

 

 
 

 

 

If selecting a CSV file as the waveform data file to add, all the data is imported. If 

selecting analog waveform data “Library Wave File (*.WVB)” or “Nac Wave File (*.nwf) ”, 

the import method can be specified. 

Once the import of the waveform data file has been completed, the graph appears. 

 

Add from import tool bar 

Add from the right click menu of the project node 

Add from menu 

Added waveform data node 
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⚫ CSV Graph Data 

Loads the CSV graph data. (Ignores the line type, display range)  

Refer to エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 (p. エラ

ー! ブックマークが定義されていません。) or エラー! 参照元が見つかりません。 エラー! 

参照元が見つかりません。 (p. エラー! ブックマークが定義されていません。) for details. 

 

⚫ Analog Waveform Data 

Loads the analog waveform data files created with Wave-in (Image, waveform sync 

display software manufactured by Library, Inc.) or analog waveform data files created in 

the MEMRECAM waveform input software or the fxLink waveform input software. The 

data range and units can be set when importing. 

 

 
Import Analog Waveform Data Dialog (Simplified Setting) 

 

Affiliation with the Image 

Select the analog waveform data to be imported and the camera affiliated with it. 

 

Import Range 

Select the range of the affiliated image or the entire range of measured data (entire 

range of analog waveform data). 

 

Data Units 

Select from [Measured Voltage (raw data)] or [Physical Quantity (converted data)]. 

Cannot be selected if there aren’t any parameters for converting physical quantities 

into analog waveform data. Treated as measured voltage. 

 

Draw Graph 

Select from [Each Channel on a Separate Graph] or [All Channels on a Single Graph]. 

[Each Channel on a Separate Graph] 

Plots the data for multiple channels input on separate graphs. (For example, 3 

graph windows are created from data measured on 3 channels.) 

[All Channels on a Single Graph] 

Plots the data from each channel together on a single graph window. If selections 

were made in [Select Series] in the detailed dialog, only the selected series are 

imported. 
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Units Used in the Graphs 

Select the units for displaying graphs. 

✓ Voltage 

Setting for the vertical axis units. 

Select either V or mV. If selecting physical quantities in [Data Units], it is 

treated as V. 

✓ Time 

Select the units for time for the waveform data. 

Select from sec, msec orμsec.  

 

Detailed Settings 

Displays the import analog waveform data dialog (detailed settings). 

Sets the details for the import method for the analog waveform data. 

 

 
Import Analog Waveform Data Dialog (Details)  

 

Set the import range with the [Time Range of Analog Data to Import]. 

If [Link Import Range to the Target Range of the Sequence] is enabled, use the camera 

data values and set the import range for the analog waveform data. 

Even if the image file [ROI (Analysis Range)] is changed, the measurement image 

playback range is not affected. Set only the import range for the analog waveform data.)  

Switch the checked part of [Series Selection] to select the series to load. Switch the 

checked part of [Draw Graph] to select whether to draw all channels on a single graph. 

 

Image file settings 

Import range settings 

Graph display settings 

Settings for when loading waveforms 
Series selection 

Draw Graph 
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Deletion of waveform data is performed by clicking 

[Delete] on the right click menu of the waveform data 

node. 

 

 

 

 

 

 

 

 

⚫ Filter Settings 

Sets the filter for each channel used for waveform 

input. To set the filter, click [Filter Settings] on the 

right click menu of the channel shown on the graph 

(figure to the right).  

 

 

 

 

 

Select [Type] from the [Filter Parameter 

Settings] dialog and set the parameters for 

each filter. The filter effect can be checked right 

after the parameters are changed.  

Click [Completed] to apply the current filter 

and close the dialog.  

 

 

 

 

 

Automatically reflected 
Checked 

Input camera time interval 
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⚫ Properties 

Edit the waveform data display settings. 

Select [Property] on the right click menu to show the [Import 

Analog Waveform Data] dialog.  

 

 

 
 

Double click on [Name], [View], [Vertical Axis] and [Color] on the series list to manually 

edit. The data on the horizontal axis cannot be changed. 

Also, add, delete, and change the series with the [Add], [Delete], and [Change] buttons. 

 

Add 

Adds the series set in the series editing section to the list of series. 

 

Delete 

Deletes the series data selected in the list of series. 

 

Change 

Changes the series data selected in the list of series to the contents set in the series 

editing section. 

 

 

Select All 

Turns [View] ON for all the series in the list of series.  

 

Cancel All 

Turns [View] OFF for all the series in the list of series. 

 

 

 

 

 

Add, Delete, Change 

Total number of series 

Select all 

Cancel all 

Edit series 

Series list 
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8.3  Correction of T0 Frames (Time Starting Point) 

If the measurement image window or the waveform graph is displayed, the displayed 

frame can be set as the T0 frame (time starting point). 

To correct the T0 frame (time starting point), click [Playback] ⇒ [Time Starting Point 

Setting] from the menu. 

Changes cannot be made to the original file during T0 frame correction. 

 

 

Access the camera image for the T0 frame (time starting 

point) to be corrected. 

 

 

 

 

 

 

 

 

 

Move to the desired frame. 

 

 

 

 

 

 

 

 

 

Click [Playback] ⇒ [Time Starting Point Settings] on the 

menu.  

 

 

 

 

 

 

 

 

 

 

 

This finishes the corrections to the T0 frame (time starting 

point).  

 

After corrections to the T0 frame (time starting point) are 

finished, the construction processing is automatically 

performed on the 2D analysis project. 

For 3D analysis projects, manually perform エラー! 参照元

が見つかりません。 (p. エラー! ブックマークが定義されて

いません。) again. 
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8.4   Window List 

The window list displays the name and type of the window currently displayed. 

Click “Window” → “Window List” on the menu to display the window list. 

 
Window List 

 

Perform either of the following to activate the selected window. 

✓ Double click a window on the list to display. 

✓ Click [OK] when the selected window is displayed. 

8.5  Project Information 

Makes the settings for the current project file. Changes are made for each project. 

 

Click [File] → [Project Information] on the menu to display the project information. 

 

⚫ [General] Tab 

 

Type of Project 

Shows the type of the current project. 

 

Project Name 

Shows the name of the current project. 

Refer to エラー! 参照元が見つかりません。エ

ラー! 参照元が見つかりません。 (p. エラー! ブ

ックマークが定義されていません。) for 

details on changing the project name. 

 

Test Number 

Input the test number. 

 

Directory 

Shows the folder where the current project 

file is saved. 

 

Comments 

Input comments related to the project. 
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⚫ [Image] Tab 

Verify and change the calibration method under the [Image] tab。 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for a description of the calibration methods. 

 

Calibration Used 

Shows the calibration method currently 

used. 

 

Calibration Method 

Select 3D DLT or MDLT for a 3D analysis 

project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

⚫  [Output] Tab 

Sets the units and number of decimal places used for display and CSV export. 

 

 

Units of Length 

Select from “m”, “cm”, “mm”, “um” for 

units used for length. 

Units of Time 

Select from “sec”, “msec”, “usec” for units 

used for time. Refer to エラー! 参照元が見

つかりません。(p. エラー! ブックマークが

定義されていません。)for details on time 

units. 

Set the number of decimal places to 

display. Set in a range from “1～16”. The 

default is “3”. 

Unit of Angle 

Select from “Degree”, “Radian”, and select 

from “+/-180”, “0-360” for units used for 

angle. 

Select from “XYZ”, “XZY”, “YXZ”, “YZX”, 

“ZXY”, “ZYX” for euler angles. 

 

 

 

Top: 2D analysis project 

Bottom: 3D analysis project 
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8.6  Environment Settings 

Application settings for MOVIAS Neo. Changes are made to the application. Click [File] 

→ [Environment Settings] on the menu to display the environment settings. 

 

⚫ [Folder] Tab 

Sets the folder first referenced when selecting a file or folder. Select the folder settings 

with the [Browse] button. Manual input is acceptable. 

 

 

Project Directory 

Folder where the project data is saved. 

Project Template File 

Folder where the project template file 

is saved. 

Import Data From 

Folder first opened when importing 

image data or waveform data. 

 

Export Data To 

Folder first opened when exporting. 

 

Calibration Data 

Folder first opened when importing・

saving calibration data. 

 

⚫ [Tracking] Tab 

 

① Check to track in the reverse direction 

once tracking in one direction is done. 

Can also be set using the tracking 

properties dialog. 

 

② Check to continue auto tracking if 

there is a failure in auto tracking. Can 

also be set using the tracking 

properties dialog. 

 

③ Check to enable tracking when 

measurement points are newly added.  

 

④ Reset all of the default measurement 

point parameters saved. Does not 

change the tracked data. 

 

 

 

 

① 

② 

④ 

③ 
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⚫ [Reconstruction Setting] Tab 

 

① Check to automatically construction 

measurement data during 3D 

analysis once the tracking and 

calibration is done. Generally, 

automatically constructed during 2D 

analysis. 

 

② Check to display the frame 

information where construction failed 

when constructing data.  Not shown 

if all frames are successful. Used for 

both 2D analysis and 3D analysis. 

 

③ Confirm when the mode is finished. 

Used for both 2D analysis and 3D 

analysis. 

 

Confirm [Update] or [Cancel] the 

Results 
Displays a confirmation message to 

save results that were changed when 

an operation mode has finished, such 

as the tracking mode or real scale 

conversion. 

Select either save changes or revert 

to the previous state and cancel the 

changes. 

 

Save the Results without Confirming 

(handled by an operator.)  
Do nothing when the mode is done. 

Saves the project at the operator’s 

discretion.  

 

④ Check to enable automatic update 

settings for graphs. 

 

 

① 
② 

③ 

④ 
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⚫ [Playback Setting] Tab 

 Check to use the playback rate saved 

for the image. 

 

 Designates the default playback rate. 

Used for graph playback or when 

playback of the image file in ① 

“cannot be used”. 

 

 

 

 

 

① 
② 
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⚫ [Conversion Algorithm Setting] Tab 

Settings for MCFF file playback・conversion settings and AVI file playback.   

 

Conversion Algorithm 

Select the MCFF file playback and 

conversion method. 

Method B (Default)  

Default playback and conversion 

method. Playback and conversion 

performed with the software (CPU). 

 

Method C (PCI High Speed Conversion 

Board)  

Method using the optional PCI image 

conversion board. 

 

Method D (GPU)  

Method using the graphic board 

equipped with a GPU that is 

compatible with the optional [MCFF 

high-speed conversion software].  

High speed playback・conversion of 

MCFF files. 

 

AVI Decode Settings 

Performs playback settings for AVI files. 

Switch Automatically 

Initially tries to perform AVI 

playback using [DirectShow]. If that 

fails, AVI playback is attempted 

using [Video for Windows].  

The default is [Switch 

Automatically]. 

 

Use DirectShow 

AVI playback using [DirectShow]. 

This is the playback method before 

MOVIAS Neo Ver2.10. 

 

Use Video for Windows 

Performs AVI playback using our 

common components.  
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⚫ [Graph Setting] Tab 

Designates the style when creating graphs. Applied to newly added [Analysis Graphs] 

and [Create Graph] dialog 

(a) [Background] Tab 

Performs background settings for graphs. To change 

individually after a graph is created, go to [Background 

Settings] on the right click menu of the graph window. 

 

 

 

 

 

 

 

(b) [Font] Tab 

Sets the graph font. To change individually after a graph 

is created, go to [Detailed Settings] on the right click 

menu in the graph window. 

 

 

 

 

 

 

 

(c)  [Component Name] Tab 

Select the series name when creating an analysis graph 

in the Create Graph dialog. 

 

The series name selected is as shown in the table below. 

 

 

 

 

 

 
Selection Example of Series Name for the 

Graph Created under the General 

Tab 

Examples of Series Name for the 

Graph Created under the Length, 

Angle and Area Tabs 
All Graph 1: Point1: X position Graph 1: Length: Lz 
Measurement Point 

Name 
Point1 Length 

Measurement Point 

Name + Physical 

Quantity 

Point1: position Length 

Measurement Point 

Name＋Component＋

Physical Quantity 

Point1: X position Length: Lz 

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 8－37 

8.7  Annotation Function (Draw Figures, Superimpose Analysis 
Results)  

Function to draw figures on the measurement image and superimpose analysis results 

on the image. 

 

Superimposing the analysis results makes it possible to visually verify the area and 

angle on the measurement image. Also, it can be used as a tool to enhance the display 

by emphasizing the tracking shown by drawing the measurement points as a figure. 

 
The figure on the measurement image is exported as shown when exporting to print, AVI 

output, clipboard, image file. 

 

 
 

 

 
 

 

The following functions are also available. 

✓ Show a figure of the tracked measurement points 

✓ Rotate the figure to match with the rotation of the quadrant (only with a group 

of lines) 

✓ Export coordinates (only with a group of lines)  

✓ Reuse already completed figures in other projects  

Example of Superimposing Analysis Results 

Draw  

・Rectangle  

・Oval  

・Groups of lines  

・Text  

・Image 

Example of Figures to Draw 

Superimpose analysis 

results numerically 

Draw area, angle, length 
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8.7.1  Show Analysis Results  

Superimposed display of the figure of the analysis results on the image and 

superimposed display of the numerical values. 

 

Select [Select Diagram to Show] from the right click menu on the measurement image. 

The [Analysis Option] tab in the [Select Display] dialog appears. 

A list of the analysis results that can be displayed in the project is shown under the 

[Analysis Option] tab. Checked items are superimposed on the image. 

 

 
[Analysis Option Tab] in the [Select Display Dialog] 

 

 
 

Some items created with analysis option cannot be edited. 

 

Click [Select Diagram to Display] from the right click menu on the measurement image 

to display the Select Diagram to Display dialog. Use this dialog to select the analysis 

results to superimpose. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for details. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。), エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for the properties used for superimposing the analysis. 

Example of 

numerical 

display 

Example of area 

diagram  

List of analysis results 

shown  

 

(Value) indicates numerical 

display of analysis results. 

  

(Diagram) refers to a 

diagram of the analysis 

results. 
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8.7.2  Draw Figures 

Draw a figure on the measurement image. Figures that can be drawn include rectangles, 

ovals, straight lines, text and images.  

Perform either of the following to draw figures. 

 

✓ Select [Add Rectangle], [Add Oval], [Add Lines], and [Add Text] from [Tool] on 

the menu. 

✓ Select any icon  on the figures toolbar on the エラー! 参照元が

見つかりません。. 

 

Rectangle・Oval  

Drag to make a rectangle and the figure is drawn inside the rectangle. 

Lines  

Input lines by dragging. Then, each click will input a connecting line. Double 

click to stop drawing lines and finish line input. 

Text  

Drag to make a rectangle and display the text input dialog. Then enter the 

text and click OK. 

Image 

After drawing a rectangle, load an image from the figure properties.  

 

Refer to エラー! 参照元が見つかりません。] Tabs (p. エラー! ブックマークが定義されて

いません。) for details. 

 

8.7.3  Using Figures  

Click on [Select] from [Tool] on the menu or select  on the figure’s toolbar on the 

main control bar, then click a figure to show the status of the figure selected.  

 

In the selection status, delete, reorder sequence, move, resize, and rotate can be applied 

to the figures. Delete, Move, Resize, Rotate is not possible in figures for the analysis 

results (length, angle, area). The text in analysis results can be moved. 

 

While in the selection status, double click inside a figure to show the [Figure Properties] 

dialog. 

Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定義されていませ

ん。) for details on the [Figure Properties] dialog. 
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⚫ Using Figures with the Right Click Menu 

Right click from the figure selection status and the following menu appears. 

 

Figure Properties  

  Shows the Figure Properties dialog. 

Refer to エラー! 参照元が見つかりません。 (p. 

エラー! ブックマークが定義されていません。) 

for details. 

Sequence 

Changes the sequence for drawing the figures. 

Select from “Move to Front”, “Send to Back”, 

“Move Forward” or “Move Back”.   

Delete 

Delete the figure. 

Edit the Peak (only with a group of lines) 

Add and delete the peaks. 

 

⚫ Move, Resize, or Rotate Figures 

Drag to rotate. With a group of line segments, the 

target angle can rotate with “Not Rot”. 

 

Drag the green rectangle to resize. 

 

Drag inside the figure to move. 

 

 

The figure can be moved, resized, and rotated 

from Figure Properties. For details, refer to the 

エラー! 参照元が見つかりません。 (p. エラー! ブ

ックマークが定義されていません。). 

 

 

⚫ Undo and Redo 

Click [Undo] from [Tool] on the menu to undo the operation on the figure. Click 

[Redo] from [Tool] on the menu to start again. 
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8.7.4  Switch between Show, Hide Figures 

Switch between show/hide all of the figures or switch them individually. 

Select the following items from the right click menu on the measurement image.  

 

 

Show Figure  

Switch between show, hide all of the 

figures displayed. 

 

Select Diagram to Show 

Set each figure to show・hide. 

Refer to the エラー! 参照元が見つかりませ

ん。 (p. エラー! ブックマークが定義されて

いません。) for details. 

 

 

 

 

 

8.7.5  Select Diagram to Show Dialog 

Click [Select Diagram to Show] from the right click menu on the measurement image to 

display the [Select Diagram to Show] dialog. Select show or hide for the figure and the 

analysis results.  

    
  [Diagram Option] Tab [Analysis Option] Tab 

A list of the figures created appears on the list under the [Select Figure] tab. Switch 

between show and hide. 

A list of analysis data or virtual points and center of gravity that can be displayed in the 

project is shown in the list under the [Select Analysis] tab. The virtual point and center 

of gravity figures can only be displayed in 2D analysis projects. 

“(Figure)” shows the analysis data superimposed on the image. Select the length, angle, 

area or virtual point and center of gravity. “(Numerical Values)” shows the numerical 

values for the analysis data or the coordinates for the virtual point and center of gravity. 

Use [Load Settings] under the [Select Figures] tab to position the saved figure on the 

measurement image. The figure selected from the list with [Save Settings] is saved to 

the file.   

 

 

Shows a list of the 

analysis results that can 

be displayed. The figure 

and the numerical values 

can be selected. 

Shows a list of 

diagram created. 
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8.7.6  Figures Properties 

Make all types of settings for the figures. 

 

Click [Figure Properties] in the right click menu of the figure selected or double click 

inside the area of the figure to show the [Figure Properties] dialog. 

 

(a)  [Name and Color] Tabs 

This item displays the rectangle, oval, line, and text properties. 

 

Name 

Set the name of the figure. 

Color 

Set the color of the figure. 

Transparency 

Sets the transparency of the fill 

color.  

(0-100%) 

Image 

Shows the properties of the 

rectangle. Shows the image on the 

currently drawn rectangle. Select 

enable, disable display or keep, and 

change the aspect ratio.  

 

 

Line Width 

Shows the properties of the line 

segments.  

Set the thickness of the line 

segments. 
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(b)  [Position and Size] Tabs 

This item shows the properties for the rectangle, oval, and text. 

 

Position X, Y 

Set the center position of the figure. 

Height, Width 

Set the height or width. 

Rotation Angle 

Displayed for rectangles and ovals. 

Set the rotation angle for the figure.  

Destination 

Draws the figure matching the 

position of the selected 

measurement points. Select fixed to 

fix the position of the figure. 

 

 

(c)  [Peak Position] Tab 

This item displays the properties for the group of lines.  

 

Peak Position 

Set the peak position. Select the 

peak and input values for X and Y. 

The peak position, destination, and 

corresponding angle are not set in 

the figure properties for the analysis 

results. 

Close Figure 

Check to close the line segment 

group (connect the starting point 

with the ending point). 

Fill 

Once a figure is closed, fills in with 

the color set in [Name and Color]. 

Destination 

Draws the figure matching the 

position of the selected 

measurement points. Select fixed to 

fix the position of the figure. The 

peak position, destination, and 

corresponding angle are not set in 

the figure properties for the analysis 

results. 

Corresponding Angle 

Sets the angle of the point at the 

[Destination]. 

Set no rotation (“Not Rot”), 

quadrant angle (“Quadrant Angle”) 

or group rotation angle (“GroupA” 

etc). 
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(d)  [Export Coordinates] Tab 

This item displays the properties for the group of lines. Coordinate export calculations 

are performed at the same time as the calculations for 2D calibration. If using this 

function to export coordinates, set the export coordinates and then click calibrate to 

display the dialog. There is no need to make these settings again. 

 

Export Peak Position as Coordinate 

Data 

Check to export the coordinates for 

the peak position selected with the 

export coordinates combination box.  

Export Coordinates 

Export the data on the peak position 

for the group of lines or the 

minimum or maximum values for X 

and the minimum or maximum 

values for Y. Determination of the 

maximum or minimum uses the 

coordinate system after 2D 

calibration. 

 

 

 

 

(e)  [Text] Tab 

This item displays the properties for the text. 

 

Text 

Input the text to display. Text, 

height, and width cannot be set in 

the text properties for the analysis 

results. 

 

Format 

Set the font. 
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8.7.7  Analysis Using the Annotation Function 

The annotation function can be used to perform analysis on measurement points that 

cannot be tracked by using a coordinate export function for groups of lines. 

 

The procedure is as follows. 

(a)  

(b) エラー! 参照元が見つかりません。 

(c) エラー! 参照元が見つかりません。 

(d) エラー! 参照元が見つかりません。 

(e) エラー! 参照元が見つかりません。 

 

The following example tracks a video file for crash tests. 

Tracking is performed on the head of the dummy. As shown in the video on the right, the 

head is hidden and cannot be tracked. 

Tracking is performed using the annotation coordinate export function. 

 

   
 

 

 

 

 

 

(a) Tracking 

Tracks standard measurement points. Track either 

quadrants or track groups to track angles. In the 

figure to the right, the quadrants are tracked 

because the angles need to be tracked.  

 

 

 

 

 

Add 

quadrants 

On-board dummy 

Tracks the outline of the 

head 

Video at the instant of the crash 

Since the dummy has leaned 

forward, part of the head is 

hidden and cannot be tracked 
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(b) Add Annotation 

Create a figure by drawing an outline around the tracked 

measurement points. Either add a new figure or load a 

saved one. 

 

Adjust the figure to match by using resize or rotate on 

the image. 

 

The figure to the right is an example where the head of the dummy is outlined. 

 

(c) Link Tracking Points and Angles for Annotation 

Set the properties of the drawn annotation. 

Set the movement tracked in “(a)” as the [destination] and the angle at “Point0” as the 

[quadrant angle]. Thus, the annotation tracks the movement of the dummy’s head during 

playback. 

After linking, the group of lines cannot be rotated so adjust the shape of the figure before 

linking. 

 
 

(d) Export Settings 

 Setting to export the coordinates for the annotation set in “(c)”. 

 Select the peak exported from the coordinate export tab and click OK. 

With this annotation, the figure below shows peak coordinates set to the maximum X 

value for export. 

 
 

 

Add line segments 

to make an outline 

Check to enable 

Select peak to export 

Tracked movement settings.  

Destination :  Point0 

Corresponding angle:  

Quadrant 
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(e) Calibration 

Calibrates and creates measurement data. 

After calibration, if the annotation export coordinates are set, perform calibration again. 

Performs calculations only to close the open real scale (or perspective) conversion dialog. 

 
2D Calibration 

Set the starting point as Point2, with the X axis direction Point2 to Point1 

 

(f) Check Measurement Data 

Displays the list from the current project on the project tree. Check that the peak 

coordinates for the maximum X value have already been exported to the list 

 

 
 

In this example, only one point is exported but there can be one point exported for each 

line. 

Add multiple lines to export multiple peaks. 

  

Exported coordinates added to 

measurement data. 

X axis direction 

Point2 

(starting point) 

Point1 
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9. MOVIAS Neo Viewer 
MOVIAS Neo Viewer opens projects created in MOVIAS Neo and displays the analysis 

results, including the videos and graphs already created. 

 

 
 

Since this is a dedicated viewer, it cannot create new tracking points or new graphs. 

It operates even without a MOVIAS license key. Additionally, results analyzed with 

MOVIAS Neo can be displayed on other PCs. 

 

MOVIAS Neo Viewer functions are as follows. 

 MOVIAS Neo Viewer presents data analyzed with MOVIAS Neo on other PCs 

so it can be distributed to other researchers.  

 Since a MOVIAS license key is not required, any PC that satisfies the necessary 

operating environment (p. エラー! ブックマークが定義されていません。) can 

display analysis results from MOVIAS Neo. 

 Images and graphs can be viewed but not edited. 

 The method of operation is identical to that used for MOVIAS Neo. 
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10. MOVIAS Neo Options 
 

10.1  Image Alignment and Overlay Function 

10.1.1  Basic Functions 

The [エラー! 参照元が見つかりません。] is an optional extension of MOVIAS Neo, which 

requires a license key to operate. 

The functions are as follows. 

 

✓ Image Alignment:  The function to display an image using a specific point as the 

standard. 

✓ Overlay Display:  The function to superimpose two images for display. 

✓ Afterimage Display:  The function to superimpose the images from the previous 

and subsequent frames for the display. 

✓ Export AVI or still image files for the above contents and output to print or to a 

clipboard. 

 

The following displays are available with this function. 

 

⚫ Image Alignment 

Sets a specified measurement point location and displays the image. 

    
 

 

If making image alignment settings from a change in perspective, create an [Image 

Viewed from the Front] from the change perspective settings (Correct Image 

Perspective) and then align. 

    
 

Reference Frame Image Image Alignment  

Reference frame image (change perspective) Image Alignment 

Reference Points 

Reference Points 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 10－2 

⚫ Screen Alignment Function 

Function to rotate the image so that the two image alignment reference points are 

“screen horizontal right facing” or [screen vertical left facing]. Screen alignment 

processing is applied after the image alignment processing.  

 

An example of the application of the screen alignment function is shown below. 

 
 

 

 

  
 

 The vector from reference point 1 to 

reference point 2 shown when alignment 

with the screen horizontal alignment is 

applied rotates the image so it is horizontal 

and facing right.  

The vector from reference point 1 to 

reference point 2 shown when alignment 

with the screen vertical alignment is 

applied rotates the image so it is vertical 

and facing up.  

 

Alignment reference point 2 

Alignment reference point 1 Alignment reference point 2 

Alignment reference point 1 

Alignment reference point 2 

Application of Alignment 

Alignment reference point 1 
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⚫ Overlay Display 

Displays two images superimposed. The differences between the images can be 

visually compared. 

 
 

 

 

⚫ Afterimage Display 

Displays the afterimages of the image. 

With image alignment, the afterimage can be shown aligned. 

With overlay display, the base image and the overlay image can both be set for 

afterimage.  

 
 

 

 

Image alignment, overlay display and afterimage display are functions to visually 

verify differences in the images. For example, when comparing repeated movement, 

images are aligned, and the differences can be visualized for quantitative analysis. 

Afterimage 

Display 

Afterimage display Images of the previous and subsequent frames 

Overlay Image Base Image Overlay Display 
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10.1.2  Operating Environment 

The following environment is required to use these functions. 

 

✓ PC with MOVIAS Neo Ver2.10 or later installed 

✓ MOVIAS license key containing the license for these functions 

 

These functions process large images, so operation with the recommended MOVIAS Neo 

specs may be slow. Therefore, we also recommend the following specifications. 

 

Recommended Operating Environment 
CPU:  Recommend Core2 Duo 2GHz or the equivalent 

Memory:  Recommend 2GB or more 

Hard Drive:  Free space of 150MB or more for software 

installation 

  (200GB or more of data space is recommended)  

Monitor:  Resolution 1280x1024 or higher 

OS:  Windows 11 64bit, 

Windows 10 64bit / 32bit, 

Windows 7 64bit / 32bit,  

Windows Vista (SP2 or later) 64bit / 32bit, 

Windows XP (SP3 or later) 32bit 

DirectX®:  Microsoft DirectX 9.0C or later 

Other:  CD-ROM drive required for installation 

 USB port for MOVIAS license key  

Equipped with dedicated GPU for graphics 

 Ex: NVIDIA:  FX880M 

Recommended 

PC:  

M4500 or greater from Dell 
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10.1.3  Operating Method 

Enable this function with the following MOVIAS Neo display settings. 

 

 Standard display 

 Alignment display 

 Overlay display 

 Afterimage display 

 

Click [Standard Display], [Alignment Display] or 

[Overlay Display] from the right click menu on the 

image window to switch displays.  

 

If selecting [Standard Display] or [Alignment Display] and the image window is reopened, 

the selected display will still be shown.   

 

If [Overlay Display] is selected, operation is only possible in the overlay window. Switch 

the display to [Standard Display] or [Alignment Display] to end the overlay display.   

 

Settings for the afterimage display can be made at the same time as the [Standard 

Display] and [Alignment Display].  

 

Use [Standard Display] for analysis (tracking, calibration, and such). 

 

[Merged Export] is not available with [Overlay Display]. After importing [Overlay 

Display] to a project using the [Import Image] function from [Export AVI File], perform 

[Merged Export] for the external image.   
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10.1.4  Image Alignment 

⚫ Image Alignment 

This function sets the position of the specified measurement points and displays the 

image. 

Use with 2D analysis projects. 

With 1 point, image alignment is performed using horizontal and vertical movement. 

With 2 points, image alignment is performed using similarity transformation.   

If performing alignment settings using change perspectives, conduct image 

alignment through projective transformation.   

 

Perform [Copy to Clipboard], [Save Image File], [Print], [Export AVI File] or [Merged 

Export] with image alignment.  

 

⚫ Image Alignment Process 

Perform the image alignment settings in the [Real Scale Conversion] dialog or the 

[Change Perspectives] dialog.   

Open the image window to perform alignment. After finishing auto tracking, open 

the [Real Scale Conversion] dialog or the [Changing Perspectives] dialog and make 

the settings for image alignment. 

 

Make the settings for image alignment according to the following procedure. 

  
Image Alignment Tab (Real Scale Conversion)  

 
Image Alignment Tab (Perspective Transform)  

 

Select alignment 

method 

Select reference 

points 

Designate reference 

frames for alignment 

① 
② 

③ 

④ 

⑤ 

Set screen alignment 

(only available when 2 

point image alignment is 

selected) 

Select reference lines 

(only available for changing 

perspectives) 
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 Image alignment procedure 

① Select the alignment method. 

② Select the reference points for alignment. 

③ Select the reference frames for alignment. 

④ If selecting 2-point alignment, make the settings for screen alignment. 

⑤ Select the reference lines for changing perspectives. 

⑥ After finishing the real scale conversion or change perspectives settings in 

another tab, click [Finish].  

 

⚫ Settings for Image Alignment 

 

 
 

No setting for alignment. 

Initial setting. 

 

Alignment is not shown even if [Alignment 

Display] is selected on the right click menu 

in the measurement image window.  

 

 

Designate one reference point for alignment. 

 

Image alignment performed on the origin 

set with the [Origin and Axis] tab during the 

selection of the [Origin (XXXX)]. “XXXX” is 

the name of the point set with [Each Frame] 

for the origin.  

 

Image alignment is performed with the 

measurement points selected unless selected 

as noted above. (applies only to image 

alignment) 

 

 

Specify two reference points for alignment. 

 

Image alignment is performed on the points 

set with the [Reference Plane] tab of the 

[Real Scale Conversion Dialog] during 

[Reference Line (XXXX)] selection. “XXXX” 

is the name of the point set when specifying 

the tracking points.  

 

Image alignment is performed with the 

measurement points selected unless selected 

as noted above. (applies only to image 

alignment) 

 

  



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 10－8 

 
 

Input the reference frames for image 

alignment. Click on the current frame to set 

the timing of the current display.  

 

Screen alignment settings (can be set only 

with 2-point image alignment) 

 

Performs image rotation so the vector 

connecting the reference points for image 

alignment is in the specified direction.  

 

No screen alignment:  No screen alignment. 

Screen horizontal alignment:  Image 

rotation so the alignment reference points 

are screen horizontal right facing.   

Screen vertical alignment:  Image rotation 

so the alignment reference points are screen 

vertical top facing. 

 

Reference Line (can be specified only when 

changing perspective)  

 

 (In general) With the exception of during 2 

point image alignment, the reference points 

and reference lengths during image 

conversion are selected from lines L1, L2, 

L3, and L4 used during エラー! 参照元が見つ

かりません。 (p. エラー! ブックマークが定義

されていません。).  

If the line is slanted, the converted image 

will also have the corresponding slant. 

Depending on the aspect ratio, if a short line 

is selected, the entire image can be shown 

converted.   
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If [Origin (XXXX)] is selected in [1 Point Image Alignment], alignment is performed 

with the measurement points selected with the starting point coordinates from the 

[Origin and Axis] tab. 

 

If [Reference Line (XXXX)] is selected in [2-Point Image Alignment], alignment is 

performed with the measurement points selected with the measurement points for 

the reference line segments under the [Reference plane] tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⚫ Alignment Display Right Click Menu 

Switch from show or hide the display name for the reference points aligned from the 

[Alignment Reference Points] on the right click menu. 

Annotation display is not possible during alignment. 

 

Reference Plane tab (Real Scale Conversion) 

Name of settings 

Name of settings 

Origin and Axis tab 

(during both Real Scale Conversion and Changing Perspective) 
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⚫ Procedure for Correcting the Image Perspective 

Next is a description of the procedure used for image alignment from changing the 

perspective. 

1. The measurement points are automatically tracked. 

 

2. Click change perspective  on the main control bar and the [Reference Plane] tab 

of the change perspectives dialog appears. 

 
3. Click the points corresponding to the changing perspectives reference points (top left 

corner, top right corner, bottom right corner, and bottom left corner) and input the 

true length connecting the reference points or the coordinates of the reference points.  

 
Distortion from filming at an incline as mentioned above is corrected and the 

coordinates can be determined. 
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4. The [Image Alignment] tab appears and settings for image alignment can be 

performed as necessary. 

The settings are identical to the image alignment settings for true scale 

conversion. Refer to エラー! 参照元が見つかりません。 (p. エラー! ブックマークが定

義されていません。) for details. 

 
 

5. After finishing the settings for changing perspectives, select [Alignment] from the 

right click menu of the image window and the conversion image will appear. 

 
 

 

During a change in perspective, if [Alignment] is selected from the right click menu of 

the image window even when [No Image Alignment] is selected, correction of the image 

perspective is performed. 

   
Normal display   Correcting the image perspective 

Alignment with [No 

Image Alignment]  
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 (Create image to view from the front)  
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6. When changing perspective, if no alignment or 1 point image alignment is selected, 

set the reference lines according to the incline of the plane for which [Alignment] is 

to be performed. With frames that do not have reference points, alignment is shown 

using the selected reference lines, even if 2-point image alignment is selected. 

Select the reference lines from the reference lines for changing perspective. The 

arrangement is the same as that in the figure for エラー! 参照元が見つかりません。 

(p. エラー! ブックマークが定義されていません。). An example is shown in the 

relationship in the following figure. 

 
 

  
If L4 is selected as the reference line  If L1 is selected as the reference line 

 

Depending on the selected reference line, the image for the results of the changed 

perspective alignment may have an exaggerated incline. Select the appropriate 

[Reference Line] for the incline of the plane. Also, if you cannot select the desired axis 

for the reference line, consider adding two fixed points for separate image alignment and 

perform 2-point image alignment.   

 

 

 

 

 

 

 

 

Reference line L1 

Reference line L4 

Reference line L3 

C-Mark2 
C-Mark1 

C-Mark3 

C-Mark4 

Reference line L2 

Reference line L4 

Reference line L1 
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⚫ Image Area Enlargement Function 

Function to enlarge the image display area. The image is not enlarged or reduced 

and remains the original size. 

 

The image alignment function performs rotation of images or changes the 

perspective, so part of the image is outside the display region, as shown in the figures 

below.     

 

  
 

In this case, this function is used to enlarge the image area and display the entire 

image after alignment. 

 
Shows the Entire Image after Changing the Shape by Enlarging the Image Area 

Area that cannot 

be displayed 

Original 

image area 

Enlarged 

image area 
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Perform the following to enlarge the image area. 

 

Click  on the main control bar with the [Image Alignment and Overlay 

Function] license key inserted. 

 

The [Create a 2D Analysis Project] dialog appears. 

 

1. Click [Reference] to designate the 

measurement image file for analysis.  

 

 

2. Check [Enlarge the Image Area] and 

input the enlarged area size.  

 

 

3. Click [OK] to create a project with the 

image area enlarged. 

 

 

 

 

 

 

 

 

 

 

 
After setting the enlarged image area, the operations using the image are processed with 

the enlarged size. Image area expansion can only be set during creation of a new 2D 

project. Changes to the image area cannot be made after a project is created. If changing 

the image area, create a new project. 

 

① 

② 

Enlarged 

image 

area 

③ 
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10.1.5  Overlay Display 

⚫ Overlay Display 

Overlay display is a function to superimpose the display of image files, showing the 

alignment of specified measurement points (reference points) is possible. Since MAX, 

MIN, RG channels can be selected as the method of creating images, match the 

superimposed images and use the appropriate method. Also, the image quality of 

both the base image and the overlay image can be adjusted. 

 

[Copy to Clipboard], [Save Image File], [Print] and [Export AVI File] can be 

performed during overlay display. [Merged Export] is not available. 

 

During overlay display, operation is only possible in the overlay image window. 

Switch to [Standard Display] or [Image Alignment] to use other windows 

 

⚫ Overlay Display Procedure 

Open the image window for the overlay image before performing overlay display. 

 

 
 

Overlay is possible with the [Measurement 

Image Window] and the [External Image 

Window]. 

 

Click [Overlay Display] on the right click menu 

of the image window used as the base and the 

[Video Overlay Settings] dialog will appear so 

you can make the overlay settings. 

 

Overlay image 

Base image 
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The procedure for making settings for the overlay display is as follows. 

 

 
 

 

 Select the superimpose settings for the overlay. 

 Select the overlay creation method. 

 Select the images to overlay from the [Overlay Image Settings] combination 

box. 

,  Make the settings for the method of superimposing the base image with 

the overlay image as well as for the afterimage and image quality adjustment. 

  (Refer to p.エラー! ブックマークが定義されていません。 for details on each 

setting.) 

Click [OK] to display the overlay image. 

 

 

Click the image on the overlay display to switch the image display. 

Switch in the order of create display → display base image → display overlay image → 
automatically alternate displays. 

The automatically alternating display temporarily shows the [base image] then switches 

to the [overlay image].  

  

① 
③ 

④ ⑤ 

⑥ 

② 
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⚫ Overlay Display Settings 

 

 
 

Overlay Settings 

No reference:  Only displays superimposed images. Does not perform alignment. 

1 reference point:  Reference alignment with vertical and horizontal movement of the 

overlay image. 

2 reference points:  Reference alignment with similarity transformation of the overlay 

image 

Base image/overlay image settings 

Settings for the method of creating the overlay  

Overlay Base image 

Overlay image Automatically alternating images 
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⚫ Details of the Base Image / Overlay Image Settings 

 
 

Overlay Settings 

 

Settings for reference points and 

reference frames. 

To superimpose one point, set 

reference point 1 and to superimpose 

two points, set reference points 1 and 

2. 

 

Do not set reference points if you are 

not superimposing reference points. 

 

Align using the reference points for 

the alignment reference frames. 

 
 

Afterimage Display 

 

Make the settings for afterimage 

display when superimposing the base 

image or the overlay image. 

 

For details, refer to エラー! 参照元が

見つかりません。  (p. エラー! ブックマ

ークが定義されていません。). 

 

 
 

Image Quality Adjustment 

 

Adjust the image quality when 

overlaying. 

This is identical to the MOVIAS Neo 

[Correction of Displayed Images] 

function. 
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⚫ Settings for the Method Creating the Overlay 

Select from average, MAX, MIN, RG channel, interleave, and the absolute value of 

the differences.  

Examples creating each type using the base and overlay images are shown below. 

  
 Base Image Overlay Image 

 

Example when [Average] is Selected 

 
 

Example when [MAX] is Selected 

 

Displays the average of 

the color for each pixel 

from the base image 

and the overlay image. 

 

Half of the brightness of 

both the base image and 

the overlay image is 

used. 

Shows each pixel with a 

brighter base image and 

overlay image. 

 

Use this method to 

make images with dark 

backgrounds easier to 

see. 
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Example when [MIN] is Selected 

 
 

Example when [RG Channel] is Selected 

 
 

Example when [Interleave] is Selected 

 
 

Displays the brightness 

of the base image as R, 

the brightness of the 

overlay image as G, and 

B as 0. 

 

Since the image is 

drawn in each color, the 

differences in images 

are easy to spot. 

Displays an interleave 

of the base image and 

the overlay image. 

 

A good quality video can 

be made because the 

images show each line. 

 

To display properly, you 

must remove the image 

zoom and display it as 

1: 1.  

 

Shows each pixel with a 

darker base image and 

overlay image. 

 

Use this method to 

make images with 

bright backgrounds 

easier to see. 
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Example when [Absolute Value of the Differences] is Selected 

 
 

 

Right Click Menu of the Overlay Display 
Switch from show or hide the display name for the superimposed reference points 

from the [Alignment Reference Points] on the right click menu. 

Annotation display is not available during the reference point alignment display. 

 

 
 

Displays the absolute 

value of the color 

differences between the 

base image and the 

overlay image. 

 

The differences between 

the images can be 

checked. 
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10.1.6  Afterimage Overlay Setting 

This function superimposes image frames before and after the current frame for display. 

Scenes of the movement over multiple frames can be displayed on a single image. 

Afterimages can be created with [Image Alignment Display] or [Overlay Display]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

⚫ Afterimage Overlay Setting Dialog 

Click [Afterimage Overlay Setting] on the right click menu of the image window to 

display the [Afterimage Overlay Setting] dialog. 

 
 

 
Afterimage Overlay Setting Dialog for Standard Display or Image Alignment 

Display 
 

Afterimage 

Display 
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During overlay display, the afterimage display can be set for the base image and the 

overlay image.  

 
Afterimage Overlay Setting Dialog for Overlay Display 

 

Enable Afterimage Display 

Enables/disables afterimage display. 

 

Number of Frames to Skip 

Sets the number of frames to jump among the surrounding frames for afterimage 

display. When 0, the subsequent image becomes the afterimage displayed. 

 

Number of Frames Behind or Number of Frames Ahead 

 Sets the number of images displayed before and after the current image. (0~9) 

 

Method for Creating Afterimages 

Select [MAX] or [MIN]. Switch according to the image so the images are easy to see. 

This is identical to the [MAX] and [MIN] methods for creating overlay display. 

MAX:  Uses the brightest colored pixel in a series of afterimages. 

Use this when the background is dark. 

MIN:  Uses the darkest colored pixel in a series of afterimages 

Use this when the background is bright. 

 

Fade Out 

The afterimage is shown fainter as time passes. 

 

Afterimage Transparency 

Designate the transparency when creating afterimages with current images. The 

afterimage becomes fainter as it gets closer to 0, and brighter as it gets close to 100. 
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10.2  Frame Rate and Time Display for Time-Lapse Photography 

[Frame Rate and Time Display for Time-Lapse Photography] is an optional function for 

MOVIAS Neo. It adds the units necessary for time-lapse photography. 

The following environment is required to use this function. 

 

✓ PC installed with MOVIAS Neo Ver2.21 or later 

✓ MOVIAS license key with the license for this function 

 

10.2.1  Basic Functions 

The following are possible with this function. 

 

✓ Frame Rate for Time-Lapse Photography:  

fpm and fph frame rates have been added for time-lapse photography. 

The following frame rates can be set with this function. 

➢ fps (frames per second) 

MOVIAS Neo standard unit for frame rate. 

➢ fpm (frames per minute =1/60fps) 

➢ fph (frames per hour = 1/3600fps) 

 

✓ Display of Hours/Minutes/Seconds for Long Term Photography:  

Adds a display of hours/minutes/seconds to show the time during long term 

photography. 

The following time displays are available with this function. 

➢ F (frames), sec (seconds), msec (milliseconds), usec (microseconds) 

MOVIAS Neo standard unit for time display. 

➢ hms (hours/minutes/seconds) 

 

 

If hms (hours/minutes/seconds) is selected for the 

time display during long term photography, the 

display is “HH: MM: SS.***”. If a negative, the 

display is “－HH: MM: SS.***”. 

 

HH and MM refer to hours and minutes. 

 “SS.***” refers to seconds. *** refers to decimal 

places. 

The number of columns is for the values set in [Number of Decimal Places] in [Time 

Units]. 

If [hours/minutes/seconds] is selected, input using the format of “HH: MM: SS.***”. 
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10.2.2  Operation 

⚫ Frame Rate for Time-Lapse Photography 

Select the frame rate unit when creating from new 2D projects, new 3D projects or 

project templates. 

 

  
Select a frame rate in fps/fpm/fph. If creating a 3D project, you can set a frame rate 

for each camera.  

 

 

⚫ Time Display for Extended Exposure Photography 

To switch to the time display for extended 

exposure photography, select the [Export] tab 

when the [Project Information] dialog 

appears. Select [Hours/Minutes/Seconds] 

under [Time Units] and click OK to display 

the time using a format of “HH: MM: SS.***”.   

 

 

 

 

 

 

Example of the Hours, Minutes, or Seconds Display 

(a) Example of the Graph Display  

 
The graph time display is [Hours, Minutes, or Seconds]. 
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(b) Example of the List Display 

 
The time display for the first row is shown in [Hours], [Minutes], or [Seconds]. 

 

(c) Playback Bar Time Display 

 
[Current], [Start] and [End] on the playback settings control bar refers to 

[Hours/Minutes/Seconds]. Input using the format of “HH: MM: SS.***”. 

 

(d) Select Time Units for Creating Graphs 

Select “hms” when importing an analysis graph or waveform graph to display 

“Hours/Minutes/Seconds” separately from the project information. 
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10.3  MOVIAS Neo 2D-6DOF Measurement Functions  

10.3.1  Basic Functions 

The [MOVIAS Neo 2D-6DOF Measurement Function] is a functional expansion option 

for MOVIAS Neo that requires a license key. With this function, 6DOF measurements 

can be performed for 2D measurement projects. 

⚫ Data required for 2D-6DOF measurements 

The following inputs and files are required to perform 2D-6DOF measurements. 

4 or more measurement points 

4 or more tracking points are required for 6DOF measurements on rigid bodies 

If there are fewer than 4 tracking points for a rigid body in a specific time frame, 

6DOF calculations cannot be performed for that time frame. 

Real scale or changing perspectives 

If performing 6DOF measurements using real scale conversion, you must set the 

true length of the reference line segment (refer to p. 5－5) and the reference plane 

depth (refer to p. エラー! ブックマークが定義されていません。).  

If performing 6DOF measurements while changing perspectives, perform this in the 

same manner as when changing perspectives normally. 

Refer to the figures on the following page for the relationship between conversion 

and 6DOF measurement values.  

 

6DOF reference coordinates file 

 (CSV format)  

Designate a starting point (0.0, 0.0, 0.0) on a rigid 

body an create a file for the coordinates for each 

measurement point using the right hand 

coordinate system. 

Refer to 2D-6DOF Reference Coordinates File (p. 

F-1) for details on the creation methods. 

 

 

⚫ 6DOF Measurement Results  

The following is output as the 6DOF measurement results. 

6DOF Calculated Values 

Position and attitude of each frame for the starting points specified in the 6DOF 

reference coordinates file. 

The 6DOF calculated values can be file outputs. 

The direction of the X axis and the Y axis are set during 2D calibration. The Z axis 

is calculated in a direction toward the right hand coordinate system from the X axis 

and Y axis. 

 

3D Calculation Coordinates for Each Measurement Point 

3D coordinates calculated for each frame of each measurement point. Use with 

analysis graph calculations or stick display. 

Calculate the coordinates while taking the X axis, Y axis and Z axis into 

consideration. 
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2D-6DOF + real scale conversion. Calculate the 6DOF movement from the reference 

plane perspective. The coordinate system follows that designated in the real scale 

dialog. 
 

 
2D-6DOF + changing perspectives. Calculate the 6DOF movement from the 

perspective plane. The coordinate system follows that designated in the perspectives 

transform dialog. 
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⚫ 2D-6DOF Quick Start 

The procedure for calculating 2D-6DOF is as follows. 

(a) Photographic Phase 

(1) Position Coordinate Measurement for Target Points 

Measure the position coordinates for the target points on the rigid body for the 

6DOF measurement. Use the right-hand coordinate system. Specify positions 

where the positional relationship on the target points is unknown. We 

recommend places on the image that are easy to identify (locations with angles 

or well-defined shapes). 

We do not recommend areas that are poorly lighted or that are hard to see due to 

noise. Also, we do not recommend reflective areas such as metallic surfaces or 

overexposed areas because they are hard to see.   

(2) Create a 6DOF reference coordinate file (refer to p. エラー! ブックマークが定義

されていません。)  

Enter the coordinate values for the measured target points to the file and create 

a 6DOF reference coordinates file. Use the target names given here and match 

them with the tracking points. 

(3) Filming 

Film so that there are 4 or more target points filmed. If there aren’t enough, add 

target points or change the camera setup. If using real scale conversion to 

perform 2D-6DOF measurement, don’t forget to measure the true length of the 

reference line segments (refer to p.  5－5) and the reference plane depth (refer to 

p. エラー! ブックマークが定義されていません。). 

 

(b) Analysis Phase 

(1) Create a 2D project 

(2) Track each measurement point 

If setting up tracking points on target points, change the name of the target 

points assigned during filming. Perform 6DOF calculations for the points 

corresponding to the names. It is not necessary to track all of the target points 

but 6DOF calculations cannot be performed on frames with fewer than 4 tracked 

points. 

(3) 2D calibration  

(3-1) Real Scale Conversion 

Set the true length, the axis and the starting point in the same manner as with 

standard real scale conversion. 

With 6DOF measurements, make sure to also set the reference plane depth 
(refer to p. エラー! ブックマークが定義されていません。). 

(3-2) Changing Perspectives 

Perform in the same manner as when changing perspectives normally (p. エラ

ー! ブックマークが定義されていません。). 

 

(c) File Output 

(1) Show measurement results 

(2) Output file of 2D-6DOF calculated values. 
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 (d) Create 6DOF Node 

Use any of the following and the 2D-6DOF analysis dialog will appear. 

 
 

Import the 6DOF reference coordinates file created in the filming phase (a) - (2) with 

the [2D-6DOF analysis] dialog. Set the units in import. Refer to p. 10－45 for details 

on other functions.  

 
 

Click OK once the import is done and a 6DOF node will be created under the 

measurement node.  

 

 
Note:  After creating a 6DOF node, when you right-click and select Edit to open the 2D-

6DoF analysis dialog, the [Import] button will be disabled, and you will not be able to re-

import the reference coordinate file and re-analyze. To re-import, create a new 6DOF 

node. 
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 (e) 6DOF Analysis 

Once the 6DOF calculations 

here have been completed 

properly, the 6DOF 

measurement results can be 

used. 

 

The 6DOF list display, graph 

display and trajectory display 

are available with the right 

click menu of the [Current 

Project] node. 

 

 

 (5-1) List Display of the Coordinate Data 

Displays the 6 elements of the rigid body with the 6DOF analysis as well as the 

3D calculated coordinates for each measurement point.  

The 6DOF measurement results can be saved to a file from a CSV export or from 

saved 6DOF measurement results.  

 (5-2) Graph Display of the Coordinate Data 

Displays the analysis graph dialog. Displays the 3D calculated coordinates for 

each measurement point. Calculates the 3D acceleration for each measurement 

point so the physical quantities (length/angle etc.) combined with the normal 

measurement points can be calculated.   

 (5-3) Display of the Trajectory Figure  

Displays a 3D trajectory figure for each measurement point. Also, the position 

and attitude of the 6DOF measurement results can be displayed on the trajectory 

figure (ver. 3.13 or later).  
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⚫ Dynamic 2D-6DOF [ver3.12 or later] 

Performs 2D-6DOF while calibrating. 2D calibration has functions for dynamic origin 

and axis in the 2D-6DOF version.   

Note:  Since only these 2D-6DOF results can be calculated with this coordinate system, 

please use caution when comparing with other tracking results.  

(a) Use 

1. Filming 

When photographing 2D-6DOF measurements, the reference coordinate system 

with 6 or more points is simultaneously photographed. 

Note:  Processing is performed in the same manner as with 3D calibration. 

Calculations for only points on a plane or straight-line fail. Use points positioned 

three-dimensionally. If arranged with a 3D calibration chart, it is easy to film these 

together Refer to the figure on the next page.  

2. Tracking 

Create a project and all the 6DOF targets and dynamic 2D-6DOF reference points 

are tracked.  

Don’t forget to track all frames of the dynamic 2D-6DOF reference points. 

3. Calculations by MOVIAS Neo 

 (3-1)  

Loads 6DOF measurement targets and coordinates for the reference points to a 

single file as the reference coordinate system.  

 (3-2)  

Check [Dynamic 2D-6DOF] in the [2D-6DOF Analysis Dialog] to display the 

checkbox in the list. Check the points in the list to be used as reference points. 

Select 6 or more points. 

Check [output on this dynamic 2D-6DOF basis.] (Select Coordinates) 

Select the output coordinates. If not checked, the 2D calibration coordinates are 

output. If checked, calculations are made with the calibration coordinates used for 

dynamic 2D-6DOF.   

Compared to output with other devices, it is convenient to check this. 

The dynamic 2D-6DOF results can be used now. 

 
 

Points selected in this 

checkbox become the 

dynamic 2D-6 DOF 

calibration points. 

If the dynamic 2D-

6 DOF checkbox is 

selected, the 

checkbox will 

appear on the list. 

Select output coordinates 

* Checked 

Output with the dynamic 2D-6DOF 

coordinates 

* Not checked 

Output with the Cal coordinates 

 

Used with dynamic 2D-6 DOF 
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Dynamic 2D-6DOF. 6DOF movement seen from the Cal chart is measured. If the Cal 

chart moves, the relative 6DOF movement is measured. This is used for 6DOF 

measurements in oscillating environments.  
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10.3.2  2D-6DOF Data Operation Method 

 

⚫ 6DOF Measurement Results 

 

6DOF analysis is possible on multiple rigid bodies. The measurement results (6DOF 

measurement values, calculated 3D coordinates for each measurement point) are 

added to the measurement data. 

(a) Confirming the Measurement Results  

Displayed on the list of measurement data or on a graph. 

Displayed under the standard measurement points on the selection dialog. Points 

where a name has been assigned as the 2D-6DOF object name are calculated 3D 

coordinates for each measurement point.  

  

 

 
 

The figure above shows the [Measurement Point Selection Dialog] for 6DOF 

measurements. You can set it to switch between the measurement points and the 

6DOF coordinates. If the combo box [6DOF] is selected, you can set it to switch the 

display for each 6DOF measurement results.  

Calculated 3D coordinates  

for each measurement point 

Standard measurement point 

Switch 

6 DOF measurement 
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(i) List Display for the 6DOF Measurement Results 

 

 
 

The figure above shows the measurement list for [6DOF measurement results]. 

The standard measurement points, 6DOF measurement results, and the calculated 3D 

coordinates for each measurement point are all displayed.  

 

 
 

The figure above shows the 6DOF measurements on the measurement list. 6 elements 

are shown for a single measurement target. With 3 rotation elements and 3 movement 

elements, they total 6 elements. 

  

Measurement Points Calculated 3D coordinates  

for each measurement point 
6 DOF Measurement Points 

 

6 DOF measurement results, 6 elements for a single 6 DOF 

measurement target 

6 DOF measurement 

results rotation elements 

(Roll, Pitch, Yaw) 

6 DOF measurement 

results movement elements 

(X, Y, Z) 
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The figure above shows the calculated 3D coordinates for each measurement point on 

the measurement list. The 2D coordinates can be differentiated by the 2D-6DOF object 

name. 

 

(ii) Show Trajectory Figure of the 6DOF Measurement Results 

Use the create trajectory figure dialog to select the 6DOF measurements to be displayed 

on the trajectory figure. If the 2D-6DOF object trajectory is selected on the trajectory 

figure, the axis expressing the attitude is shown. 

 
On the 6DOF page of the [Create Trajectory Figure Dialog], the 6DOF objects checked 

for all elements (XYZ, roll, pitch, and yaw) are displayed on the trajectory figure. When 

the trajectory figure is drawn, if the 6DOF objects are selected, the axis expressing the 

attitude is also shown (ver. 3.13 or later).  

All 6 of the elements, including X／Y／

Z／Roll／Pitch／Yaw are selected and 

shown on the Trajectory Figure. 

In the case of the figure on the left, 

only “6 DOF 1” is displayed. 

Axis with the selected "6 DOF 1" 

object and attitude. 

6 DOF measurement coordinates 

6 DOF node name assigned to the point. 
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(b) Use for Analysis Results 

Calculated 3D coordinates for each measurement point are added to the create new 

graph dialog. An analysis graph using these points can be created. 

 

 
 

Calculated 3D coordinates for each measurement point are added to the list of 

measurement points for the analysis (general, length, angle, and area) using the 

measurement points from the create new graph dialog. 

Analysis can also be performed combining the standard measurement points with the 

calculated 3D coordinates for each measurement point. 

Note:  Different from the standard measurement points. 

Standard measurement points are the coordinates from subjecting the tracking results 

to real scale conversion or changing perspectives. On the other hand, the calculated 3D 

coordinates for each measurement point are the coordinates calculated from the rigid 

body motion, and the length, angle and area of a single body are constant.    

 

Note:  The calculated 3D coordinates for each measurement point are 3D coordinates 

while the standard measurement points are 2D coordinates. If angles are compared or 

distances calculated, there may be differences in the distances or angles seen on the 

image. 

 

Note:  6DOF calculations can be made using the 2D calibration movement origin and 

axis. However, tracking is possible on the XY plane, but tracking is not possible for the 

movement in the Z direction. If performing 6DOF measurements combining these, be 

careful of the activity. This is not a perfect relative coordinate system.    

 

Calculated 3D 

coordinates are added 

for all measurement 

points. 
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(i) 6DOF Analysis Graphs [ver.3.13 or later] 

An analysis graph can be displayed of the XYZ, roll, pitch, and yaw values from the 6DOF 

measurement results. 

 

⚫ [6DOF] Tab 

(a) Basic Operation 

 
List of measurement points:  Select the 6DOF object to be used for calculations. 

Graph horizontal axis and Graph vertical axis:  Graph settings. 

 

Create a graph showing the 6DOF calculation results. The units are only raw (units 

for 6DOF calculations). 

(b) Physical Quantities 

(i) POS (6DOF) 

Create a graph of the location elements 

(X, Y, and Z) for the 6DOF measurement 

results. 

Physical 

Quantities 

POS (6DOF) 

Units raw 

Elements X, Y, Z 
 

 

[6DOF] tab selection 

6DOF object list Axis settings 
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(ii) ANGLE (6DOF) 

Create a 

graph of the 

attitude 

elements 

(roll, pitch, 

and yaw) for 

the 6DOF 

measuremen

t results. 

Physical 

Quantitie

s 

 
ANGLE (6DOF) 

Units raw 

Elements roll, pitch, yaw 
 

Elements are sorted and displayed depending on setting of deconstruction method for 3D 

angles (Euler). 

Example: YXZ                        ZXY 

                      
[v3.13 or later] The analysis graph series is displayed in the order in which the 

components are selected/added. 

Example: 

XYZ                                                              ZXY 

roll(red), pitch(green), yaw(blue)               yaw(red), roll(green), pitch(blue) 

     
Note: After creating a graph using analysis data, set the 3D angle decomposition method 

(XYZ, XZY, …). If you change the 3D angle decomposition method, the series name of 

analysis graph remains the same as when it was created. It is recommended to recreate 

the analysis graph. 

 

Example: List of Analysis Graphs 

When created with "YZX" settings After that, when changed to "XYZ" settings 
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(c) Superimposed Display of the 2D-6DOF Results 

The 2D-6DOF results can be displayed as part of an annotation figure.  

Select [Select Diagram to Show] from the right click menu for the image to open the 

select display dialog. Select the 6DOF number or figure from the select analysis tab for 

superimposed display. 

  
[Select Diagram to Show] menu 

 
Select superimposed display for 6DOF results. 

With a numerical superimposed display, the 6 elements (X, Y, Z, Roll, Pitch, and Yaw) of 

the 2D-6DOF calculations are displayed.  

(X,Y,Z)=X value, Y value, Z value 

(Roll,Pitch,Yaw)=Roll value, Pitch value, Yaw value 

Note: The order of (Roll,Pitch,Yaw) values differs depending on the version of MOVIAS 

Neo. [v3.24 or later] Automatically sorted by current settings of 3D angle decomposition 

method (XYZ, XZY, …) can be obtained. [v3.13～v3.23] The order of Roll, Pitch, Yaw is 

fixed. 

 

With a diagram superimposed display, the arrows for the 3 axes are shown superimposed 

on the starting point location (0.0,0.0,0.0) of the rigid body subject to 6DOF 

measurements. The red arrow is the X axis direction, the green arrow is the Y axis, the 

blue arrow is the Z axis, and the attitude for each of the 6DOF measurement targets is 

expressed. Also, the movement trajectory of the rigid body is displayed. 

Note: The superimposed display of 3-axis arrow shapes is not reflected even if the 3D 

angle resolution method (XYZ, XZY, …) is changed. 

Superimposed display of numbers 

Superimposed display of figure 
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(d) Export File 

 

(i) Export File of the2D-6DOF Calculations. 

First, access [Display List of 6DOF Measurement Results] to display the contents to be 

exported. 

 

Select [Save 6DOF] from the right click menu on the list. The save dialog will appear so 

select the destination and save. Select a semicolon (;) or comma (,). 

 
[Save 6DOF] menu 

 

 
[6DOF Result Save] dialog  
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(ii) Contents of the Export File for 2D-6DOF Calculations 

CSV file constructed from 1 header row + data. Select a semicolon (;) or comma (,). 

＄ Header Part 

The first row of the file is fixed at  

#Time;X;Y;Z;Roll;Pitch;Yaw;m00;m01;m02;m10;m11;m12;m20;m21;m22. 

Since v3.24, depending on the setting of 3D angle decompose (XYZ, XZY, …) in the 

angle unit of the output tab of the project information, the part of “Roll;Pitch;Yaw” 

sorted and output. Fixed to "Roll;Pitch;Yaw;" from v3.13 to v3.23. 

Example: Since v3.24, for ZXY setting 

#Time;X;Y;Z;Yaw;Roll;Pitch;m00;m01;m02;m10;m11;m12;m20;m21;m22 

＄ Data Part 

＄＄  The first row is time. Milliseconds. 

＄＄  Subsequent rows are the data for each of the 6DOF objects. 

There are 15 values for a single object. 

The order from the left is (X coordinate, Y coordinate, and Z coordinate), (Roll value, 

Pitch value, and Yaw value), (with 3x3 rotation matrix shown, there are 9 elements). 

The units for angles are as set. (ex. degree or radian) 

 

Roll, Pitch, Yaw:  

The ranges for Roll, Pitch, Yaw are as follows. 

 −180° < 𝜃roll ≤ 180°, −90° ≤ 𝜃pitch ≤ 90°, −180° < 𝜃yaw ≤ 180° 

 

The final attitude is calculated as 𝑹 = 𝑹𝑥(𝜃roll)𝑹𝑦(𝜃pitch)𝑹𝑧(𝜃yaw) . 

The rotation matrix is as follows. 

 𝑹𝑥(𝜃) = (
1 0 0
0 𝑐𝑜𝑠 𝜃 −𝑠𝑖𝑛 𝜃
0 𝑠𝑖𝑛 𝜃 𝑐𝑜𝑠 𝜃

) 

𝑹𝑦(𝜃) = (
𝑐𝑜𝑠 𝜃 0 𝑠𝑖𝑛 𝜃
0 1 0

−𝑠𝑖𝑛 𝜃 0 𝑐𝑜𝑠 𝜃
) 

𝑹𝑧(𝜃) = (
𝑐𝑜𝑠 𝜃 −𝑠𝑖𝑛 𝜃 0
𝑠𝑖𝑛 𝜃 𝑐𝑜𝑠 𝜃 0
0 0 1

) 

Note: This is the same format as the simple 6DOF measurement results.  

 

m00;m01;m02;m10;m11;m12;m20;m21;m22 part 

Each element for a matrix of 3 rows and 3 columns. 

 
has this arrangement. 
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10.3.3  2D-6DOF GUI 

⚫ Right Click Menu 

Perform the following using the right click 

menu (figure on the right) of the 2D-6DOF 

object node.  

 

➢ Change Node Name 

Changes the name of the 2D-6DOF 

object. 

➢ Delete 

Deletes the selected graph node and 

its 6DOF analysis results. 

➢ Edit 

Displays the [2D-6DOF Analysis 

Dialog p. 10－45] so the settings can 

be edited. 
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⚫ 2D-6DOF Analysis Dialog 

Make the 6DOF settings and the graph settings using this dialog. 

Set the following items. 

 

✓ Load and edit [Reference Points]  

✓ 6DOF node name 

✓ Coordinate units (mm/cm/m) 

✓ 6DOF starting point settings 

➢ Reference points 

➢ Offset 

✓ Drawing settings 

✓  (Dynamic2D-6DOF)  

 

After finishing, the 6DOF node is added at the bottom of the [Current Project] node. 

 
 

2D-6DOF dialog. Click OK to create. 

 

・[Units] combo box 

Select the units for the coordinates. 

・[Reference] combo box 

Set the standards for the 6DOF results to be calculated. 

 [Cal coordinate system]: Calculate the position・attitude viewed from the 

calibration coordinate system. 

[Top frame]: Calculate the relative position・attitude from the position and 

attitude of the top frame. 

 [T0 frame]: Calculate the relative position・attitude from the position and 

attitude of the T0 frame. 

・[Node name] edit box 

Set the name of the 6DOF node. Use a unique name. 

・[Import] button 

Select the 6DOF reference coordinate file to load those coordinates. 
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・[Export] button 

Save the currently displayed coordinates to a 6DOF reference coordinates file. 

・[Draw Settings] button 

Switch the trajectory display for the starting point of the rigid body with 6DOF 

measurements ON/OFF and set the colors of the trajectory lines and the trajectory 

display range (around a certain frame). 

・[Dynamic 2D-6DOF] checkbox 

Enables 2D-6DOF. If checked, a check will appear in the [Reference Point List]. 

Points checked here will be used as calibration points for the dynamic 2D-6DOF. 

・[output on this dynamic 2D-6DoF basis.] checkbox (Select Coordinates) 

Select the output coordinates. If not checked, the 2D calibration coordinates are 

output. If checked, calculations are made with the calibration coordinates used for 

dynamic 2D-6DOF. 

Compared to output with other devices, it is convenient to check this. 

 
・6DOF Starting Point 

Input auxiliary function for the reference coordinates. This is a function to apply 

the offset batch to the 2D-6DOF reference coordinates.  

 
The [6DOF starting point] area is below the list. The settings for the starting point 

offset are made here. The value after applying the offset and the original value is 

shown on the list.  

Points selected with this checkbox become 

the dynamic 2D-6 DOF calibration points. 

If the dynamic 2D-6 DOF box is 

checked, the checkbox appears 

on the list. 

Select output coordinates 

* Checked 

  Output with the dynamic 2D-6DOF 

coordinates 

* Not checked 

  Output with the Cal coordinates 

Used with dynamic 2D-6DOF 

6DOF origin point settings area 

Original coordinates and offset coordinates 

Select reference points combo box 

Specify the Offset 
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⚫ [Contents of the List Display] 

Two numbers are shown in a single cell. The [import] value is shown in parenthesis 

and the value is that input by manually editing the CELL. The value on the left side 

is the value after offset application.  

When manually editing the value, the value in parenthesis is editing. 

The value for the [centroid] is shown at the very bottom. These coordinate values are 

the values that are used when the centroid is selected in the combo box as the 

reference point. 

 
Values shown on the list. Both the value after offset and the original values are shown. 

Coordinates for the [centroid] are shown at the very bottom.  

 

Select reference points combo box 
✓ Reference Coordinates System 

The reference coordinates input is used without being changed. 
✓ Centroid 

Parallel transport of all points so the center of gravity of the input reference 

coordinates is (0,0,0). 

With [dynamic 2D-6DOF], the center of gravity for the measurement points 

(the center of gravity for the points not checked on the list) is used. To check 

the current coordinates for the center of gravity, look at the [Centroid] 

coordinates at the very bottom of the list. 
✓ Select Measurement Points 

Parallel transport of all points so the coordinate of the designated point is 

(0,0,0). 

 

Specify the Offset 

If [Offset] is checked, the coordinates specified are calculated with the coordinate 

system added. If not checked, these offset values are not used. 

 

Values in parenthesis are the originals Values on the left are the values are being offset 

Coordinates for the center of gravity are shown at the very bottom of the list 
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⚫ [Display Settings] 

Make the 6DOF display settings from the [Output] tab in the [Information to set up 

parameters of this Project] dialog. 

Range: Display in a range of ±180° (Default) or display in angles from 0～360°. 

Units: Radian display or displayed in degrees (Default). 

XYZ～ZYX: Deconstruction method for 3D angles. (Euler) The default is deconstruction 

in the order of XYZ. 

  
Setting for displaying angles. Set the unit, range, and deconstruction method. 

 

Note: [Since v3.24] After changing for Deconstruction method for 3D angles, the value 

may not match the existing series (item name) in the analysis trajectory diagram. It 

is recommended to recreate the analysis graph. 

Example: List of analysis trajectory graph 

Example: Create graph with ZYX   ->    Update to XYZ 

 
The timing at which the arrangement is reflected by the setting of the decomposition 

method of the 3D angle is as follows. 
Item name in the measurement list: When changing the decomposition method of 3D 

angles 

Analysis graph series (list item name): When creating an analysis graph 

Analysis graph list value: When changing the decomposition method of 3D angles 

Roll/Pitch/Yaw items in the analysis trajectory chart list: When creating an analysis 

trajectory graph 

Values in the analysis trajectory chart list: When changing the decomposition method of 

3D angles 

Sorting and numbers of Annotations (Roll, Pitch, Yaw) on Measurement Images: When 

changing the decomposition method of 3D angles  

Note: [v3.13-3.23] Measurement list, analysis graph/trajectory chart list, annotation 

(Roll, Pitch, Yaw) (old ROT=…) is a fixed arrangement of Roll/Pitch/Yaw. (No sorting) 

 

 
 

Deconstruction method for 3D angles 

Units 

Range 
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11. Appendix 

Appendix A GUI Overview 

(a) Menu 

All operations. Switch according to the project open. There are also menus that can 

only be used with specific modes. 

 

■If a project is not open 

 
 

■ While a 2D project is processing 

 
 

■ While a 3D project is processing 

 
 

✓ File 

 
(if a project isn’t created) 

 
(if a project is open) 

 

 

 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 11－2 

New 2D Project 

Create a new 2D project. 

 Requires a MOVIAS license key for 2D analysis and 3D analysis. 

 

New 3D Project 

Create a new 2D project 

Requires a MOVIAS license key for 3D analysis 

 

エラー! 参照元が見つかりません。 

Opens a specific project. 

Requires the MOVIAS license key for the project. 

 

Close a Project 

Closes a project. 

 
Save a Project 

Saves a project. 

 

Save Project As 

Assigns a name to the current project to save it. Changes the name of the 

current project. 

 
Project Template 

Creates a project from a template or creates a template from the current 

project. 

 

Session 

Opens a session and performs processing to save and close. 

 
エラー! 参照元が見つかりません。 

Adds [Reference Image] or [Analog Waveform] to the project. 

 

エラー! 参照元が見つかりません。 

Exports project data to another file. 

✓ CSV export of measurement coordinate data 

✓ Export image to AVI・still image 

✓ Merged export 

✓ Excel export 

 

Remove External Project Analysis Results 

Deletes an external project linked to a project. 

 
Printer Settings 

Shows the printer settings dialog. 

 

Print 

Prints the current active window. 

 
エラー! 参照元が見つかりません。  

Displays or changes the project settings. 
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エラー! 参照元が見つかりません。 

Displays or changes the MOVIAS Neo settings. 

 

 
Exit the Application 

Ends the MOVIAS Neo application. 

 

 

✓ View 

 
Project Tree, Zoom View, Toolbar, Status Bar 

 Switch each tool control between show/hide.  

 
Zoom Tool, Zoom In, Zoom Out, Actual Size, Full Screen 

 Adjusts the size of the image displayed. 

 
Frame Display 

 Switches the frame units used for viewing between time and frame number. 

 

✓ Play 

 
 

Synchronized Display Mode 

 Puts each window into the synchronized display mode. 

 

View Mode 

 Puts the active window into the view mode. 

 

Tracking Mode 

 Puts the measurement image into the tracking mode. 

 
Time Starting Point (T0) Settings 

 Sets the current frame to the time starting point (T0). 
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 Image Pre-Processing 

Performs image rotation, resizing, interlace removal and image quality 

adjustment for tracking. 

Adjusts the image quality for display with [Adjust the Window Image]. 

 

Adjust the Window Image  

Adjusts the image for viewing. 

Image quality adjustment for tracking is performed with [Image Pre-processing]. 

 

 

✓ Tracking 

 

 
 (2D analysis project)  

 
 (3D analysis project)  

 

Specify Measurement Points 

 Selects the target marker for the measurement points to be added. 

 

Rearrange Measurement Points 

 Rearranges measurement points. 

 

Measurement Point Properties 

 Sets the properties for the measurement points selected. 

 

Rearrangement between Cameras (3D only) 

 Camera mapping. Used when setting measurement points for 3D analysis. 

 
Delete Measurement Points 

 Removes the selected measurement points. 

 

Delete the Tracking Results for a Specified Range 

 Deletes the tracking results for the selected measurement points. 

 
Operation 

 Performs tracking operations. 

Select from Step Backward, Reverse, Stop, Forward and Step Forward. 

 

Interpolate Hidden Points 

 Shows the interpolation dialog for function fitting. 
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Tracking Properties 

 Displays the tracking settings dialog. 

 
Specify Tracking Area (2D only) 

 Switches to the mode to specify the tracking area. 

 

 

✓ 2D Construction, 3D Construction 

  
(2D analysis project) (3D analysis project) 

 

Calibration Status Settings (2D only) 

 Performs real scale or changing perspectives. 

 

Calibration (3D only) 

 Switch to the 3D calibration mode. 

 

Optical Distortion Correction 

 Uses the optical distortion correction chart to perform optical distortion 

correction. 

 

Expanded Optical Distortion Correction 

 Performs expanded optical distortion correction. (improved method of 

calculating distortion correction, chessboard, and qualitative correction without a 

chart)  

 

 
Create 3D Measurement Data (3D only)  

 Creates 3D analysis data. 

 

Evaluate 3D Construction Error (3D only)  

 Shows the construction error for the 3D analysis data. 

 
Display Measurement Data Construction Status 

 Shows the error status for data construction. 

Cannot be used when the data construction is successful. 
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✓ Analysis 

 
 (2D Analysis Project)  

 
 (3D Analysis Project)  

 

Create a Graph of the Momentum 

 Displays the create graph dialog. 

 

Create Trajectory Figure  

 Displays the create trajectory figure dialog. 

 

Create Sticks 

 Creates and displays sticks. 

 

2D-6DOF Analysis (2D only) 

 Displays the 2D-6DOF analysis dialog. 

 

6DOF Analysis (3D only) 

 Displays the 6DOF analysis dialog. 

 
Mass Settings 

 Displays the mass settings dialog. 

 

Partial Center of Gravity Calculations 

 Displays the partial center of gravity calculations. 

 
Add Common Virtual Points 

 Displays the dialog for creating common virtual points. 

 

Add Custom Virtual Points 

 Displays the dialog for creating custom virtual points 
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✓ Tool 

 

 
 (2D Analysis Project)   

 (3D Analysis Project)  

 

Stick Definition 

 Defines sticks 

 
Select Object 

 Selects the figure created on the image. 

 

Add Rectangle 

 Adds a rectangle on the image. 

 

Add Ellipse 

 Adds an oval on the image. 

 

Add Line 

 Adds a line on the image. 

 

Add Text 

 Adds text to the image. 

 
Undo 

 Returns to the operation previously performed on the figure. 

 

Redo 

 Corrects the previous operation. 

 
Status Bar Display Settings 

 Selects the items displayed on the status bar (coordinates, RGB values, 

brightness values) 

 

3D Coordinate Transform (3D only) 

 Displays the 3D coordinate conversion dialog. 
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✓ Window 

 
 

Cascade, Tile Horizontally, Tile Vertically  

 Rearranges the window according to the method specified. 

 
Window List 

 Shows a list of the windows currently displayed. 

 

✓ Help 

 
 

Manual 

 Shows the MOVIAS Neo manual (pdf file). 

 

About MOVIAS Neo 

 Shows the version of the MOVIAS Neo application. 

 

(b) Status Bar 

Displays the image coordinates and brightness or RGB 

values for image windows. Displays the graph 

coordinates for graph windows. 

Select the items to display with [Tool] → [Status Bar 

Display Settings] on the menu. 

 

(c) Right Click Menu 

(i) Measurement Image (Display Mode, Sync Display 

Mode) 

Change to Tracking Mode 

Switches to the tracking mode 

 
Copy to Clipboard 

Copies the displayed image to the clipboard 

Copy to Image File 

Outputs the displayed image to the file 

Print Screen 

Prints the screen displayed 

Output AVI File 

Outputs the image to an AVI file 

 
Display Tracking Points 
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Switches between show・hide for all tracking points  

Show Image 

Switches the image between show or hide 

Show Trajectory  

Switches all the tracking points between show or hide 

Show Sticks 

Switches all the sticks between show or hide 

Show Figure  

Switches all the figures between show or hide 

Show Tracking Range (2D only) 

Switches the tracking range between show or hide 

Alignment Reference Points  

Switches alignment reference points between show or hide 

 
Show Reference Lines (Real Scale Conversion, Changing Perspectives Only) 

Switches the reference lines between show or hide 

Show Starting Point (Real Scale Conversion, Changing Perspectives Only) 

Switches the starting point between show or hide 

Show X Axis (Real Scale Conversion, Changing Perspectives Only)  

Switches the X axis between show or hide 

Show Y Axis Direction (Real Scale Conversion, Changing Perspectives Only) 

Switches the Y axis between show or hide 

Show the Grid (Real Scale Conversion, Changing Perspectives Only) 

Switches the grid between show or hide 

Show the Scale Lines (Real Scale Conversion Only) 

Switches the scale lines between show or hide 

 
Zoom Tool 

Enables the zoom tool 

Zoom In 

Zooms in the image 

Zoom Out 

Zooms out the image 

Actual Size 

Displays the image as actual size 

Full Screen 

Displays the image fit to the size of the window 

 
Standard Display 

Standard display of the image 

Alignment Display (option sold separately) 

Displays the alignment of the image 

Overlay Display (option sold separately)  

Shows the overlay settings dialog 

 
Afterimage Overlay Setting 

Displays the afterimage overlay setting dialog if the afterimage overlay setting 

(option sold separately) are enabled 

Switches the afterimage between show or hide if the afterimage overlay setting are 

disabled 

Select Diagram to Show 

Displays the select diagram to show dialog 



MOVIAS Neo V3 User’s Guide  nac Image Technology, Inc. 

(00355)L 11－10 

 

(ii) Measurement Image (During Tracking Mode) 

Change to Display Mode 

Switches to the display mode 

 
Specify Measurement Points 

Specifies the measurement points 

(selected measurement point, quadrant, white 

dot, black dot, feature point, fixed point)  

Rearrange Measurement Points 

Rearranges the selected measurement 

points 

Delete Measurement Points 

Deletes the selected measurement points 

Delete the Tracking Results for the Specified 

Range 

Displays the [Delete Tracking Results for the Specified Range] dialog  

 
Show Figures 

Switches between show or hide all the figures 

Show Tracking Range (2D only) 

Switches between show or hide the tracking range 

Show Sticks 

Switches between show or hide the sticks  

Tracking Properties 

Shows the [Tracking Properties] dialog 

 
 

Save Tracking Data as 

Saves the tracking data to a CSV file 

(iii) Measurement Image (During Specify Tracking Range Mode) 

Change to the Tracking Mode 

Switches to the tracking mode 

 
Delete 

Deletes the selected tracking range 

Delete All 

Deletes all of the tracking range 

 
Copy to Clipboard 

Copies the image displayed to the clipboard 

Copy to Image File 

Exports the image displayed to the file 

Print Screen 

Prints the screen displayed 

 
Show the Tracking Points  

Switches between show or hide all the tracking 

points 

Show Image 
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Switches between show or hide the image 

Show Trajectory 

Switches between show or hide the trajectory of all tracking points. 

Show Sticks 

Switches between show or hide all the sticks 

Show Figures 

Switches between show or hide all the figures 

Show Tracking Range 

Switches between show or hide the tracking range 

 
Zoom Tool 

Enables the zoom tool 

Zoom In 

Zooms in the image 

Zoom Out 

Zooms out the image 

Actual Size 

Displays the image as actual sized 

Full Screen 

Displays the image fit to the size of the window 

 

(iv) Calibration Image (3D) 

Switch to the calibration mode 

Switches to the calibration mode (3D)  

 
Copy to Clipboard 

Copies the displayed image to the clipboard 

Copy to Image File 

Outputs the displayed image to the file 

Print Screen 

Prints the screen displayed 

 
Show the Control Points 

Switches between show and hide the control points 

Show Image 

Switches the image between show and hide 

 
Detection Range 

Sets the detection range for the auto detection of 

white dots 

Delete the Detection Range 

Deletes the detection range for the auto detection of the selected white dots 

Delete All of the Detection Range 

Deletes all of the detection ranges for the auto detection of white dots 

 
Zoom Tool 

Enables the zoom tool 

Zoom In 

Zooms in the image 

Zoom Out 

Zooms out the image 
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Actual Size 

Displays the image as actual sized 

Full Screen 

Displays the image fit to the size of the window 

 

(v) Distortion Correction Chart Image 

Switch to the Optical Distortion Correction Mode 

Switches to the optical distortion correction mode 

 
Copy to Clipboard 

Copies the image displayed to the clipboard 

Copy to Image File 

Exports the image displayed to the file 

Print Screen 

Prints the screen displayed 

 
Show the Control Points 

Switches between show and hide the control 

points 

Show Image 

Switches the image between show and hide 

 
Zoom Tool 

Enables the zoom tool 

Zoom In 

Zooms in the image 

Zoom Out 

Zooms out the image 

Actual Size 

Displays the image as actual sized 

Full Screen 

Displays the image fit to the size of the window 

 

(d) Toolbars 

(i) Project Toolbar 

Performs project operations. 

 

 
 

 New 2D project 

 New 3D project 

 Open project 

 Save project 

 Print 

 Help 
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(ii) Import Toolbar 

Imports external data. Imports image and waveform data. 

 

 
 

 Import external image:    Imports image data. 

 Import external waveform data:   Imports waveform data. 

 

(iii) Operation Mode Toolbar 

 Tool bar to switch operating modes. The tracking mode can only be used when the 

measurement window is active. 

 

 
 

 Synchronized Display Mode:   Accesses the synchronized display mode. 

 Display Mode:   Accesses the display mode. 

 Tracking Mode:   Accesses the tracking mode. 

 

(iv) Settings Toolbar 

Tool bar to perform the following processing on tracking and measurement data. 

Different for 2D and 3D analysis. 

 

(2D analysis) 

 (3D analysis) 

 

 Real Scale Conversion:   Performs real scale conversion.  

Enabled during measurement image display for 2D 

analysis. 

 Changing Perspectives:   Changes perspectives.  

Enabled during measurement image display for 2D 

analysis. 

 3D Calibration:  

Performs 3D calibration. 

 Add Virtual Point:   Switches to the virtual point input mode. 

Enabled when measurement data exists. 

 Optical Distortion Correction:   Switches to the optical distortion correction 

mode. 

                          Enabled when the optical distortion correction window is   

                          displayed. 

 Specify Tracking Range:   Switches to the specify tracking range mode. 
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Enabled when the 2D analysis measurement image window 

is active. 

 Define Sticks:   Shows the settings dialog for stick definitions. 

Enabled when measurement data exists. 

  2D-6DOF Analysis:  Performs 2D-6DOF analysis. 

 

 3D Coordinate Conversion:   Performs 3D coordinate conversion. 

 

(v) Analysis Toolbar 

Tool bar to create analysis data based on measurement data. 

Enabled when measurement data exists. 

 

 
 

 Create Graphs:   Displays the create a graph dialog. 

 Create Trajectory Figures:   Displays the create a trajectory figure dialog. 

 Create Sticks:   Creates a stick item node from a stick definition. 

 

(vi) Specify Measurement Points Toolbar 

Selects the input method for the tracking points. Displayed during the tracking and 

calibration modes. 

 

 
 

 Select Measurement Point: Setting for the measurement point selection. 

 Add Quadrant:   Setting for adding quadrants. 

 Add White Dot:   Setting for adding white dots. 

 Add Black Dot:   Setting for adding black dots.  

 Add Feature Point:   Setting for adding feature points. 

 Add Fixed Point:   Setting for adding fixed points. 

 Input Line Segment:  Used during 2D calibration. 

The starting point and the ending point can be input once 

when the axis and line is input. Drag to input. 

 Add User Defined Point:  Setting for adding user defined points. 

 

 Rearrange Tracking Points:  Setting for rearranging tracking points. 

 Delete Measurement Points:  Deletes the specified measurement points. 

Processing for everything selected on the measurement 
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point list. 

 Delete Tracking Results:   Deletes the results within a specified range. 

Processing for everything selected on the measurement point 

list. 

 Camera Mapping:   Used during 3D analysis. Mode for adding the measurement 

points added with another camera to the current camera.  

 

(vii) Window Toolbar 

Sorts the currently displayed windows. The sorting order depends on the order the 

windows were activated. 

 

 
 

 Cascade 

 Tile Vertically 

 Tile Horizontally 

 

(viii) Figures Toolbar 

Draws a figure on the currently displayed measurement image. 

 

 
 

 Selects the figure to be drawn. 

 Draws a rectangle. 

 Draws an oval. 

 Draws a line group. 

 Draws text. 

 

(ix) Excel Export Toolbar 

Performs either [Group Export of Graphs to Excel] or [Export Graphs to Excel Template]. 

 

 
 

 Performs [Group Export of Graphs to Excel]. 

 Performs [Export Graphs to Excel Template]. 

 

(x) Tracking Control Toolbar 

Shown on the top of the zoom view while in the tracking mode. 

Tracks and makes the settings for stopping and tracking. 
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  Tracks the current frame and jumps to the frame in the specified 

direction. 

  Starts auto tracking in the specified direction. 

  Stops auto tracking. 

  Interpolates for function fitting. 

  Shows the tracking properties.  

 

(e) Zoom Control Bar 

Zoom settings in the video display window. 

 

 
 

 

 Zoom Tool:   Switches the zoom tool between show・hide.   

 Zoom In:  Enlarges the display. 

 Zoom Out:  Shrinks the display. 

 Remove Zoom:  Displays the image as actual size. 

 Fit to Screen:  Displays the image fit to the size of the window. 

 
Set Image Size:   Specifies the zoom rate selected from a list or manually input. 

 

(i) Playback Control Bar 

Performs playback, stop and jump. Also sets the index frame. 

 

 
 

  Jump to starting frame or to the previous frame 

  Frame by frame forward, jump to the ending frame 

 ( ) Play (loop play) 
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 ( ) Reverse playback (reverse loop play) 

 Stop 

 Jump to T0 

 Jump to the next index frame 

 Add or delete the index frame 

 

(ii) Playback Settings Control Bar 

Displays the numbers for the current playback settings. Click [View] → [Toolbars] → 
[Playback Settings Control Bar] on the menu to show/hide. 

 

 

Current:  Current frame number. Manually input a number to 

jump. 

Start:  Start of the playback range. Manually input numbers 

to set the range. 

End:  End of the playback range. Manually input numbers 

to set the range. 

Frame Rate:  Sets the frame rate. Either manually input a number 

or select from the combo box. 

 

(iii) Playback Slider Bar 

The slider bar shows the current playback settings. Click [View] → [Toolbars] → 
[Playback Slider Bar] on the menu to show/hide. 

 

Set the playback start frame, playback end frame, current frame on the slider. 

 

While in the synchronized playback mode, you can set [Common Range]・[Combined 

Range] for the window displayed.  

 

 

 

 

 

 
 

 

 

 

 

 Sets the current frame to the playback start frame. 

Current frame 

Index frame 

Top frame End frame 

Playback start frame Playback end frame 

T0 frame 

Playback range 
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 Sets the current frame to the playback end frame. 

 Sets the synchronized playback range to a range where the playback 

range for all of the windows displayed is an overlapping range (only in 

the sync playback mode)  

 Sets the synchronized playback range to a range that includes the 

playback range for all of the windows displayed (only in the sync 

playback mode)  

 

 

 

(f) Dialog Bar 

(i) Project Tree 

Shows the current project structure. Not displayed if a project isn’t open. 

 

Switch the display with [View] → [Project Tree] on the menu. 

 
 

The name of each node is as follows. Each node can be 

edited using the right click menu for that node. 

 

 Project Node 

   Primitive Node 

     Camera Node 

       Measurement Image Node 

 Calibration Mode Node (2D) 

       Calibration Node (3D) 

       Optical Distortion Correction Node 

     Waveform Data Node 

     External Image Node 

       External Image Item Node 

   Measurement Data Node 

     Measurement Data Item 

     External Measurement Data Item 

     6DOF Node 

   Analysis Data Node 

     Graph Node 

       Graph Item Node 

     Trajectory Figure Node 

       Trajectory Figure Item Node 

     Stick Node 

       Stick Item Node 

 

 

To display data corresponding to a node, double click on a node or use the right click 

menu. 

Set and operate each node from the right click menu of that node. 

Change the name of the project node to change the name of the project file. 
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(ii) Zoom View 

Zooms the area clicked. Zooms points if selected. 

Click [View] → [Zoom View] on the menu to switch between show/hide the zoom view. 

 

When the measurement image window, calibration image window or optical distortion 

correction window is activated, they can be viewed. 

    
Not in tracking mode   In tracking mode 

  Zoom In, Zoom Out 

 Auto Detect 

 Confirm (the space bar can be used as a shortcut)  

 Undo (returns to previous state) 

 Measurement Point Properties 

 

(iii) Tracking Dialog Bar 

Shows the tracking status and coordinates. Displayed only in the tracking mode. The 

display cannot be switched. 

 
Displays the X-T graph, the Y-T graph and the X-Y graph. Also displays the tracking 

completed/tracking not completed frames and the tracking status (regardless of 

interpolation). 

 

Shows when the box next to the graph on the measurement point list is checked. 

 

(iv) Measurement Point List 

Shows the status of the measurement points in the current frame. 
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Performs the following on points selected on the list 

✓ Deletes measurement points 

✓ Deletes tracking results in the specified range 

✓ Sorts measurement points 

 

 

 

 

 

 

 

Appendix B Description of 3D Coordinate Conversion 

(a) 3-2-1 Conversion 

Specifies the 3 types, specifically coordinate plane, axis, point, and performs coordinate 

conversion into that coordinate system. 

If xxx-yy-z is specified, the six points of 𝒙1, 𝒙2, 𝒙3, 𝒚1, 𝒚2, 𝒛1are input.   

Coordinate conversion is performed so the X coordinates of 𝒙1, 𝒙2, 𝒙3 become 0, the Y 

coordinates of 𝒚1, 𝒚2 become 0, and the Z coordinates of 𝒛1 become 0.   

 

First, plane (𝛼) is determined so X=0 from 𝒙1, 𝒙2, 𝒙3. 
Next, plane (𝛽) is determined so Y=0 from 𝒚1, 𝒚2 and plane ( ) previously calculated. 

Finally, plane (𝛾) is determined so Z=0 from  and plane ( , 𝛽). 

 

The rotation matrix R and the parallel transport vector t are calculated from planes , 

𝛽, 𝛾. 

Perform coordinate conversion using this R and t.  

 



1z 


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Overview of 3-2-1 Conversion 

 

Conversion is performed in the same manner as other types of conversion, including yyy-

xx-z. 
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(b) Parallel Transport  

Parallel transport coordinate conversion is performed for only the number specified from 

the calibration coordinate starting point. 

 
Overview of Parallel Transport 

Real calculations use the following formula for coordinate conversion.   

𝒙′ = 𝒙 − 𝒕 (where t refers to specified measurement points or coordinates)  

 

(c) Reference Points Best Fit 

Designate the three points of  as the reference points for coordinate conversion. 

After coordinate conversion, the coordinates are 𝒙1
′ , 𝒙2

′ , 𝒙3
′ . With R as the rotation matrix 

and t as the extent of parallel transport, R and t are calculated from ,  

according to the following formulas. 

𝑹𝒙1 + 𝒕 − 𝒙1
′ = 0 

𝑹𝒙2 + 𝒕 − 𝒙2
′ = 0 

𝑹𝒙3 + 𝒕 − 𝒙3
′ = 0 

The rotation matrix and parallel transport obtained from these equations are used for 

coordinate conversion. 

 

The formulas will not be correct if there is any measurement error. Using the distance 

between the specified coordinates and the converted coordinates as the error, the rotation 

matrix and parallel translation vector can be calculated to minimize the error. 

 
Overview of Reference Points Best Fit 

 

321 ,, xxx

321 ,, xxx 321 ,, xxx 
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Appendix C Description of Calculations 

(a) Calibration 

(i) Depth Correction 

Basically, during 2D analysis, the camera considers the movement of the object as 

movement on the same perpendicular plane, and analysis is performed on that plane. 

 

If filming objects with depth, objects close to the camera seem larger than objects farther 

away. On the other hand, objects far away appear smaller than those nearby. 

Therefore, to perform analysis on the motion on multiple planes of varying distances, it 

is necessary to correct for the differences in size and position due to this photographic 

distance (distance from the camera to the object). This is called depth correction. 

 

MOVIAS Neo has a depth correction function for 2D analysis and can perform 

quantitative motion analysis on multiple planes that taken into account the differences 

in depth. (However, correction is not possible if there are constant changes in the 

photographic distance, and this is limited to when there is movement within a plane 

perpendicular to the optical axis of the camera.) 

 

 
Descriptive Figure of Depth Correction 
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In the descriptive figure of depth correction, with 

O:   Center of the screen 

d1:   Distance from the camera on a plane containing point P1 

d2:   Distance from the camera on a plane containing point P2 

D:   Distance from the camera on a plane (reference plane) containing real scale 

conversion standard points (R1, R2), with point P3 also on the reference plane 

P1, P2, P3:  Actual positions of measurement points P1, P2, P3 

P1', P2', P3':  Apparent positions of measurement points P1, P2, P3 

P1”, P2”, P3”:  Position of measurement points P1, P2, P3 after depth correction 

Therefore,  

the depth correction coefficient for point P1 is 
 𝑑1 

𝐷
 

the depth correction coefficient for point P2 is 
 𝑑2 

𝐷
 

the depth correction coefficient for point P3 is 
 𝐷 

𝐷
 =  1 

 

The specific calculation uses  
( 𝑥 ,  𝑦 ) as the coordinates of the measurement point before correction, 𝛼 as the depth 

correction coefficient of this measurement point, ( 𝑐𝑥 ,  𝑐𝑦 ) as the coordinates of the 

center of the screen, and ( 𝑋 ,  𝑌 ) as the coordinates of the measurement point after 

depth correction to get  

( )
( ) 



−+=

−+=

cyycyY

cxxcxX
 

 

As is clear from this equation, for measurement point P2 that appears smaller because 

it is farther away from the reference plane, 
 𝑑2 

𝐷
 =  𝛼 is a value greater than 1 so is 

calculated to be larger. On the other hand, for measurement point P1 that appears larger 

because it is closer to the reference plane, 
 𝑑1 

𝐷
 =  𝛼 is a value less than 1 so is calculated 

to be smaller.  
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(ii) Changing Perspectives 

Filming with cameras may be difficult if the motion of the object is positioned 

perpendicular to the camera. If the plane of motion is not perpendicular to the camera, 

the actual scale may vary even if the distance on the image is the same 

As a result, correction for differences in size and position may not be possible with just 

depth correction. 

 
Figure Showing the Positional Relationship for Changing Perspectives 

In the figure of the positional relationship for changing perspectives, 

𝐿1, 𝐿2:  actual length along the plane of movement 

𝑙1, 𝑙2:  length that can be verified on the image 

 

Even if the distance on the image is equivalent, we understand that the width on the 

plane of movement differs. This cannot be corrected with simple depth correction alone. 

As a result, correction of the size and position must take place by changing perspectives. 

 

MOVIAS Neo 2D analysis has a change perspective function with a level of freedom for 

the positional relationship of the plane on which the object moves relative to the camera, 

and quantitative motion analysis can be performed on that plane 

(However, this correction is limited to when the relationship between the camera and 

the plane of motion is constant.) 
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(b) Physical Quantities when Creating Graphs 

This describes the physical quantities calculated during graph creation. 

(i) Position 

Calculates the positions of specified points or the relative position to particular points. 

𝑝𝑖(𝑋𝑖 𝑌𝑖 𝑍𝑖) are the coordinates for frame i of the specified point, and 𝑝0𝑖(𝑋0𝑖 𝑌0𝑖 𝑍0𝑖) 
are the coordinates for frame i of the reference point for calculating the relative position. 

At this point, position 𝑃𝑖(𝑃𝑋𝑖 𝑃𝑌𝑖 𝑃𝑍𝑖)  and the absolute value 𝑃𝐴𝑖  are calculated as 

follows. 

222
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If the relative position is not specified, it is calculated as 𝑝0(𝑋0 𝑌0 𝑍0) = (0 0 0). 

(ii) Velocity 

Calculates the velocity of a specified point. There are two equations for calculating speed. 

 are the coordinates for frame i of the specified point and 𝑇𝑖 is that time. 

At this point, the velocity 𝑉𝑖(𝑉𝑋𝑖 ⥂ 𝑉𝑌𝑖 𝑉𝑍𝑖) and the absolute value 𝑉𝐴𝑖 are calculated 

as follows. 

 

Formula１－Forward Difference 

𝑉𝑋𝑖 =
𝑋𝑖+1 − 𝑋𝑖
𝑇𝑖+1 − 𝑇𝑖

 𝑉𝑌𝑖 =
𝑌𝑖+1 − 𝑌𝑖
𝑇𝑖+1 − 𝑇𝑖

 𝑉𝑍𝑖 =
𝑍𝑖+1 − 𝑍𝑖
𝑇𝑖+1 − 𝑇𝑖

 

𝑉𝐴𝑖 = √𝑉𝑋𝑖
2 + 𝑉𝑌𝑖

2 + 𝑉𝑍𝑖
2 

Formula２－Central Difference 

𝑉𝑋𝑖 =
𝑋𝑖+1 −𝑋𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 𝑉𝑌𝑖 =
𝑌𝑖+1 − 𝑌𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 𝑉𝑍𝑖 =
𝑍𝑖+1 − 𝑍𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 

𝑉𝐴𝑖 = √𝑉𝑋𝑖
2 + 𝑉𝑌𝑖

2 + 𝑉𝑍𝑖
2 

( )iiii ZYXp
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(iii) Acceleration 

Calculates the acceleration of a specified point. There are two equations for calculating 

acceleration. 

 is the velocity for frame i of the specified point and  is the time at 

that point. Here, the acceleration 𝐴𝑖(𝐴𝑋𝑖 ⥂ 𝐴𝑌𝑖 𝐴𝑍𝑖) and the absolut value 𝐴𝐴𝑖  are 

calculated as follows. 

 

Formula１－Forward Difference 

𝐴𝑋𝑖 =
𝑉𝑋𝑖+1 − 𝑉𝑋𝑖
𝑇𝑖+1 − 𝑇𝑖

 𝐴𝑌𝑖 =
𝑉𝑌𝑖+1 − 𝑉𝑌𝑖
𝑇𝑖+1 − 𝑇𝑖

 𝐴𝑍𝑖 =
𝑉𝑍𝑖+1 − 𝑉𝑍𝑖
𝑇𝑖+1 − 𝑇𝑖

 

𝐴𝐴𝑖 = √𝐴𝑋𝑖
2 + 𝐴𝑌𝑖

2 + 𝐴𝑍𝑖
2 

Formula２－Central Difference 

𝐴𝑋𝑖 =
𝑉𝑋𝑖+1 − 𝑉𝑋𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 𝐴𝑌𝑖 =
𝑉𝑌𝑖+1 − 𝑉𝑌𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 𝐴𝑍𝑖 =
𝑉𝑍𝑖+1 − 𝑉𝑍𝑖−1
𝑇𝑖+1 − 𝑇𝑖−1

 

𝐴𝐴𝑖 = √𝐴𝑋𝑖
2 + 𝐴𝑌𝑖

2 + 𝐴𝑍𝑖
2 

(iv) Displacement 

Calculates the amount of displacement from a particular frame of a specified point. 

𝑝𝑖(𝑋𝑖 𝑌𝑖 𝑍𝑖) are the coordinates for frame i of the specified point, j is the reference 

frame for calculating the displacement and 𝑝0𝑗(𝑋0𝑗 𝑌0𝑗 𝑍0𝑗) are the coordinates for 

that frame. At this point, the amount of displacement 𝐷𝑖(𝐷𝑋𝑖 𝐷𝑌𝑖 𝐷𝑍𝑖) and the absolute 

value 𝐷𝐴𝑖 are calculated as follows. 
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(v) Movement 

Calculates the amount of accumulative movement from a reference frame “ 𝑁𝑟𝑓 ”. 

Negative values are before the reference frame and positive values are after. The value 

of the reference frame is “0”. 

The amount of movement 𝑇𝑟𝑎𝑣𝑒𝑙𝑖 is calculated as follows. 

( )

( )

　













−

=





=

+

=

−

nFrm

Nrfk

ii

nFrm

Nrfk

ii

nFrm

PP

PP

Travel

1

1

,dist

0

,dist
,  𝑁𝑟𝑓 < 𝑛𝐹𝑟𝑚

,  𝑛𝐹𝑟𝑚 ≡ 𝑁𝑟𝑓

,  𝑛𝐹𝑟𝑚 < 𝑁𝑟𝑓

  

Here, 𝑑𝑖𝑠𝑡(𝑃𝑖, 𝑄𝑖) is the function that calculates the distance between 2 points 𝑃𝑖, 𝑄𝑖 . If 
processing elements, the function returns absolute values for the differences of each 

element. If processing for “absolute value”, the function returns the Euclidian distance. 

( )iiii VZVYVXV iT
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(vi) Length 

Calculates the distance formed by multiple designated points. With N number of points, 
(𝑥𝑖 𝑦𝑖 𝑧𝑖) are the coordinates for point i. 

At this point, the length 𝐿𝑎𝑏𝑠 and the projection length 𝐿𝑥, 𝐿𝑦, 𝐿𝑧 are calculated as follows. 
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


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Projection length 𝐿𝑥 expresses the length projected on plane y-z,  expresses the length 

projected on plane z-x and 𝐿𝑧 expresses the length projected on plane x-y.  

(vii) Angle 

Calculates the angle between specific vectors. 

Consider vectors 𝑽1(𝑉1𝑥 𝑉1𝑦 𝑉1𝑧) and 𝑽2(𝑉2𝑥 𝑉2𝑦 𝑉2𝑧). There are three methods of 

calculating angles, and the method of calculating each vector 𝑽1, 𝑽2 is different. Angle 𝜃 

is calculated as follows. 

𝜃 = 𝑡𝑎𝑛−1
𝑠𝑖𝑛𝛼

𝑐𝑜𝑠𝛼
  : 𝑐𝑜𝑠 𝛼 ≠ 0 

𝜃 =
𝜋

2
  : 𝑐𝑜𝑠 𝛼 = 0 

with  





2

21

21

cos1sin

cos

−=

•
=

VV

VV

 

 

Method 1   4 Points 

Calculates the angle created by the vectors from 4 points. If the four points of 

𝑃1(𝑋1 𝑌1 𝑍1), 𝑃2(𝑋2 𝑌2 𝑍2), 𝑃3(𝑋3 𝑌3 𝑍3), 𝑃4(𝑋4 𝑌4 𝑍4) are specified, vectors , 

𝑽2 are calculated as follows. 

342

121

PPV

PPV

−=

−=
 

,  are applied to the abovementioned angle calculations to calculate the angle. 

 

Method 2   3 Points 

Calculates the angle created by the vectors from 3 points. If given the three points of 

, , , vectors ,  are calculated as 

follows. 

 
132

121

PPV

PPV

−=

−=
 

,  are applied to the abovementioned angle calculations to calculate the angle. 
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Method 3    2 Points 

Calculates the angle created by the vectors from 2 points. If given the two points of 

, , vectors ,  are calculated as follows. 

 
122

1

PPV

eV

−=

=
 

𝒆 denotes the unit vector for the selected coordinate axis. ,  are applied to the 

abovementioned angle calculations to calculate the angle. 

 

(viii) 3D Angles 

Calculates the angle from 3D measurement data. The projection planes include 

“Standard”, X projection plane (𝐴𝑥), Y projection plane (𝐴𝑦), Z projection plane (𝐴𝑧) and 

absolute value (𝐴𝑎). 

𝐴𝑥, 𝐴𝑦, 𝐴𝑧 and 𝐴𝑎 are used as vectors ( ,𝒙2), (𝒚1,𝒚2), (𝒛1,𝒛2) projected on the x plane 

(𝒙1,𝒙2), the y plane (𝒚1,𝒚2), and the z plane (𝒛1,𝒛2) and are used for the calculations in 

the previous section (エラー! 参照元が見つかりません。 エラー! 参照元が見つかりませ

ん。) for the 3D vector calculations (𝒗1,𝒗2). The angle between the two vectors ( , ) 

is calculated for the absolute value ( ). 

“Standard” is used for angle calculations compatible with MOVIAS Neo Ver1, which 

takes into consideration the 3D coordinates and the orientation of the rotation angle to 

determine the agreement with the results of the calculations for Aa. 

This positional relationship is shown in the following figure. 

 

 

𝐴𝑎 = 𝑐𝑜𝑠
−1 (

𝒗1 • 𝒗2
‖𝒗1‖‖𝒗2‖

) 
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Positional relationship of 3D angle Calculation 

３D 角度計算の位置関係 

3D angle absolute value(Aa) formula 
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(ix) Area 

Calculates the projection area 𝑆𝑥, 𝑆𝑦, 𝑆𝑧 for the points when the group of input points are 

projected on the y-z plane, the z-x plane and the x-y plane. The number of input points 

is N. The coordinates for #i are (𝑥𝑖 𝑦𝑖 𝑧𝑖). At this point, the projection areas , , 

 are calculated as follows. 
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Lines connecting points cannot intersect with other lines. 

(x) Momentum 

Calculates the momentum for a designated point. 

𝑚 is the mass for the specified point and 𝑉𝑖(𝑉𝑋𝑖 ⥂ 𝑉𝑌𝑖 𝑉𝑍𝑖) is the velocity of frame 

i. At this point, momentum 𝑀𝑖(𝑀𝑋𝑖 ⥂ 𝑀𝑌𝑖 𝑀𝑍𝑖) and the absolute value 𝑀𝐴𝑖  are 

calculated as follows. 

𝑀𝑋𝑖 = 𝑚 ⋅ 𝑉𝑋𝑖  𝑀𝑌𝑖 = 𝑚 ⋅ 𝑉𝑌𝑖  𝑀𝑍𝑖 =⥂ 𝑚 ⋅ 𝑉𝑍𝑖 

𝑀𝐴𝑖 = √𝑀𝑋𝑖
2 +𝑀𝑌𝑖

2 +𝑀𝑍𝑖
2 

(xi) Force 

Calculates the force of a specified point. 

 is the mass of the specified point and  is the acceleration of 

frame i. At this point, force 𝐹𝑖(𝐹𝑋𝑖 ⥂ 𝐹𝑌𝑖 𝐹𝑍𝑖)  and the absolute value 𝐹𝐴𝑖  are 

calculated as follows. 

𝐹𝑋𝑖 = 𝑚 ⋅ 𝐴𝑋𝑖  𝐹𝑌𝑖 = 𝑚 ⋅ 𝐴𝑌𝑖  𝐹𝑍𝑖 =⥂ 𝑚 ⋅ 𝐴𝑍𝑖 

𝐹𝐴𝑖 = √𝐹𝑋𝑖
2 + 𝐹𝑌𝑖

2 + 𝐹𝑍𝑖
2 

(xii) Power 

Calculates the power of a specified point. 

 is the mass of the specified point and  is the velocity of frame I 

and  is the acceleration of frame i. At this point, power 

𝑃𝑊𝑖(𝑃𝑊𝑋𝑖 ⥂ 𝑃𝑊𝑌𝑖 𝑃𝑊𝑍𝑖) and the absolute value 𝑃𝑊𝐴𝑖 are calculated as follows. 

𝑃𝑊𝑋𝑖 = 𝑚 ⋅ 𝑉𝑋𝑖 ⋅ 𝐴𝑋𝑖 𝑃𝑊𝑌𝑖 = 𝑚 ⋅ 𝑉𝑌𝑖 ⋅ 𝐴𝑌𝑖  𝑃𝑊𝑍𝑖 =⥂ 𝑚 ⋅ 𝑉𝑍𝑖 ⋅ 𝐴𝑍𝑖 

𝑃𝑊𝐴𝑖 = 𝑚 ⋅ (𝑉𝑋𝑖 ⋅ 𝐴𝑋𝑖 + 𝑉𝑌𝑖 ⋅ 𝐴𝑌𝑖 + 𝑉𝑍𝑖 ⋅ 𝐴𝑍𝑖) 

xS yS

zS

m ( )iiii AZAYAXA

m ( )iiii VZVYVXV
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(xiii) Energy  

Calculates the energy of a specified point. 

is the mass for the specified point and  is the velocity of frame i. 

At this point, energy 𝐸𝑖(𝐸𝑋𝑖 ⥂ 𝐸𝑌𝑖 𝐸𝑍𝑖) and the absolute value 𝐸𝐴𝑖 are calculated as 

follows. 

𝐸𝑋𝑖 =
1

2
𝑚 ⋅ 𝑉𝑋𝑖

2  𝐸𝑌𝑖 =
1

2
𝑚 ⋅ 𝑉𝑌𝑖

2  𝐸𝑍𝑖 =  ⥂
1

2
𝑚 ⋅ 𝑉𝑍𝑖

2 

𝐸𝐴𝑖 = 𝐸𝑋𝑖 + 𝐸𝑌𝑖 + 𝐸𝑍𝑖 

 

m ( )iiii VZVYVXV
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(xiv) Calculating the Center of Gravity 

This describes the method of calculating the center of gravity. 

The 3-point method of calculating the center of gravity is described below. 

 

The center of gravity 𝐺(𝑋 𝑌 𝑍 ) using the 3 points , 

, and the mass 𝑀1, 𝑀2, 𝑀3 are calculated as follows. 

 

𝐺𝑋 =
𝑀1 × 𝑃1𝑋 +𝑀2 × 𝑃2𝑋 +𝑀3 × 𝑃3𝑋

𝑀1 +𝑀2 +𝑀3
  

𝐺𝑌 =
𝑀1 × 𝑃1𝑌 +𝑀2 × 𝑃2𝑌 +𝑀3 × 𝑃3𝑌

𝑀1 +𝑀2 +𝑀3
 

𝐺𝑍 =
𝑀1 × 𝑃1𝑍 +𝑀2 × 𝑃2𝑍 +𝑀3 × 𝑃3𝑍

𝑀1 +𝑀2 +𝑀3
 

 

 

Appendix D CSV Format 

Graph data can be imported or exported with MOVIAS Neo as comma separated text 

data (CSV format). The file formats include the two types of time graphs (XT graphs) 

and correlation diagrams such as trajectory figures (XY graphs). 

Imported graphs can be played back together with AVI images and graphs analyzed with 

MOVIAS Neo. 

 

File Format 

The format is comma separated text files (CSV format). 

The files are constructed of the following 3 blocks. 

✓ Header (fixed length)  

1~29 rows, containing information relating to the graphs. 

✓ Data (variable length)  

From row 30 to “EOD”, containing coordinate data.  

✓ Comments (variable length)  

From “EOD” to the end of the file, containing comments (and calibration 

data).  

For CSV output, the point displayed on the list is the one output.  

CSV imports correspond to XT graphs.  

 

( )1111 ZYXP

( )2222 ZYXP ( )3333 ZYXP
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(a) Header 

The header is comprised of six parts, including the file identifier, graph settings, graph 

data information, horizontal axis settings, data channel settings, and channel data 

information. 

(i) File Identifier 

Row Contents Format  

１ File format and version identifier Movias**GraphV## (all single byte)  

**: Graph format 

XT with graphs of time, XY for graphs 

of correlation 

##: 2 rows of single byte for version 

information of this format 

Ex) time graph, with Ver1.1  

MoviasXTGraphV11 

２ Reserved  

(ii) Graph Settings 

Settings for the graphs, including title and data channel. 

Note:   

- The characters“\/: ?” cannot be used in the “Title”.  

- About the “Creator”, indicates the creator of this file and the version. 

Row Item Contents Format 

3 Title  Graph title Text 

4 SubTitle Graph sub-title Text 

5 NDataCh  Number of data channels Integer 

6 Creator  Creator of this file Text 

(iii) Graph Data Information 

Graph data information added with MOVIAS output. 

Note:  Ignore when importing. 

Row Item Contents Format 

7 #NData  Number of data Integer 

8 #FrameInterval[ms] Time interval between 

frames 

Integer 
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(iv) Horizontal Axis Settings 

Horizontal axis settings, including title of the horizontal axis and the scale. 

Note:  Ignore “XMin” and “XMax” when importing. 

Row Item Contents Format 

9 XAxisCaption  X Axis Caption Text 

10 XUnit X Axis Unit Text 

11 XMin  X Axis Minimum Value  Fixed at “Auto”  

12 XMax  X Axis Maximum Value Fixed at “Auto” 

13 XChName X Axis Data Channel 

Name 

Text 

 (used only with XT 

graphs)  

(v) Data Channel Settings 

Settings for each channel, including the titles for vertical lines and colors. 

Note:  Ignore “LineStyle”,” YMin”, and “YMax” when importing. 

Row Item Contents Format 

16 ChNo Channel number Integers, 1,2,3,4... 

17 ChName Channel name Text 

18 Color  Line color Color name or number 

Refer to the following 

chart for a list of color 

names 

19  Line Style Line type Fixed at integers 

20 YAxisCaption Y axis caption Text 

21 YUnit  Y axis unit Text 

22 YMin Y axis minimum value Fixed at “Auto”  

23 YMax Y axis maximum value Fixed at “Auto” 

24 YChName  Y axis data channel 

name 

Text 

25 XChName  X axis data channel 

name 

Text (used only for XY 

graphs)  
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List of Colors 

Color Name Color Color Name Color 

Yellow Yellow Maroon Maroon 

Fuchsia  Magenta Navy Navy blue 

Aqua Cyan Purple Purple 

Red Red Teal Teal 

Blue Blue Black  Black 

Green Green Gray Gray 

Lime Lime Silver Silver 

Olive Olive White  White 

Color Numbers:  After “#”, base 16 with a sequence of blue, green, red, with a maximum 

of “FF”.    

The format is #BBGGRR, with BB the brightness of blue, GG the brightness of green 

and RR the brightness of red. 

(vi) Channel Data Information 

Information on each channel added for MOVIAS Neo output. 

Note:  Ignore when importing. 

Row Item Contents Format 

15 #ExcelRange  Range of cells for channel data 

on an Excel spreadsheet 

Excel standards 

Ex) B12: C20 

26 #Min Minimum value for the channel 

data 

Integers 

27 #Max Maximum value for the 

channel data 

Integers 

28 #MinTime Time when the channel data is 

at a minimum [ms] 

Integers 

29 #MaxTime Time when the channel data is 

at a maximum [ms] 

Integers 

(b) Data 

Data for each channel in chronological order. Output involves the file for the channel 

shown on the list display. 

Row Contents Format 

30 Data item (XT graph) 

Time[ms], Ch1Y, Ch2Y, Ch3Y, Ch4Y..... 

(XY graph) 

Time[ms], Ch1X, Ch1Y, Ch2X, Ch2Y, Ch3X, Ch3Y,  

Ch4X, Ch4Y..... 

31 ～

EOD 

Time and channel 

data 

 (1st row)  

Time data. Msec units, integers. 

Times all at even intervals. 

 (2nd row and after)  

Channel data. Integers. 

Data arranged identical to the 30th row. 

Untracked points and failed measurement points show “ ” in the column. 

If comments or calibration data are continued below, “EOD” is inserted. 
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(c) Comments 

 From “EOD” to the end of the file. Includes comments. When exporting from 

measurement data, the calibration data (real scale conversion, changes in perspective, 

3D calibration) can also be exported. 

Ignore when importing. 

(i) Calibration Data 

If exporting from measurement data to a CSV file, calibration parameters are included 

after the “EOD” row. Depending on the calibration, the calibration parameters are 

included from the item “CalibPrmBeg” to the item “CalibPrmEnd”. 
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✓ Real Scale Conversion 

If performing real scale conversion for calibration or if not calibrating, the following 

parameters are output. 

Real scale conversion parameters consist of calibration parameters, axis and origin 

settings and depth planes 

Row Item Contents 

EOD next row CalibPrmBeg Mark for starting the 

calibration data 

 #2D Calibration 

Parameter 

 

  Real scale conversion 

parameters 

Refer to the following 

table for details 

(# of plane rows)  Depth plane parameters 

Refer to the following 

table for details 

Next row after the entries 

for all the plane 

parameters 

#End  

 CalibPrmEnd Mark for ending the 

calibration data 

 

Details of the real scale conversion calibration parameters 

The following calibration parameter items are included in the row as CSV.   

 

Conversion Parameters 

Column Item Contents Format 

1 Type:  scale Calibration type 

 Fixed at “scale”  

Fixed text 

2 Datum pnt1_x:  (#) Input reference length 

coordinates (X starting 

point)  

Integers 

3 Datum pnt1_y:  (#) Input reference length 

coordinates (Y starting 

point)  

 

4 Datum pnt2_x:  (#) Input reference length 

coordinates (X ending point)  

 

5 Datum pnt2_y:  (#) Input reference length 

coordinates (Y ending point)  

 

6 Segment length:  (#) Actual reference length  

7 Depth:  (#) Depth of reference plane  

8 Coefficient:  (#)  Coefficient of calculated 

reference plane 
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Starting Point for Real Scale Conversion 

Exports the starting point settings for real scale conversion. Items vary according to the 

item selected. 

Column Item Contents Format 

 If [lower left corner of screen] or [fixed] is selected 

9 Origin_x:  (#) X coordinate for the starting 

point 

Integer 

10 Origin_y:  (#) Y coordinate for the starting 

point 

 

 If [each frame] is selected 

9 Origin point:  (Point 
name) 

Name of starting point Text 

 

Axis Direction for Real Scale Conversion 

Exports the axis settings for real scale conversion. Items vary according to the item 

selected. 

Column Item Contents Format 

 If [horizontal right] is selected 
Next column 

from beginning 

point 

Axis_x_direction:  horizontal 

axis 

Shows the X axis 

direction 

Fixed text 

If [fixed] is selected 
Next column 

from beginning 

point 

Axis_x begin_x:  (#) Input coordinates for X 

axis (X starting point)  

Integer 

 Axis_x begin_y:  (#) Input coordinates for X 

axis (Y starting point)  

 

 Axis_x end_x:  (#) Input coordinates for X 

axis (X ending point)  

 

 Axis_x end_y:  (#) Input coordinates for X 

axis (Y ending point)  

 

If [every frame] is selected 
Next column 

from beginning 

point 

Axis_x begin:  (Point 
name) 

Name of X axis starting 

point 

Text 

 Axis_x end:  (Point 
name) 

Name of X axis ending 

point 

(blank if not 

selected) 

Y axis direction 

Next 

column 

from X axis 

Axis_y:  (characters) Characters set to 

indicate the Y axis 

direction 

Text 

: bottom-up 

: top-down 
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 Details of the Parameters for the Depth Plane 

The scale plane is shown afer the depth plane.  

Column Item Contents Format 

1 Depth plane:  (characters) Depth plane name Text 

2 Depth:  (#) Depth of this plane Numbers 

3 Coefficient:  (#) Conversion coefficient of 

this plane 

Numbers 

 

✓ Changing perspectives 

Exported to change perspectives. 

Parameters for changing perspectives include conversion parameters and axis and origin 

settings. 

Row Item Contents 

EOD next row CalibPrmBeg Mark for starting the 

calibration data 

 #2D Calibration Parameter  

  Parameters for changing 

perspectives 

Refer to the following 

table for details 

 #End  

After entering all of the 

calibration data 

CalibPrmEnd Mark for ending the 

calibration data 

 

Calibration Parameters for Changing Perspectives 

The following items are included in the row as CSV. 

 

Conversion Parameters 

Column Item Contents Format 

1 Type:  perspective Calibration type  

Fixed at “perspective” 

Fixed text 

2 Point_UL_x:  (#) Input reference length 

coordinates (upper left of X)  

Integer 

3 Point_UL_y:  (#) Input reference length 

coordinates (upper left of Y)  

 

4 Point_UR_x:  (#) Input reference length 

coordinates (upper right of X)  
 

5 Point_UR_y:  (#) Input reference length 

coordinates (upper right of Y)  
 

6 Point_LR_x:  (#) Input reference length 

coordinates (lower right of X)  
 

7 Point_LR_y:  (#) Input reference length 

coordinates (lower right of Y)  
 

8 Point_LL_x:  (#) Input reference length 

coordinates (lower left of X)  

 

9 Point_LL_y:  (#) Input reference length 

coordinates (lower left of Y)  
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Conversion Parameters (continued from previous page)  

Column Item Contents Format 

10 Segment_UL_UR:  (#) Actual reference length 

(Upper left ⇔ Upper right)  

Integer 

11 Segment_UR_LR:  (#) Actual reference length 

(Upper right ⇔ Lower right)  

 

12 Segment_LL_LR:  (#) Actual reference length 

(Lower left ⇔ Lower right)  

 

13 Segment_UL_LL:  (#) Actual reference length 

(Upper left ⇔ Lower left)  

 

14 Segment_UL_LR:  (#) Actual reference length 

(Upper left ⇔ Lower right)  

 

15 Segment_UR_LL:  (#) Actual reference length 

(Lower left ⇔ Upper right)  

 

 

Starting Point for Changing Perspectives and Axis Direction for Changing Perspectives 

Identical to real scale conversion. Enter on the same row as the calibration parameters 

for changing perspectives. 
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✓ 3D Calibration 

Output during 3D calibration. 

Outputs the calibration method and the calibration results. 

Note:  For “Repeat for each camera” repeats for all cameras. 

Camera name → PrincipalDist → … → CameraPosition → Camera name →

PrincipalDist→…… 

Sequentially output for all the cameras. 

Row Item Contents 

EOD next row CalibPrmBeg Mark for starting the 

calibration data 

 Type:  (characters) With 3D calibration:  

 “Type:  3D Calibration”  

With MDLT:  

 “Type:  MDLT”  

Repeat for each 

camera 

CameraName:  (characters) Camera name 

 PrincipalDist:  (#), (#) X, Y of the camera focal 

length 

 PrincipalPnt:  (#), (#) X, Y of camera center 

position 

 TransformR:  

(#), (#), (#) 

(#), (#), (#) 

(#), (#), (#) 

Rotation matrix showing the 

camera positions 

 CameraPosition:  (#), (#), (#) X, Y, Z of camera position 

After including all of 

the calibration data 

CalibPrmEnd Mark for ending the 

calibration data 

(ii) Comments 

If there are comments, enter the comments in the row after “#Comment”. If none, leave 

blank 

Row Contents 

#Comment Mark for starting comments 

From #Comment next row to the end of the 

file 

Comments 
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Appendix E Simple CSV Format 

After Ver2.20, a simple CSV format has been added to the エラー! 参照元が見つかりませ

ん。 (p. エラー! ブックマークが定義されていません。) for importing waveform data. 

This streamlines the procedure for editing files. 

 

(a) File Format 

 

The format is comma separated text file (CSV format). 

The files are constructed of the following 2 blocks. 

 

Data (variable length)  

Pairs of time and waveform data. 

Optional information (variable length)  

The names and colors of series information can be specified. If there isn’t any, the 

default value is set. 

 

An example of a file is shown below. In this example, time data is entered in the first line 

but times can be set in other lines by specifying “Time” under [Title] of the optional 

information. 

 

 

 

 

 

 

 

 

 

1 0.188906 0.663756 0.308846 0.688181 
2 0.571408 0.615731 0.267138 0.555397 
3 0.943593 0.390421 0.064892 0.823087 

  

・ 

・ 

・ 

  

99 0.986931 0.117127 0.487761 0.118405 

100 0.514575 0.335635 0.758175 0.846427 
Unit=msec Meters Meters g V 

Color=0xffffff 0xff00ff 0x00ff00 0x0000ff 0xff0000 

Axis=Time Position Position Acceleration Sensor 

Title=Time Seq1 Seq2 Seq3 Seq4 

FrameRate=10000     

Example of a Simple SCV File Format 

Optional Information 

Data Time data (milliseconds) 
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(i) Data 

Section to arrange time and waveform data in pairs. 

Specify the time in milliseconds. The amount of data is determined by the number of 

rows in the top row of the data. 

The default is the time data in the first column. If setting “Time” under [Title] in the 

optional information section, that column is specially imported as time. 

(ii) Optional Information 

If “Unit”, “Color”, “Axis”, “Title” or “FrameRate” are entered in the first column, the 

information noted in that row is used to import the optional information on the 

waveform data. 

If there are multiple rows with the same item in the file, the contents of the first row 

found are reflected. 

Series data with the same [Unit] and [Axis] are drawn to the same axis but if they are 

different, they are drawn to different axes. 

 

Unit 

Sets the units for the series. Used as the graph display units. The default is “V”. 

Color 

Sets the color for the series. The default is the registered color. 

Axis 

Sets the axis for the series. Paired with units for use. The same pair is shown on 

the same axis. The default is “voltage”. 

Title 

Series title. The default is sequential [Ch1], [Ch2]. 

If “Time” is specified, the column is treated separately as the time sequence, and a 

graph is drawn. 

If not, the first column is imported as time. 

FrameRate 

Sampling frequency for the waveform data. This number is calculated when 

applying Filter Settings (p. 8－25). If not entered, it is calculated from the time 

series data. 

 

The following is entered into the エラー! 参照元が見つかりません。 (p. エラー! ブックマ

ークが定義されていません。). 

Series Unit Color Axis Name 

Time msec  0xffffff Time 

Seq1 meters 0xff00ff Position 

Seq2 meters  0x00ff00 Position 

Seq3 g  0x0000ff Acceleration 

Seq4 V  0xff0000 Sensor 

[Units] and [Axis] are only used for the graph display and identifier name. Unit 

conversion (milliseconds ⇔ seconds) is not supported 

The first column in the エラー! 参照元が見つかりません。 is read as time. 

“Seq1” and “Seq2” are drawn on the same axis since the [Unit] of “meter” and [Axis] of 

“position” match. “Seq3” and “Seq4” are drawn on different axes since the [Unit] and 

[Axis] combination does not match. 
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(iii)  [Unit] and [Axis] Optional Information 

The [Unit] and [Axis] optional information are separated according to the axis displaying 

the series data. 

Effective when comparing different data with high amplitude or large offset. 

 

 
Example of Defaults (when optional items are not specified) 

Ch3 has high amplitude compared to other series. Ch4 has low amplitude compared to 

other series but a large offset. If these series are imported unchanged, it will be a bit 

difficult to compare the graphs. 

 
Example of when the axis is specified (when optional items are specified)  

Loaded as unit + axis. 

Ch1, Ch2 from the previous graph are on a single axis. Ch3 is on a single axis. Ch4 is 

drawn on a single axis 

Since vertical auto scaling is done for each axis, it is easy to compare each waveform. 

 

Therefore, when importing waveforms, consider combining axes according to the scale of 

the data. 

High amplitude 

Large offset 
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(b) Importing Waveforms 

When loading simple CSV formatted waveform files, the analog waveform data import 

dialog in the figure below is displayed. Create the series to import and press the draw 

graph button to draw a waveform graph. If necessary, add・delete series. 

 

  
Double click [Name], [View], [Vertical Axis], [Horizontal Axis] or [Color] in the series list 

dialog to edit. Click the draw graph button and after creating a graph, use エラー! 参照

元が見つかりません。 Properties( p. 8－26) to edit data not on the horizontal axis. 

Use the [Add], [Delete], and [Change] button to add, remove or change the series. 

 

Add 

Adds the series set in the edit series section to the series list. 

Delete 

Deletes the series data selected in the series list from the list. 

Change 

Changes the details of the series data selected in the series list that were set in the 

edit series section. 

 

Separate Graph for Each Channel 

Create a graph for each series on the list. 

 

One Graph for Each Channel 

Draws each group of waveform data with the same horizontal axis on a single graph.  

If there are multiple groups with the same horizontal axis, multiple graphs are 

drawn. 

 

Time Units 

Select the units showing the time axis for the waveform graph. 

Select from sec, msec or usec. 

 

Time units 

Edit series 

Series list 

Draw graph 

Add・delete・change 
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Appendix F 2D-6DOF Reference Coordinates File 

The 2D-6DOF reference coordinates file specifies a desired starting point (0.0, 0.0, 0.0) 

to a rigid body in CSV format (comma separated values) so create a graph of coordinates 

for each measurement point with the coordinate system on the left.   

The values that must be input include, from the left, the name, X coordinate, Y 

coordinate and Z coordinate for each measurement point. 

The names of each measurement point must be the same name assigned to the target 

point assigned in MOVIAS Neo. 

 

 

 

 
 

 

 

  

Name of each 

measurement point 

X Coordinates Y Coordinates Z Coordinates 
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